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1. INTRODUCTION 
 

 

Urbanisation produces numerous changes in the natural environment it replaces. The impacts 

include hydrological, morphological and sedimentological changes. The amount of storm water 

runoff is generally increased due to the removal of vegetation and the rise in impervious areas, 

resulting in a rise in the frequency and magnitude of floods. Moreover, the increased stream 

powers alter the shape of channels and sediment supplies are disturbed. The reduction of 

perviousness also results in a reduction in groundwater. Finally, the quality of water is lowered 

due to urban sources of pollution. The major factors controlling the effects of urbanisation are 

the impervious proportion of the drainage basin, the size of the catchment and the nature of 

rainstorms. Today, in addition to the necessity to increase social awareness about the protection 

and management of the water resources, there is a need for planners to obtain information 

regarding the drainage system response to the changing environment. 

 

Singapore is naturally flood prone due to its particular physiography – small drainage basin, 

relatively steep hillslopes – and its equatorial climate characterised by intense rainfall of limited 

duration. Since the 1960s, the country has undergone widespread land development. As 

Singapore expanded, slopes were covered by impervious surfaces and floodplains were 

converted into arterial roads next to a stream transformed into a straight concrete canal. The 

natural propensity of flood has therefore increased. In this context of urban growth, management 

of the quantity and quality of water has become an important issue. 

 

The effects of urbanisation on the hydrological environment can be quantified and predicted 

through detailed characterisation and modelling of the concerned urban area. Watershed models 

have become essential for water resources planning, development and management and their role 

will be increased in the future. Models are used to understand interactions between climate and 

hydrology; they are able to perform simulation of the effects of watershed processes and 

anthropogenic activities on water quality and quantity. They allow a great variety of applications, 

from the simulation of transport and treatment of storm water pollutants to the computation of 

discharge in each point of the catchment and the detection of the sensitive areas. These models 

require a high number of parameters in order to accurately describe the relationships between 

rainfall, runoff and watershed characteristics. These parameters are sometimes hard to quantify 

and data are not always readily available. 
 

The Upper Bukit Timah basin, a watershed of 6.8 km² situated in the central part of Singapore 

constitutes a worthwhile case study of Singapore‟s increased flood probability with urban 

development. This area has been quiet widely researched upon during the past, but most of the 

studies concerned the old pattern of the catchment. Moreover, only few of them established a 

link between urbanisation and hydrological changes. 
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The aim of this work consists in modelling the Upper Bukit Timah catchment in order to perform 

a diachronic analysis of the effect of changes in imperviousness and roughness on hydrology. 

This objective will be achieved through the development of the SWMM model. In this case, only 

few data are available. The first step therefore consists in developing a methodological approach 

to build a correct watershed model of the Upper Bukit Timah catchment, using a variety of data 

sources. The second phase relies on the application of the watershed model previously 

constructed to underline the hydrological changes due to urbanisation.  

 

One of the primary motivations behind this research is to help the future user to understand the 

hydrological processes of an urban watershed model and to show how indirect data can be 

exploited. Moreover, the model developed will provide a framework that can easily be reused to 

incorporate other available hydrologic/hydraulic processes data. The methodology used here 

could also be applied to another urban area. It is why all manipulations are described in details at 

the end of the work (see tutorial).  

 

The work is organised as follows. Chapter 2 brings a short overview of the physical environment 

of Singapore and the Upper Bukit Timah basin (location topography, climate and physiography). 

It also details the hypotheses which are tested here. Chapter 3 summarises a review of the 

literature relevant to this research and revises the key concepts constituting the roots of the work. 

Chapter 4 explains the pre-treatments required to obtain basic data, namely topographic and land 

use data. Chapter 5 describes the methodology applied to achieve our goals. It first gives a brief 

presentation of the model and its computational methods and describes how parameters 

necessary for the model to run are determined. Then, it presents the results of the 

parameterisation of the model and its final adjustment. Chapter 6 focuses on the second research 

objective by performing the diachronic analysis and presenting the results. Chapter 7 draws some 

final conclusions before discussing the limitations of the work and briefly describing the research 

to be conducted in the future. 

 



9 

 

 

 

 

2. STUDY AREA AND HYPOTHESES 
 

 

This chapter is a brief summary of the physical geography of Singapore and the Upper Bukit 

Timah basin. The catchment is detailed in terms of location, climate, topography, drainage, 

geology, soil and land use. The hypotheses are detailed at the end of the chapter. 

 

 

2.1. General context 

 

2.1.1. Location, demography and economy 

 

Singapore, officially the Republic of Singapore, is a tropical city-state of Southeast Asia situated 

at the coordinates of 1º22´ N - 103º48´ E, on the southern tip of the Malay Peninsula (figure 1). 

The Straits of Johor separates it from Malaysia to its north and the Singapore Strait from 

Indonesia to its south. It is made up of 63 islands and its total land area is 712.4 km² (Singapore 

Department of Statistics, 2010). The main island of Singapore is about 42 km from west to east 

and 23 km from north to south (Check, 1997).   

 

The population recorded in 2009 was 5.076 million (Singapore Department of Statistics, 2010). 

Since its independence from Britain in 1965, it has seen a massive increase in wealth due to the 

strict controls imposed by the one-party government to build a wealthy, modern city (Campbell, 

2008). The economy of the country depends heavily on the industry sector and the service sector, 

sharing 26.3% and 69.1% of GDP respectively (Yee et al., 2010). This important growth has 

triggered the encroachment into the rainforest-covered areas during British colonization followed 

by radical alterations during the planned post-1960 urbanisation when hills were removed, 

forests cleared, and mangrove swamps reclaimed to build residential, commercial, and industrial 

areas (Chatterjea, 1993). This resulted in a series of changes in the geomorphic environment, 

both in time and space (ibid.). Today, the country is highly urbanised, apart for the Bukit Timah 

Nature Reserve, the only significant remaining tropical rainforest. 

 

 

2.1.2. Topography  

 

Singapore has a moderately low relief (figure 1). The highest point, the Bukit Timah Peak, is 

163 m, but 64 % of the main island lies within 15 m of mean sea level, 10 % over 30 m and only 

1 % over 60 m (Pitts, 1994). The slopes are relatively low with 76 % of them being lower that 

6°. In spite of the limited catchment relief, the hillsides can be steep. According to Gupta (1982), 

there are more than forty watersheds in Singapore, with a surface of less than 13 km². This 

constitutes a flood prone topography (Gupta, 1994). The natural state of the island was 

constituted of small streams carrying a large amount of sediments and running down the 
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hillslopes to join larger rivers occupying the flat valley floors. This type of physiography led to 

flooding of the valley flats and, once the vegetative cover had been removed, accelerated the 

erosion and sediment transport (ibid.). Much of the present Singapore landscape is the result of 

anthropogenic changes brought on by urbanisation. 

 

 
Figure 1. Location and topography of Singapore 

 

 

2.1.3. Climate 

 

Singapore can be classified as having an equatorial climate characterised by evenly high 

temperatures, humidity and rainfall throughout the year (Sien and Fook, 1991). Figure 2 

illustrates it with the climatograph of the Changi Airport climate station. The yearly rainfall lies 

between 1650 and 2550 mm, depending on gauge location (Gupta, 1994). Rainstorms are brief, 

localised and intense and fall 179 days of the year (ibid.). The rainfall intensity-duration-

frequency curve for the island shows that the 30-minute two-year rainstorm is estimated to bring 

90 mm of rainfall and the 30-minute ten-year rainstorm is supposed to bring 120 mm 

(appendix 1). Temperatures usually range from 23 to 32°C (National Environment Agency, 

2009). The mean 24-hour maximum relative humidity is close to 100 % throughout the year 

while the mean 24-hour minimum varies between 60 and 70 % (Sien and Fook, 1991). This 

climate is influenced by the monsoons which introduce variations of wind speed and direction. 

This produces wet and dry seasons over the year: the Northeast monsoon season which lasts 

from late November to March and the Southwest monsoon season from late May to September 

(Check, 1997). The Northeast monsoon winds are generally cooler and bring wet weather which 

may persist for several days while the Southwest monsoon season brings winds occasionally 

strong, often accompanied by heavy rain and thunder (ibid.). The nature of Singapore‟s rainfall is 

thus conductive to frequent short-term flooding. 
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Figure 2. Climatograph of the Changi climate station, Singapore (constructed from data of the 

National Environment Agency (2011). Rainfall period of record: 1869-2010, temperatures period of 

record: 1929-1941, 1948-2010) 

 

 

2.1.4. Geology and soils 

 

Singapore comprises mainly sedimentary rocks of the Jurong Formation containing six 

sedimentary facies (Triassic to Early Jurassic), granite and granodiorite rocks of the Bukit Timah 

Granite Formation (lower-mid Triassic age), coarse sand-gravels interpreted by Gupta et al. 

(1987) as being the proximal facies of an ancient braided river deposit and referred to as the Old 

Alluvium (Pleistocene) as well as Holocene alluvial, littoral and inshore marine deposits forming 

the Tekong and the Kallang formations (Public Works Department Singapore, 1976). The 

igneous rocks consisting of the Bukit Timah granite occupy the north and central-north region of 

Singapore, the sedimentary rocks of the Jurong formation occupy the west and southwest region, 

the Quaternary deposit of the Old Alluvium lies in the eastern region and the recent deposits of 

the Tekong and Kallang formations are distributed throughout the island (figure 3). 

 

Due to the particular climatic and topographic conditions, the rocks are deeply weathered and the 

drainage has reached the point where the rivers are of low gradient with a mature profile (Public 

Works Department Singapore, 1976). The average thickness of weathering profiles over igneous 

rocks is 10 to 20 m (Pitts, 1994). The upper portion consists of clayey silt soils while the lower 

section consists of completely weathered granitic rocks (Rahardjo et al., 2004). The sedimentary 

Jurong formation has a degree of weathering which is variable, and which normally depends on 

the parent rock types such as mudstone, siltstone and limestone (ibid.). Weathering profiles over 

the Old Alluvium rarely exceed 6-7 m and consist mainly of clayey silty sand (Pitts, 1994). 

Gupta (1982) indicated that sediment produced over most of Singapore is generally in the 

medium to coarse sand class along with a small portion of silt and clay. 
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Figure 3. Simplified geological map of Singapore (modified from Rahardjo et al. (2004), p.158) 

 

 

2.1.5. Flood propensity 

 

Singapore has a long history of flooding. The natural physiography and climate of the country 

result in frequent flooding due to the high volume and intensity of rainfall, the undulating 

topography with breaks in slope between the hillside and the valley floor, and the low altitude of 

the country (Gupta, 1982).  Although the flood potential of the island has always been high, 

urbanisation has triggered a considerable growth of its flood propensity since the 1960s-1970s. 

According to Check (1997), the old drainage systems have always been inadequate to drain away 

storm water runoff but it is the new land developments of the 1970s that aggravated the flooding 

problem in Singapore. From this time, urbanisation reduced ground infiltration, natural storage 

and shortened the time of flow concentration resulting in changes in the hydrological 

characteristics (ibid.).  

 

However, the urbanisation of the island involved drastic transformations of the drainage system 

from a pattern of natural streams and rivers into a network of concrete-lined drains and canals. 

Logically, the increase in urbanisation required that the drainage system keep up with the 

increasing runoff generated (Ching, 1997). In the 1960s, about 13 % of the island was 

susceptible to severe flooding, associated with inadequate drainage systems and the low-lying 

nature of the built-up areas (Check, 1997). During this period, drainage matters came under the 

centralised control of authorities. The problem of flooding has been more or less eliminated with 

the prompt improvements of the drainage system (Ching, 1997) (figure 4). Today, at every stage 

of any new development proposal, the Drainage Department is consulted to implement control 

strategies. The implementation of drainage development schemes is consequently more efficient 

than before. Flooding is alleviated in several ways: elevation of areas below flood levels prior to 

construction, sufficient systems of drains, rooftop detention, and porous pavements, for example. 

Drainage channels in Singapore are planned on the basis of a 5-year recurrence interval (PUB, 

2010).  

 

Nevertheless, flooding remains a recurring problem for several parts of Singapore, especially the 

Bukit Timah catchment. In fact, in the context of rapid environmental modification, recurrence 
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intervals change rapidly. Therefore, a good drainage condition may become inadequate in time, 

thus requiring re-designing of drainage channels (Gupta, 1982).  

 

 
Figure 4. Flood prone areas in the 1960s (6900 ha) and mid 1990s (207 ha) (Modified from: Check, 

1997, p.185) 

 

 

2.2. Upper Bukit Timah Catchment 

 

2.2.1. Location 

 

The Upper Bukit Timah subbasin
1
 is located in the central part of Singapore ( 

figure 5). This subcatchment occupies an area of approximately 6.8 km² and is roughly circular 

in shape. It constitutes a worthwhile case study since five rain gauge stations and three gauging 

stations are present within the basin. Unfortunately, all these data were not available for this 

study because of the non-cooperation of the authorities in charge of these stations. The general 

pattern of Singapore‟s climate described above persists but the annual rainfall of the Upper Bukit 

                                                 
1
 Although the Upper Bukit Timah basin is only a part of the Bukit Timah catchment, it is suitable to use only the 

upstream part of the whole watershed because part of the water is diverted to the neighboring Ulu Pandan Valley at 

the outlet (appendix 2). Consequently, the term « catchment », « watershed » or « basin » will be used instead of 

« subcatchment », « subwatershed » or « subbasin » in the following pages.  
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Timah basin is around 2400 mm (Gupta, 1994). This amount, however, is not evenly distributed 

and there are considerable spatial and temporal variations within the catchment (Kaur, 1981). 

The appendix 2 contains a general map of the Upper Bukit Timah basin, showing the major 

roads and streams. 

 

 

2.2.2. Topography 

 

The relief of this catchment is not uniform ( 

figure 5). The northeastern part of the catchment, comprising the Bukit Timah Nature Reserve, is 

considerably higher than the rest of the area and the slopes are steeper. The relief of the other 

parts of the basin is undulating with isolated low hills. The highest point of Singapore is within 

the basin and reaches an altitude of 163 m. The remaining of the catchment is very flat and the 

mean height is about 30 m above sea level. We have calculated that 70 % of the area is between 

15 m and 50 m and only 2 % is above 100 m. The median slope is about 9 %.  

 

 
Figure 5. Topography and location of the Upper Bukit Timah basin 
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2.2.3. Drainage 

 

The Upper Bukit Timah is a part of the Bukit Timah basin. The drainage pattern is entirely man-

made and constituted of drain channels of varying dimensions. The streams flow from north to 

south in the upper half of the catchment while the main channel flows from northwest to 

southeast in the lower half of the basin ( 

figure 5).  

 

In the early 1960s, the Bukit Timah basin was prone to severe flooding (Check, 1997). A scheme 

was implemented in two phases to alleviate the flooding. The first phase was implemented in 

1966 when a diversion canal was constructed to divert flow toward the southwest from the Upper 

Bukit Timah basin to Ulu Pandan (figure 6). This constitutes the outlet of the Upper Bukit Timah 

catchment. This scheme was completed in 1971 (Ching, 1997). Phase 2A of the scheme, 

downstream from the Upper Bukit Timah basin, was implemented because of the growing flood 

problem of the 1980s. It consisted of building a second diversion canal to the Kallang River 

toward the east (ibid.). This phase was completed in 1990. The Upper Bukit Timah basin is 

currently drained at the outlet by a trapezoidal concrete lined channel with a low flow section 

(figure 7). This channel is being modified, its widening and deepening just upstream of the 

diversion is in progress (Wei, 2011). It begun in late November 2011 and is targeted to be 

completed by the end of 2012. This concerns a 600 m section and is the first stage of an overall 

drainage scheme to improve the Bukit Timah First Diversion Canal (bukittimah.net, 2011). Thus, 

the two major methods of flood control in Singapore, namely the increase of drainage capacity 

and the diversion of flow from a channel to a separated outlet (Gupta, 1982), are illustrated in the 

Upper Bukit Timah basin. 

 

     
Figure 6 (left). Diversion of the Bukit Timah Canal towards Ulu Pandan (17/09/10)  

Figure 7 (right). Bukit Timah Canal at the intersection of Bukit Timah road and 6
th

 Avenue 

(02/10/10) 

 

2.2.4. Geology  

 

Essentially, the catchment can be divided into two geological units: the granite and recent 

alluvial deposits. In general, apart from the valley-floor, the Upper Bukit Timah consists of 
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granitic hills. The term “granite” includes granite and associated igneous rocks such as 

granodiorite (Chuah, 1987). The Bukit Timah granite belongs to the mid-Triassic. It is 

undoubted that the geology of this basin influences the relief and the land use associated with it. 

 

 

2.2.5. Soils 

 

Two soil units are developed over both dominant geological units: the Rengam and Tengah 

series (Chuah, 1987). Chemical weathering in the Upper Bukit Timah catchment is intense and 

rapid and has given rise to thick regolith (ibid.). The Rengam series is dominant and it has a red 

variant in the northern part of the basin. Soils of the Rengam series are well drained and the 

topsoils have textures consisting in sandy loam while the deeper subsoils consist in fine to coarse 

sandy clay. The red variant, however, has coarse textures even near the surface (Chia, 1979). The 

topsoils have a depth of about 10 to 20 cm (Chuah, 1987). Soils in the Tengah series are 

extremely variable in texture and appearance. But, generally, they consist in a dark, loamy 

horizon over a heavy, grey clay or silty loam (ibid.). Their drainage is relatively poor compared 

to the Rengam series (ibid.). Figure 8 represents the different soil types covering the basin. 

 

 
Figure 8. Simplified soil map of the Upper Bukit Timah catchment 

 

 

 



17 

 

2.2.6. Land use 

 

Originally confined to the main valley floor or the lower slopes, the urban development has 

moved up the tributary valleys (Gupta, 1994). This has led to accelerated localised slope failure, 

excessive sediment production and increased flooding of the Bukit Timah valley floor (ibid.).  

 

Although the higher northern parts of the basin are still covered by rainforest, the rest of the 

basin is urbanised. It has been calculated that 30 % of the basin is forested, but the Bukit Timah 

Nature Reserve only covers an area of 75 ha. General vegetation consists in parks, grass, green 

spaces and open spaces. It is dispersed throughout the catchment. It constitutes 18 % of the 

Upper Bukit Timah basin. The valley floor is crossed from northwest to southeast by one of the 

major roads of Singapore: the Bukit Timah/Dunearn road. The north-eastern part is also crossed 

by some important roads: the Upper Bukit Timah road and the Jalang Jurong Kechil (see 

appendix 2). This is a commercially developed area. Personal calculations have shown that the 

highest impervious surfaces, namely roads and car parks, cover 13 % of the catchment. Single-

family dwellings, consisting of houses surrounded by a small, open space, are mainly found on 

the north of the Bukit Timah/Dunearn road, as in the past. Other types of dwellings are situated 

throughout the basin. The residential function occupies 28 % of the catchment.  

Figure 9 shows a map representing the present land use of the Upper Bukit Timah catchment. 

 

 
Figure 9. Land use of the Upper Bukit Timah basin 
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2.3. Hypotheses 

 

This study attempts to model the rainfall-runoff relationships in the Upper Bukit Timah 

catchment in Singapore in order to highlight and quantify the effect urbanisation has on runoff. 

The SWMM model is used mostly used. The purpose of this study is to verify the two following 

hypotheses: 

 

- It is possible to model an urbanised catchment with little data. Working with “free” data 

is not an easy task. It will be shown how to use them and integrate them into the SWMM 

model. Then, the watershed model will be verified using as more as possible available 

data. The strategy and methodology to build a correct model from data of a variety of 

sources will be presented and details about all manipulations will be found in the tutorial 

in order to help future user to repeat the same steps. 

 

- There is a link between runoff and urbanisation for the Upper Bukit Timah basin and it is 

possible to quantify this relationship as well as identify runoff producing areas with the 

model previously built. The basin has undergone rapid urbanisation during the last few 

decades. A diachronic analysis will be presented in order to show the evolution of the 

basin in terms of imperviousness and linked runoff and discharge. The runoff-producing 

zones will be underlined using the model potentialities. 
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3. LITERATURE REVIEW 
 

 

This chapter first gives a short overview of different key-concepts that need to be understood 

before getting started with the modelling of an urban catchment. It then presents the general 

changes in the physical environment in relation to urbanisation before detailing the works about 

impacts of land use changes on geomorphology in Singapore. Next, the flood prone nature of 

Singapore and Bukit Timah basin is highlighted through the presentation of several works. The 

studies undergone about physical geography of the Upper Bukit Timah catchment are presented 

in the following section. Finally, watershed models are overviewed and the different works about 

the modelling of the Upper Bukit Timah basin are briefly explained. 

 

 

3.1. Concepts 

 

The term « hydrology » names the « science that encompasses the occurrence, distribution, 

movement and properties of the waters of the earth and their relationship with the environment 

within each phase of the hydrologic cycle » (USGS, 2011). Penman (1961 cited in Singh and 

Woolhiser, 2002, p. 270) simplified the definition of « hydrology » as the science that attempts 

to answer the question, « what happens to the rain »? This seems to be a simple question, but the 

hydrological response of a basin may be difficult to determine due to the heterogeneity of the 

land surface, soils, vegetation, land use, etc. as well as the variability in inputs over the scales of 

time and space (Cantone, 2010). 

 

The term « watershed hydrology » was defined by Singh and Woolhiser (2002) as the « branch 

of hydrology that deals with the integration of hydrological processes at the watershed scale to 

determine the watershed response ». Cantone (2010) defined « urban hydrology » as the 

« branch of hydrology that deals with the integration of hydrological and hydraulic processes at 

the urban scale to determine watershed response ». Hydrologic processes and their spatial non-

uniformity are defined by climate, topography, geology, soils, vegetation, and land use and are 

related to the basin size (Singh and Woolhiser, 2002). Hydraulic processes define the 

mechanisms that take place in the river channel, pipes, pumps etc. and that can be quantified by 

the mechanical properties of liquids. « Urban hydrology » is therefore a branch of « urban 

geomorphology ». This term has been defined by Gupta and Ahmad (1999) as the part of the 

geomorphology that « combines the ambient geology, landforms, and geomorphological 

processes with the evaluation of impacts brought to these by urbanisation ». According to 

Chengtai (1996), the urban geomorphological environment can be divided into three parts: 

physical landforms (not or hardly built by human activities), artificial landforms (man-made 

architectures) and physic-artificial landforms (formed in varying degrees by human beings). 

Studies in urban geomorphology encompass different topics in a wider range than urban 
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hydrology such as slope instability, seismic hazards, increased flood problems and land 

subsidence. 

 

There are essential differences between natural and urban watersheds. Land surface 

characteristics represent the key physical distinction between the two: urban catchments tend to 

be highly impermeable (predominant land use is residential, commercial and industrial); natural 

watersheds tend to be highly pervious (land use is dominated by pastures, crop land, etc.) 

(Cantone, 2010). Moreover, urban catchments typically encompass a smaller range of space 

scales (of the order of hectares or square kilometres) (ibid.). Due to these characteristics, natural 

watersheds can have time scales ranging from minutes to years while urban catchments typically 

have time scales lying between minutes and hours (ibid.).  

 

In 2008, the U.S. Environmental Protection Agency (EPA) defined the term « model » as a 

physical representation of natural systems, with or without a series of mathematical equations 

(mathematical models). The processes included in a watershed model can be complex and may 

require knowledge of several ongoing systems. Including all processes which influence the 

response of the system to the various climatic conditions is not possible since generation and 

transmission of surface runoff require complex mathematical description and data available to 

define the parameters are limited in both space and time (Choi and Ball, 2002).  As a result of 

these limitations, simplifying assumptions are made and the real situation is idealised (ibid.). A 

typical watershed model can divided into four conceptual modules, which are represented in 

figure 10: first, the spatial and temporal variation of the water is represented (generation); then, 

the model predicts the temporal variation of the quantity and quality of storm water at the entry 

points of the transport module (collection, hydrologic component); next,  the quantity and quality 

of storm water is routed through the links in the drainage system (transport, hydraulic 

component); finally, the storm water is discharged into the receiving water (disposal). According 

to Cantone (2010), there is a principal difference when considering a natural watershed or an 

urban catchment. For the former, all of the hydrological processes may be accounted for in the 

hydrologic model while for the latter only subsets of these hydrological processes are generally 

considered (precipitation, infiltration excess, overland flow and channel flow).  

 

The steps to follow in hydrological modelling were reviewed by Blöschl and Sivapalan (1995). 

These ones constituted a basis for this study. They are illustrated in figure 11 and consist in: 

- collecting and analysing data;  

- describing the important hydrological characteristics of the catchment (drainage network, 

topography, soils, imperviousness, etc.) and determining various parameters from these 

characteristics;  

- translating these data into a mathematical model; 

- calibrating the model to fit real data by adjusting various inferred parameters, which are 

parameters determined from the application of the model, contrarily to the measured 

parameters;  

- applying the model. 
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Figure 10. The four conceptual components of a watershed model (Source: Choi and Ball, 2002) 

 

 
Figure 11. Procedure to follow in hydrological modelling (Source: Choi and Ball, 2002) 
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3.2. Urbanisation versus physical environment 

 

This section presents a theoretical statement of the impacts of urbanisation on hydrologic and 

geomorphic processes and details the works concerning the effects of urbanisation in Singapore. 

 

The urbanisation of a watershed triggers significant changes in geomorphic processes (Gupta, 

1994). There are three different stages, constituting the Wolman‟s time-sequence: 

- Pre-urbanisation: natural vegetation or agriculture, channels adjusted to existing 

conditions; 

- Construction: very high increase in erosion during a brief period of time, channels in 

disequilibrium due to the high amount of sediments reaching drains; 

- New urban landscape: impervious surface, concrete storm drains and sewers, increase of 

floods frequency, diminution of sediment supply, channels still in disequilibrium that 

may or may not adjust to the changed environment. 

 

The resulting changes in the nature of the hydrologic environment due to urbanisation can be 

regrouped into three categories (Gupta, 1994).  

- hydrological changes: 

Development of an urban area involves covering the surface with imperviousness, which 

increases the amount of surface runoff due to a lower infiltration and removal of 

vegetative cover (Leopold, 1986). It thus results in an increase the total volume of water 

in the channel while the amount of water available for ground water storage is diminished 

(ibid.). The rate at which water is transmitted to stream channels is higher, as surface 

runoff travels quicker over impervious surfaces and through drains that it does in natural 

conditions. The consequence is a rise in the frequency of floods. Finally, the rapid runoff 

of storm water causes pollutants to be washed off the surface. 

 

- morphological changes: 

The changes of the flow characteristics listed above cause adjustments in the stream 

channels to accommodate the flows (ibid.). The larger volume, velocity and duration of 

flow cause higher erosion, resulting in an enlargement of channels and instability of their 

banks.  

 

- sedimentological changes: 

The exposure of the soil during construction triggers more effective erosion which results 

in the deposition of sediments in the channels (Gupta, 1994). This stage is followed by a 

diminution of sediment yield when the urban landscape is set up.  

 

Chatterjea (1989) quantified the changes occurring during the three stages of the Wolman‟s 

sequence over several areas in Singapore. He presented an overview of the sequential changes in 

the nature and rates of fluvial and slope processes that take place in Singapore, leading to 

environmental changes of both temporal and spatial types. Data were obtained from field studies 

on three different sites: forested hillslopes, bare sites under construction and urban concrete or 

grass covered slopes. This was done in order to observe the impact rainwater has on soil 

moisture conditions, surface microtopography, runoff generation, sediment movement, and 
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ground lowering. He found that the primary natural conditions are altered when areas are cleared 

for construction leading to the development of gullies, augmentation of erosion, high runoff 

generation and high sediments release. With increasing urban development, this highly erosive 

phase changes and accelerated erosion is replaced by frequent floods from the impermeable 

surfaces. 

 

One of the first observations on the effects of urbanisation on runoff in Singapore has been done 

by Gupta (1982). According to him, the proportion of catchment urbanised, the size of the 

drainage basin and the nature of rainstorms are the three principal factors controlling the effects 

of urbanisation on stream generation and channel characteristic. The impacts are most 

pronounced on a small channel draining a small catchment (ibid.). They are also heightened by 

the occurrence of intense rainfall of limited duration the presence of some relief and of storm 

sewers (ibid.). Therefore, urbanisation in Singapore has led to a rise in flood frequency and 

channel degradation. The factors cited below are found in the Upper Bukit Timah catchment. 

The area is therefore manifestly suitable for studying the effect of urbanisation on runoff since 

the extension of impervious surfaces, establishment of storm sewers and lining of drainage 

channels are happening at a great speed.  

 

Gupta (1982 cited in Gupta, 1982, p. 143) examined the intensity of land use changes in a part of 

the Bukit Timah basin by mapping repeatedly the area according to several categories (open 

space, construction areas and different classes of built-up areas). A one year time-sequence of 

land use changes in this area has been created for the period from August 1981 to December 

1982. He concluded that the open space is representative of the pre-urban environment, where 

only large storms would involve serious flooding and sediment loss. The construction areas 

provide a high quantity of sediment and after a certain time would create flooding downslope as 

a result of the blockage of certain channels caused by sediment build-up and the sealing of pores 

in the exposed soil surface by rainsplash. Some built-up areas allow 90 % of the rainwater to 

reach a drainage channel via surface runoff. Single-family dwellings, constituted of houses 

surrounded by a green space, probably have a hydrologic environment approaching that of the 

open space. Gupta showed that there were noticeable local variations in runoff and sediment 

production in a given area at a certain time and that these changed over time. Unfortunately, he 

did not specify the changes in the quantity of runoff and sediment over the period studied. He 

asserted a progressive increase in runoff from this part of the Bukit Timah basin in the future. In 

order to estimate the effect of denudation through time over this area, long term measurements of 

runoff and change in land use are necessary. However, it is usually not available for most areas 

(Gupta, 1982).  

 

The physical adjustments in response to the urbanisation of Singapore have been underlined in a 

book edited by Gupta and Pitts in 1994. This book covered a wide variety of themes, from the 

landscape change to the evolution of the country during the Quaternary through the changing 

vegetation and the newly reclaimed land or the stability of slopes. Gupta (1994) has devoted a 

chapter to floods and sediment production in Singapore. According to him, the flood propensity 

has been increased considerably by the urban growth associated with the expansion of 

impervious areas and the establishment of storm drains. The main channel, connected to such 

drains, is therefore incapable of carrying all the contributed water arriving rapidly. In order to 
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overcome the problem, the solution of temporarily detaining the water at various points 

throughout the catchment is implemented (ibid.). Certain areas of Singapore, like the Bukit 

Timah Valley for example, have been more flood prone than others, mainly due to physiographic 

reasons (ibid.). The location of arterial roads in the valley bottom, the Bukit Timah Road for 

example, highlights the flood prone nature of the environment. The Bukit Timah catchment is 

therefore an interesting area to focus on. 

 

 

3.3. Floods propensity 

 

Flooding has always been an issue in Singapore. Several specific works on floods in Singapore 

have highlighted the flood prone nature of Singapore and the Bukit Timah catchment 

particularly. They are cited below. 

 

A general appraisal of floods in Singapore was undertaken by Foo in 1986 in order to provide a 

comprehensive overview of the flood problem in the country. It analysed the man-flood hazard 

relationship by describing and analysing the effects, causes and characteristics of floods as well 

as the responses to the flood hazard (structural and non-structural adjustments) and the future 

scenario of the flood problem in Singapore. A special reference to the Upper Bukit Timah 

catchment has been made. He estimated that the frequency of flooding in the catchment has been 

increasing. This bachelor dissertation did not provide any statistical analysis; it was more 

concentrated on a review of the literature. 

 

In this context, Ching (1997) studied the drainage canals in Singapore and evaluated the 

developments of a drainage system through time for flood control as well as other uses. This 

exercise sought to overview the history of the drainage canal network, to evaluate the design and 

efficiency in disposing excessive runoff of such drains and to discuss the aesthetic treatment of 

the drainage canals and their utilisation beyond flood control. This work did not bring a 

quantitative assessment of the effects of the drains on the urban environment. It constituted a 

descriptive appreciation of the history of drainage canals and the perception people have of them. 

 

Simultaneously, Check (1997) presented a paper dealing with the strategies adopted by 

Singapore's government to keep the flood situation under control despite the new developments 

that are continuously taking place. It discusses the drainage development programmes that were 

implemented for flood mitigation. It gives a good general overview of the flood situation and 

also explains the Bukit Timah Flood Alleviation Scheme, a plan describing the strategies setting 

up to prevent flooding in the Bukit Timah Basin.  

 

Nevertheless, it is important to keep in mind that, according to Gupta and Ahmad (1999), the 

geomorphological problems (floods and landslides particularly) in Singapore are small-scale, 

almost entirely anthropogenic, and successfully managed. Effectively, the city enjoys efficient 

technical and managerial capacities. Financial resources are available to face geomorphology 

hazards. According to these authors, although urbanisation brought in impervious cover on the 

slopes and conversion of the floodplain wetlands into arterial roads next to a channel, flood 

alleviation in Singapore managed to keep up with the urbanisation of the valleys and flooding 
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has a low destructive component. On the other hand, the frequency of such disruption to normal 

activities is high (Gupta, 1994). 

 

Gupta (1994) reported three major floods with great consequences in past flood records. The first 

happened the 9
th

 and 10
th

 of December, 1954, when about 25 km² or 3.6 % of the island was 

under water. The next major flood happened the 9
th

 and 10
th

 of December, 1969, when 27.5 km² 

were inundated after 467 mm of precipitation in one day. The flood of the 2
nd

 and 3
rd

 of 

December, 1978, was triggered by 512 mm of rainfall in 24 hours and affected 32 km². This is 

the highest rainfall recorded in Singapore over a period of 24 hours (Straits Times, 2010). Since 

the publication cited above, some 366 mm within one day fell on December 19
th

, 2006, which 

resulted in massive flooding (ibid.). The flood of November 19
th

, 2009, was also reported as one 

of the worst floods and was triggered by 92 mm of precipitation within 30 minutes (PUB, 2009 

cited in Channelnewasia, 2009). More recently, the flood of the June 25
th

, 2011, triggered by 

65 mm of precipitation within 30 minutes, caused damage in several areas of the island 

(Channelnewasia, 2011). PUB, Singapore‟s national water Agency, said it was the worst flood 

since 25 years (ibid.). 

 

 

3.4. Urban hydrology of the Upper Bukit Timah basin 

 

The Upper Bukit Timah basin is one of the few areas in Singapore that has been widely 

researched upon, especially with respect to the physical geography of the area. According to 

Gupta (1994), it is a worthwhile case study of flooding in Singapore‟s watersheds. Since the land 

use of the watershed has changed strikingly since the 1950s, the basin provides good examples 

of flood increases following urbanisation. In fact, the percentage of forest cover has decreased 

from 10.91 % in 1950 to 8.36 % in 1986 and grass and open space fell from 68.05 % in 1950 to 

29.24 % in 1986 (ibid.). On the other hand, the percentage of built-up areas has increased from 

12.94 % in 1950 to 48.92 % in 1986 (Chuah, 1987). The percentage of built-up areas today is 

even higher still and will be illustrated in this work. The main canal has undergone many 

transformations since the 1960s to overcome the increase of urbanisation (Gupta and Ahmad, 

1999).  

 

In 1981, Kaur realised an exercise regrouping five methods to estimate the runoff from rainfall 

data in the Upper Bukit Timah Basin. These methods were direct correlation, Rational formula, 

unit hydrographs, water budgeting and computer simulation. The increase in the runoff-rainfall 

ratio between the periods of 1969-1973 and 1978-1980, associated with the increase of the built-

up area and the decrease of vegetation, has been calculated. This ratio grew from 54.52 % to 

59.44 % for the two periods respectively. This trend of increase in runoff has also been reflected 

in the 45 minutes duration unit hydrograph where an increase in discharge from 13 m³/s to 

15 m³/s has been observed for the periods 1969-1974 and 1976-1981 respectively. He found that 

in most cases, the methods used provided a fairly good estimate of the runoff volumes. An 

identification of critical parameters in each technique has underlined the careful consideration in 

the selection of these parameters when estimating runoff. 
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Research on the hydrological impact land use changes has on runoff in the Upper Bukit Timah 

basin was done by Chuah in 1987. The first part of her exercise was an attempt to analyse the 

changing land use in the Upper Bukit Timah basin, in terms of increase in impervious area for 

the period 1950-1986. She used the topographic maps and aerial photographs of the region. Then 

the relation between the changing land use and the change in runoff in terms of peak discharge 

and time of concentration was established, using the Rational formula. This method estimates the 

peak runoff Q from only three parameters: the watershed area A, the runoff coefficient C and the 

storm intensity I. Her analysis showed that the average coefficient of runoff C, depending on the 

land use, gradually increased from 0.55 in 1950 to 0.65 in 1980 and the time of concentration 

decreased from about 100 minutes to 60 minutes during the same period of time. Consequently, 

she discovered an increasing trend of the 5-year peak discharge since 1950: 73 m³/s in 1950, 

78 m³/s in 1959, 79 m³/s in 1973, 82 m³/s in 1980 and 91 m³/s in 1986. It is important to note that 

the Rational formula is the simplest way to determine the peak runoff and is not the best in the 

field. However, according to Gupta (1994), given that the data available are not rigorous and the 

drainage basin is small, it is perhaps the most appropriate technique to obtain suitable peak 

discharge estimations. 

 

In 1990, Rahman underlined the hydrological processes under changing land use in humid-

equatorial conditions with a special focus on the Upper Bukit Timah. His article presented the 

results of different studies (Chia (1979), Kaur (1981), Foo (1986), Chuah (1987), cited here). 

 

 

3.5. Urban watershed models 

 

According to Singh and Woolhiser (2002), watershed models are employed to understand 

dynamic interactions between climate and land-surface hydrology. They are used to plan, design, 

and operate projects, to conserve water and soil resources and to protect their chemical and 

biological qualities. They are fundamental to assess, develop, and manage water resources 

(ibid.). According to Jacobson (2011, in press), urban watershed models provide powerful tools 

to inform management decisions about how changes in urban basins will impact flows and to 

assess the likely impacts of climate change and changing rainfall patterns on urban runoff. 

Research is needed to improve our understanding of the changes linked to urbanisation in urban 

catchments, and to develop planning strategies in order to minimise the impact of future urban 

growth (ibid.). This section discusses the choice of taking SWMM and HEC-HMS to model the 

Upper Bukit Timah. Then, it reviews the different models implemented on this basin over the 

past decades. 

 

In their article, Singh and Woolhiser (2002) discussed new developments and challenges in 

watershed models. According to them, the SWMM model, a dynamic rainfall-runoff simulation 

model that computes runoff quantity and quality from primarily urban areas, was one of the 

earliest models developed and is currently a widely used model throughout the world. HEC-

HMS, a model designed to simulate the precipitation-runoff processes of watershed systems in a 

wide range of geographic areas, is one of the most commonly used watershed models in United 

States (ibid.). Among the watershed models identified by Singh and Woolhiser (2002), SWMM 

and HEC-HMS are most commonly used for urban catchment hydrologic modelling. Gironás et 
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al. (2009) published a manual regrouping some examples illustrating how the SWMM model can 

be used to model some of the more common types of storm water management. The manual 

highlighted the main applications of the watershed model:  it could compute runoff for both pre- 

and post development conditions as well as analyse the hydraulics of  simple  collection  

systems, simulate  the  build-up,  washoff,  transport  and  treatment  of  stormwater  pollutants 

and so on. Likewise, the U.S. Army Corps of Engineers published an applications guide in 2008 

illustrating the wide range of applications of the computer program HEC-HMS. There are a 

variety of studies undertaken by this model: urban flooding, flood-frequency, flood-loss 

reduction, flood-warning system planning studies, reservoir design studies and so on. SWMM 

and, to a lesser extent, HEC-HMS models have been chosen in this study as they are adapted to 

the urbanised environment. They are physically based models, which means that they require a 

lot of subcatchments characteristics parameters to simulate runoff. Their computational methods 

will be discussed in chapter 5. The steps for their application cited above (figure 11) can be 

applied to these models. 

 

Several models were attempted on the Upper Bukit Timah in the past. In 1975, Wong modelled 

the Upper Bukit Timah watershed hydrology by using a Tank model, a very simple model 

considered to correspond to the zonal structure of underground water. This model was composed 

of four reservoirs: the first one containing precipitation minus evaporation (“gain”); all of them 

possessing outputs, representing surface discharge, intermediate discharge, sub-base discharge 

and base discharge (“loss”).  

 

In 1979, a computer simulation on rainfall-runoff relationship was carried out by Chia. The basin 

hydrological cycle was conceptualised as a deterministic box cascading system. Processes 

included in the model were, among others, interception, infiltration, overland flow in pervious 

and impervious areas and evapotranspiration. These processes were coded in FORTRAN/3000. 

The model developed the hydrological response of the basin that generates synthetic streamflow 

data. This model was considered as a first approximation, as it could have been greatly 

improved.  

 

In 1987, Selvalingam et al. published a paper on the use of RORB and SWMM models in the 

Upper Bukit Timah basin for the purpose of storm water drainage design and management. They 

presented the data preparation needed for the testing of each of the models, and discussed the 

limitation and constraints of the parameter estimation. They concluded that the use of the 

SWMM model is a good replacement for the Rational method, method currently in use by the 

Public Utility Board to estimate the peak runoff (PUB, 2010). According to them, SWMM is a 

sophisticated model capable of taking into account a large variety of parameters. This reinforced 

our decision to use this model in this study. Since then, the SWMM model has obviously 

undergone several modifications. This paper was useful since it gave us an idea of what 

parameters would be required for the application of the SWMM model. One hydrograph was 

also used in this work. 

 

Liong et al. (1993) and Liong et al. (1991) applied the Knowledge-Based Storm Water 

Management Model (KBSWMM) on the Upper Bukit Timah catchment. This model regroups 

the calibration parameters into „traditional‟ and „non-traditional‟ parameters. The distinction 
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between the two was based on how the parameters are estimated: the former is obtained through 

calibration; the latter is estimated based on field measurements. The KBSWMM contains the 

features of the SWMM but a new calibration component (“Knowledge-Based”) is added to it. 

Current SWMM model does not have this special calibration component. Liong et al. (1993) and 

Liong et al. (1991) evaluated the model in the perspective of interactivity and presentation of 

data and results and the KBSWMM was considered as user-friendly. They also presented the 

important features of the model and highlighted their particular calibration methodology 

composed of eight calibration parameters and six storm events (three used for calibration, three 

for verification). The application on the Upper Bukit Timah catchment showed good agreement 

between the simulated and the measured peak flows (r² ≈ 1). The hydrographs and hyetographs 

presented in that paper were used for the verification of our model.  

 

SWMM model does not allow automatic calibration of the parameters. SWMM users are able to 

compare simulation results with actual measurements but the calibration parameters have to be 

modified manually in order to adjust the model to reality. In 1998, Javaheri submitted a thesis on 

automatic calibration of the SWMM. They were based on two different optimisation algorithms 

(Downhill Simplex method and Shuffled Complex Evolution method). The consistency of the 

Shuffled Complex Evolution method in estimating the SWMM model parameters was assessed 

under two different scenarios: using „error-free‟ data and using observed data. The observed data 

have been collected for the Upper Bukit Timah watershed by Liong et al. (1993). The 

optimisation algorithm follows several particular steps. Initially, the model calibration is done 

with eight parameters, using the synthetic data. Then, based on the sensitivity of these 

parameters, the number of calibration parameters is reduced, while still maintaining the same 

level of accuracy. The author found that the percentage of impervious areas and the catchment 

width are the two most effective parameters to use in the calibration of SWMM. The application 

of this method for the Upper Bukit Timah catchment showed that the Shuffled Complex 

Evolution method-based calibration scheme was able to provide accurate parameters. 

 

More recently, Liong et al. (2002) published a paper on Genetic Programming, an evolutionary 

algorithm-based methodology utilised as a flow forecasting tool. Genetic Programming is a 

member of the evolutionary algorithm family, based upon Darwin‟s natural selection theory of 

evolution where a computer program is progressively improved by selectively discarding the 

not-so-fit one. Each computer program contains different watershed parameters, varying from 

one program to another. The advantage of this model is that, in contrast to physically based 

models like SWMM which require a lot of catchments characteristics parameters, Genetic 

Programming only requires rainfall and runoff data. The model was tested on the Upper Bukit 

Timah catchment for six old events of different intensities and durations that took place between 

1978 and 1987. The runoff prediction accuracy was measured in terms of root mean square error. 

Although the results showed a higher value of computed runoff compared to the observed data, 

the authors concluded that it can be a viable alternative to traditional rainfall-runoff models.  

 

In 2003, Khu and Werner explored the possibility to reduce simulation runs for uncertainty 

estimation in hydrological modelling (regardless the model). They developed a hybrid genetic 

algorithm, just as Liong et al. (2002), and an artificial neural network, a computational model 

consisting of an interconnected group of parameters, both forming the GAANN model. This 
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„pre‟ model discards the parameter sets that give non-behavioural model runs before running the 

hydrological model. This method is applied to different cases among which we find the Upper 

Bukit Timah. For this basin, the procedure was tested on the SWMM model for the storm of 

March 2
nd

, 1984. According to the authors their technique reduces significantly the 

computational effort involved in investigating model parameter uncertainty. 

 

Chua and Wong (2010) provided a detailed study on an event-based rainfall-runoff process 

simulation. Three types of artificial neural network models were used (as Khu and Werner, 

2003). These are based on the association between rainfall and runoff patterns measured for past 

storm events to make predictions. A kinematic wave model was also developed. This model uses 

the kinematic wave method for routing flows through the drainage system and is based on 

physical properties of the catchment, as well as the determination of rainfall and losses. The 

point of the study was to combine the two different models in order to simulate better 

hydrographs. Three sets of rainfall-runoff data were used, among them one obtained from the 

Upper Bukit Timah catchment. The storm data used to calibrate the model dated from 1988 and 

1989. It was concluded that the kinematic wave model was not able to accurately produce 

hydrographs. Indeed, the modelled discharges presented in the paper showed very high values 

compared to the measured ones. On the other hand, one of the artificial neural network models 

was able to produce hydrographs that were much closer to the measured hydrographs. This 

article provided essential information about the basin (notably drain characteristics and 

hydrographs). 

 

 

3.6. Literature review conclusion 

 

The Upper Bukit Timah basin is a suitable area for this study for several reasons. First of all, it is 

a small catchment where the occurrence of floods is higher than in most of the other regions of 

Singapore today despite the large channel and the two downstream diversions. In fact, although 

the floods are generally limited in extent, numerous major floods with great impact have been 

recorded on this particular basin. Secondly, the area has undergone many developments in a 

short period of time. It is therefore interesting to quantify the effect of urbanisation on runoff in 

this region. Finally, the Upper Bukit Timah is a worthwhile case study which has been quiet well 

studied over the past. Therefore, the different studies about the basin have provided essential 

information when the authorities did not cooperate in providing the data. 

 

This chapter has shown that the past Upper Bukit Timah catchment studies, even the ones carried 

on in the past few years, concern old storms which happened in the 1970s and 1980s. It is 

therefore important to bring a new approach taking into account the current pattern of the area as 

well as some current storm events. It was also essential to use current powerful tools like 

watershed models to achieve the objectives. Moreover, the major part of the studies was satisfied 

with the development of models without any application studies. Only the works using the 

Rational formula tempted to quantify the link between urbanisation and peak discharge. 

 

Models are powerful tools that provide useful information about the changes in urban catchment 

needed for planning strategies. The SWMM and HEC-HMS models are suitable for urban 
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environments. The SWMM is currently used worldwide and has been applied in the past on the 

Upper Bukit Timah catchment. This explains our decision to develop this model, and in a lesser 

extent, the HEC-HMS model. These one-dimensional models allow a huge variety of 

applications which cannot be understood with the Rational formula: detection of the areas which 

produce runoff, quantification of the discharge in each drainage canal of the catchment, 

modification of a variety of parameters function of the changing environment and so on.  
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4.  PRE-TREATMENTS FOR DATA 

ACQUISITION 
 

 

A large number of data is required for the application of any watershed model in order to 

accurately describe the complex relationships between rainfall, runoff and catchment 

characteristics. In this study, it was particularly difficult to obtain valuable data from the 

authorities or from the National University of Singapore (NUS). This chapter describes how the 

basic data used to determine the necessary parameters of the SWMM and HEC-HMS models 

(described in the next section) have been obtained. The first step consisted in the geo-referencing 

of the maps available. Then, a Digital Elevation Model (DEM) was created from the topographic 

map and the land use data was extracted from the Google Earth image. All these pre-treatments 

were realised in ArcMap. All technical details concerning the manipulation can be found in the 

tutorial. 

 

 

4.1. Georeferencing 

 

4.1.1. Topographic sheets 

 

The topographic map is the basis of any catchment characterisation. Unfortunately, only photos 

of the topographic map of Singapore were available from the National University of Singapore 

(NUS). There was no digital raster map available. Therefore, the first step consisted of 

georeferencing the available maps. All details concerning the steps to georeference images, 

topographic sheets and projections characteristics can be found in the tutorial. The topographic 

map was principally used to realise the DEM. 

 

4.1.1.1. Rectified Skew Orthomorphic projection 

 

The 1:25,000 topographic map published by the Mapping Unit of the Ministry of Defence in 

2005 was used. This map was chosen mainly because its scale is smaller than the other maps 

available, and the contour interval is 10 m, with a supplementary contour of 5 m. The projection, 

the Rectified Skew Orthomorphic (RSO) projection, is based on the Everest 1830 Modified 

spheroid. The latitude and longitude of the projection centre are respectively 4°00‟N and 

102°15‟E. The RSO projection method is defined as oblique cylindrical (ESRI, 2009). The local 

shapes and angles are true and the distances are true along the centre line (ibid.). Distortion 

increases rapidly away from the central line. The use of this projection is therefore limited to 

areas of Borneo and Malaysia, for which the projection was developed (ibid.). The Everest 1830 

Modified Spheroid has its origin in Central India, in Kalyanpur (Gopi, 2005). It is a local 
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ellipsoid, designed to match the geoid in that area. In order to georeference the photos on the 

basis of this projection, a ground control point (GCP) was added for each junction of the 

projection lines figuring on the map. A total of about 25 GCP were selected for each photo 

(tutorial, section 1). Once the residual errors were acceptable, the image was rectified. It was 

then set as the “Kertau RSO Malaya Meters” projection of Arcmap, whose characteristics 

correspond to the ones figuring on the map (Define Projection function). 

 

4.1.1.2. Universal Transverse Mercator projection 

 

The Malaysian coordinate system was converted into a universal coordinate system, the 

Universal Transverse Mercator (UTM), in order to set all the geographic data on a same 

universal basis (Project function). This was done in two steps: first, the local coordinate system 

RSO was transformed into the geographic coordinate system longitude-latitude (WGS 84); then, 

the geographic coordinate system was converted in UTM. After that, the four photos were 

assembled using ERDAS Imagine software. The UTM projection is a cylindrical conformal 

transverse projection (Donnay, 2010). The longitude of origin is the central meridian of each 

zone while the latitude of origin is the Equator. Singapore is situated in the UTM 48N zone, the 

central meridian being at 105° E. 

 

 

4.1.2. Google Earth image 

 

The last accurate Google image of the Upper Bukit Timah dates from the 14
th

 of March, 2009. It 

has been projected in UTM 48 N by using 35 GCP. These GCP were taken from the Google 

Earth interface. This image was used to characterise the land use of the area and, to a lesser 

extent, to complete our database concerning the drainage network. 

 

 

4.2. Digital Elevation Model (DEM) 

 

4.2.1. ASTER Global Digital Elevation Model 

 

The ASTER Global Digital Elevation Model (GDEM) is available to users at no charge. It 

supplies DEM images of about 60 km by 60 km ground area which cover land surfaces between 

83° N and 83° S (ASTER GDEM Validation Team, 2009). Accuracies for this DEM are 20 m at 

95 % confidence for vertical data and the resolution is 30 m at 95 % confidence (ibid.). ASTER 

GDEM does contain anomalies and artefacts that degrade its overall accuracy. It is particularly 

the case for areas where residual cloud-related anomalies exist. The large elevation errors 

noticed on the area of study, in addition to the too weak resolution, were highly problematic. All 

tests realised in order to characterise the Upper Bukit Timah (water system extraction, watershed 

delimitation, slope determination etc.) using this DEM have shown incorrect results. Thus, we 

built an independent DEM from the topographic map. 
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4.2.2. DEM based on topographic map 

 

Contour lines and quoted points of the 1:25,000 topographic map of 2005 were used to realise a 

more accurate interpolated DEM. Waterways and lakes figuring on the map were also useful.  

The contour interval of the topographic map is 10 m, but supplementary contour lines of 5 m 

intervals are present. Still, several difficulties were encountered and are detailed below. All 

manipulations are explained in the tutorial. 

 

4.2.2.1. Digitisation and first surface interpolation test 

 

Each contour line of the area containing the Upper Bukit Timah basin and a buffer zone of 

several hundred meters was digitised. Its value was simultaneously specified in the attribute 

table. Likewise, quoted points and lakes were also digitised. 

 

The Topo to Raster function of Arcmap was tested on the digitised dataset. The function uses an 

interpolation method specifically designed for the creation of a hydrologically correct DEM from 

points (quoted points), lines (contour lines), and polygon data (lakes) (ERSI, 2009). At the 

beginning of the interpolation process, a generalised model is built on a very coarse grid 

resolution using information inherent to the contour lines (ibid.). The problem is then solved at 

succeeding finer resolutions, until the final user-specified resolution is obtained (Hutchinson, 

1996). Starting values for each succeeding grid resolution are obtained by bilinear interpolation 

from the preceding coarser grid (ibid.). At each resolution the elevation data are simply allocated 

to the centre of the nearest grid cell (ibid.). This interpolation method is optimised to have the 

computational efficiency of local interpolation methods without losing the surface continuity of 

global interpolation methods (ESRI, 2009). Topo to Raster also imposes constraints on the 

interpolation process in order to obtain accurate drainage structure and correct representation of 

ridges and streams (ibid.).  

 

Unfortunately, the function did not provide a correct DEM. In fact, the Flow Accumulation 

function, which gives the general pattern of the stream network, showed that the waterways 

constructed from the DEM did not match real data. Other manipulations were necessary to obtain 

a correct DEM. They are described below. 

 

4.2.2.2. Streams characterisation and transformation into points 

 

In order to constrain the DEM to accurately represent the drainage structure, the streams paths 

were integrated in the DEM generation process. The digitisation and characterisation of the 

stream network was based on the Chuah and Wong (2010)‟s sketch previously georeferenced 

and on Google Earth imagery. The streams were characterised by their type (concrete or earth 

channel), state (aerial or subterranean), Manning‟s coefficient, length, slope, channel shape 

(trapezoidal, rectangular or triangular), width, depth and side slope. These data were provided by 

Chuah and Wong‟s article (2010), Google Earth, Google Street View and personal fieldwork. 

Figure 12 illustrates the places where field measurements have been performed, and an 
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illustration for some of the drains measured
2
. Figure 13 shows an example of the determination 

of the drain depth from Google Street View when more accurate data were not available. 

 

The polylines of stream network were then transformed into points using ET GeoWizard in order 

to provide new quoted points for interpolation. One point every 50 m was created for each 

digitised drain of the water system. The elevation of all points was specified in the attributes 

table. The elevation of a first point was determined using a quoted point of the topographic map; 

for the remaining points, known drain depth and slopes and distance between points were used to 

compute each stream profile. Other points representing the drain sides were also created in order 

to form a 3D water system. Their altitudes were encoded thanks to the known drain depth. 

 

 
Figure 12a. Measurements performed by fieldwork 

 

                                                 
2
 Measuring drains in an urban environment without high resolution field mapping devices is a difficult task. For 

example, the major channel in the middle of the Bukit Timah/Dunearn Road is not accessible. Only pedestrian 

bridges allowed a view on the channel. Moreover, several drains are subterranean, impeding field data collection. 

Measurements from fieldwork are therefore insufficient and the data from Chuah and Wong (2010) were used to 

verify ours or when field data were not available. 
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Figure 12b. Photos corresponding to some of the points figuring on the map 

 

 
Figure 13. Determination of the depth from steps (~ 20 cm) in Google Street View 

 

4.2.2.3. Final DEM 

 

Using the digitised contour lines, quoted points and points forming the water system in 3D, 

several tests were first performed using the TIN interpolation. TIN is made up of triangular 

facets built following the Delaunay‟s criteria (Donnay, 2010). Each apex of a triangle is made of 

quoted points. Therefore, this interpolation method gives exact results for each quoted point. It 

was decided not to use it since it only gave accurate results for the areas surrounding the drains. 

 

About forty tests were realised with the Topo to Raster function. Each test was a succession of 

different functions, as illustrated in figure 14. At the end of each test, the hydrological 

consistency of the model was checked. Between each test, the resolution was changed and 

contour lines were redigitised or deleted. Also, a new sample of points forming the water system 

was created; the distance between them being set at 5 m instead of 50 m. The altitude of the 

points forming the drains was extracted from the TIN since it gave good results along the drains. 

Finally, the Flow Acc and Watershed functions showed a realistic look after the test of the Topo 

to Raster function with some contour lines modified, with quoted points and newly created 

points used as inputs. A hydrologically-correct DEM was constructed, with a resolution of 20 m. 
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Figure 14. Succession of functions used in each test for the DEM realisation. These are the results of 

the final interpolation. 

 

4.2.2.4. Evaluation of the DEM 

 

The most common evaluation of the quality of the output DEM is to create contours from the 

new surface and compare them to the input contour data (ESRI, 2009). Although the contour 

lines of the new DEM were not strictly identical to the actual ones, they were closed from each 

other and were therefore considered realistic. An example of comparison of the contour lines is 

shown in the tutorial, section 2. 

 

According to ESRI (2009), another common method for evaluating the quality of an interpolated 

surface is to subtract the height of the known quoted points after generating the surface. It is 

therefore possible to examine how closely the new surface represents the true surface. These 

differences can be used to calculate the RMS error, a common measure of the differences 

between modelled values and actual values. It is expressed as: 

             
    

                
       

   

 
 (1) 

where,   
            

 refers to the i
th

 interpolated point value,   
     refers to the i

th
 known quoted 

point value and N is the number of sample points. The RMS error was calculated from the fifteen 

quoted points situated inside the limits of the basin. A value of 1.1 m was obtained. 
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It is important to note that, in this case, the primordial objective was to obtain a hydrologically 

correct DEM, for which the Flow Acc function gives continuous streams. Also, after a visual 

comparison of the drainage cover with the known streams, the new DEM was considered 

acceptable as the two water systems almost coincided. This third method also constitutes a mean 

to evaluate the consistency of a DEM (ESRI, 2009). 

 

 

4.2.3. ASTER GDEM and new DEM comparison 

 

The first difference between the two DEMs is that the ASTER GDEM has a resolution of 30 m 

while the new DEM resolution is of 20 m. In order to compare them in terms of elevation, the 

ASTER GDEM was subtracted from the new DEM (with resampling).  The result is shown in 

figure 15. The maximum difference between the two DEMs is -114 m, in the southeastern part of 

the basin. Moreover, the ASTER GDEM gives a value of 91 m for the Upper Bukit Timah 

summit instead of 164 m, resulting in a divergence of 73 m between the two DEMs. The mean 

difference is -13 m and the standard deviation is 15 m. 

 

The RMS error was also calculated for the ASTER GDEM, with the fifteen quoted points used 

previously. A value of 10.1 m was obtained, showing that the new DEM is definitely better than 

the ASTER GDEM. In an ideal case, LIDAR DEM would be the most suitable high resolution 

elevation data to use in hydrologic modelling but this kind of dataset was not available in 

Singapore. 

 

 
Figure 15. Comparison between the DEMs. 
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4.3. Land use 

 

Holding a precise land use map of the Upper Bukit Timah basin was indispensable to 

characterise the surface imperviousness. No accurate map was available for the area. Thus, we 

digitised the Google Earth image as precisely as possible. The tutorial (section 3) gives an 

overview of the land use digitisation steps. 

 

 

4.3.1. Land use classes and digitisation 

 

Above all, it was imperative to define the classes characterising the surface. The imperviousness 

is an important parameter used in watershed models. Values for the coefficient of 

imperviousness have been found in various writings (see next chapter), and the classes used in 

these different works determined our choices. Then each class was precisely defined before the 

digitising step in order to avoid any subjective identification. The appendix 3 regroups the 

criteria of differentiation between the classes. The final step consisted of the digitisation of each 

land use class by following the criteria set up previously. The land use classes generated are 

noted below. Figure 9 in chapter 2 presents a land use map of the catchment.  

Figure 16 below illustrates an example of digitisation, with a part of the Google Earth image and 

its corresponding digitisation. 

 

 

 
Figure 16. Example of digitisation. Above: Google Earth image of the Upper Bukit Timah road; 

below, the corresponding image reclassified. 
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4.3.2. Quality of the digitisation 

 

In this case, it is difficult to evaluate the quality of digitisation for several reasons. Firstly, 

although the land use classes were well defined, errors inherent to the subjectivity in the class 

choices have triggered uncertainties in the determination of certain areas (figure 17). Secondly, 

errors due to the impossibility to draw exact limits of a polygon being digitising are inevitable 

(figure 18). Thirdly, the quality of a manual digitisation can also be lowered because of the 

georeferencing of the image on which the digitisation is based. The Google Earth image has been 

georeferenced from the Google Earth interface with a great number of GCP (35) in order to 

obtain a small RMS error. However, it is unavoidable that the areas delimited by the digitisation 

are linked to an uncertainty related to the georeferencing.  To a lesser extent, an alteration due to 

a too small screen resolution can also affect the quality of the digitisation (Donnay, 2010).  

 

 
Figure 17. Subjectivity in the class choice: (left) multiple family dwelling attached or detached? 

(right) polygon defined as attached. 

 

 
Figure 18. Difficulty in drawing the exact limits: (left) limit of the road hidden by the trees, (right) 

digitisation of the road following the visible limit. 
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4.4. Pre-treatments conclusion 

 

This chapter presented an overview of the pre-treatments performed to acquire a basic dataset. 

First, a hydrologically correct DEM was constructed in order to characterise the surface of the 

Upper Bukit Timah catchment based on topographic contours, quoted points, lakes and stream 

networks. Although there are certain errors inherent to such a manipulation, it was shown that 

building a new DEM was the best solution. Effectively, the ASTER GDEM presented too many 

artefacts and the comparison with the new DEM showed that the latter was decidedly better, with 

a RMS error of 1.1 against 10.1 m. Secondly, a land use classification using a georeferenced 

Google image was built. It will be used in the models to determine the imperviousness of the 

catchment. Land use was defined as precisely as possible. The quality of the manual digitisation 

is uncertain but the models will show the effects of its accuracy on the results. The next chapter 

will present both the watershed models, SWMM and HEC-HMS, and the methodology used to 

constrain the parameters and variables necessary for their application. 
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5.  MODELLING 
 

 

This chapter brings a short introduction about the SWMM model and its computational methods 

intended to model surface runoff and channelled flow. Then, it reviews the methodology used to 

determine the necessary parameters which must be encoded into the SWMM model. These 

parameters characterise the Upper Bukit Timah catchment in terms of imperviousness, slope, 

roughness, infiltration, water network and so on. Once the necessary variables are defined, a pre-

parameterisation of the model is realised. A final adjustment is then effected in order to adjust 

the simulated data to the observed ones. At last, the SWMM model is verified, using different 

data. A brief overview of the HEC-HMS model and its application on the Upper Bukit Timah 

basin is given at the end of the chapter. 

 

 

5.1. SWMM model 

 

5.1.1. What is SWMM? 

 

The Storm Water Management Model (SWMM) is a one dimensional, physically based model 

produced by the Water Supply and Water Resources Division of the U.S. EPA's National Risk 

Management Research Laboratory. It is “a dynamic rainfall-runoff simulation model used for 

single event or long-term (continuous) simulation of runoff quantity and quality from primarily 

urban areas” (Rossman, 2010 (SWMM user‟s manual)). SWMM was first developed in 1971 

and has undergone major improvements since then (ibid.). The current model, SWMM 5, is user-

friendly as it provides an integrated environment for editing study area, input data, running 

simulations and viewing the results in a variety of forms (time series graphs and tables, profile 

plots, scatter plots and colour-coded maps). The data required for modelling include 

hydrometeorologic (mainly rainfall), geomorphologic (topography), hydraulic (drain 

dimensions), pedologic (soil type, infiltration), agricultural (land use) and hydrologic (discharge) 

properties. SWMM is a widely accepted model and is currently used throughout the world for 

planning, analysis and design related to water systems in urban areas (ibid.).  

 

 

5.1.2. Subcatchments, conduits and junctions 

 

Spatial variability of various hydrologic processes that produce runoff, like topography, drainage 

pathways, land use and soil characteristics, imposes the division of the basin into several 

homogeneous subcatchments. A subcatchment is a hydrologic unit of land containing a mix of 

pervious and impervious surfaces whose drainage system elements run off to a common outlet 

point (Rossman, 2010). Each of these subbasins represents idealised runoff areas with uniform 

slope (Javaheri, 1998).  
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The user is responsible for dividing a study area into an appropriate number of subcatchments. 

This step was done in ArcMap by identifying an outlet point for each subcatchment and 

delimiting them automatically using the Watershed function. The runoff block of SWMM 

models the generation of runoff (and pollution) from the collection of subcatchments that receive 

precipitation. The routing block of SWMM transports this runoff through the system of conduits 

and allows the quantification of runoff and flow generated within each conduit or subcatchment 

of the study area. Conduits are pipes or channels that move water from one node to another in the 

water system (Rossman, 2010). A junction node is a point where conduits join together, 

representing the confluence of channels or pipes. A junction node is also needed where conduit 

characteristics are modified. Outfalls are terminal nodes of the drainage system used to define 

final downstream boundaries (ibid.). The drain network of the basin was created using the Flow 

Acc output, for which a threshold value was applied to select cells with a high accumulated flow, 

representing the water network. Once each component of the study area was defined, the 

SWMM sketch could be drawn. It is shown in figure 19. The spatial representation does not need 

to be exact since only the property of each subcatchment, conduit and junction are taken into 

account. These ones are presented in the following sections. 

 

 
Figure 19. Sketch representing the study area in SWMM. 

 

 

5.2. SWMM computational methods 
 

SWMM is a physically based, discrete-time simulation model. It employs principles of 

conservation of mass, energy, and momentum wherever appropriate (Rossman, 2010). This 

section describes the methods SWMM uses to model surface runoff and flow within conduits.  
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5.2.1. Surface runoff 

 

The conceptual view of surface runoff used by SWMM is summarised in figure 20 below. This 

method employs the surface water budget (Smith, 2010). Each subcatchment surface is 

considered as a nonlinear reservoir with inflows, assembling precipitation and any upstream 

subcatchment flow, and outflows, including infiltration, evaporation and surface runoff 

(Rossman, 2010). The capacity of the reservoir is the maximum depression storage   . Surface 

runoff   occurs only when the depth of water in the subcatchment   is higher than the maximum 

depression storage    (ibid.). The water in storage is also depleted by evaporation and 

infiltration
3
, modelled by the Horton‟s equation or Curve Number method (see section 5.2.3). 

 

 
Figure 20. SWMM runoff conceptual view (Source: Smith, 2010) 

 

The concept is applied to each subcatchment. The model of surface runoff is based on two 

equations (Pitt et al., 1999). The first governing equation is the continuity of mass equation, 

which calculates the depth of water over the subcatchment and updates it with time: 

 
  

  
 
      

  
         (2) 

where 
  

  
 

      

  
 is the change in volume stored on the subwatershed per time unit and      is 

the rainfall excess of the subwatershed; with       being the volume of water on the 

subwatershed (m³),   the area of the subwatershed (m²),   is the water depth on the 

subwatershed (m),    the time (s),    the rainfall excess (m/s) (rainfall intensity minus 

evaporation/infiltration rate), and   is the runoff flow rate from the subwatershed (m³/s) (ibid.). 

 

The second equation is based on Manning‟s equation and is used to model the overland flow rate 

(or surface runoff): 

                                                 
3
 Infiltrated water is routed through upper and lower subsurface zones and may contribute to total runoff through 

groundwater flow. In this case, no information concerning groundwater flow has been encoded in the model. 

Therefore, infiltrated water is considered as lost. 
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 (3) 

where    is the cross-sectional area of flow over the subcatchment (m²), equal to the width of 

overland flow   multiplied by the flow depth       ,   is the Manning‟s coefficient,    is the 

slope of the subcatchment and    is the hydraulic radius of flow over the subcatchment (m) 

(ibid.). The hydraulic radius is defined as the ratio of cross section area    to the wet perimeter. 

It is evident that the flow width is significantly larger than the flow depth and therefore the 

hydraulic radius converges towards the flow depth       . Considering that, the previous 

equation becomes: 

    
       

      
   

 
 (4) 

Substituting this equation into equation (1) and dividing by   gives the second governing 

equation used in SWMM: 

 
  

  
    

       
      

   

   
 (5) 

The two governing equations are solved numerically as follows. The continuity of mass equation 

[equation (1)] is approximated by: 

 
       

  
     

 

 
    

       
      

   

   
 (6) 

where            is the time step (s),    is the average precipitation intensity during time 

step     (m/s),   is the average runoff flow rate during time step      (m³/s), and   is the 

average depth of flow during time step     (m), equal to 
       

 
 (ibid.). The differential term 

  

  
 is therefore firstly approximated by a finite difference of value of depth at two points in 

time   and     and then approximated by the average of the terms on the right-hand side 

evaluated at the beginning and end of the time step. 

 

This nonlinear equation (6), having one unknown term at any time, (    ) is solved numerically 

using the Newton-Raphson technique, a widely used technique for solving equations numerically 

(Smith, 2010). The calculated      is then used in equation (4) to compute the value of   at the 

end of the time step (Pitt et al., 1999). According to Smith (2010), this method assumes that the 

depth of flow over the surface is quasi-uniform, which over-estimates the volume on the surface. 

This would result in a surestimation of the peak runoff.   

 

 

5.2.2. Flow routing 

 

Flow routing is a procedure to determine the time and magnitude of flow at a point in the system 

based on known or assumed hydrographs at one or more points upstream (Cantone, 2010). Flow 

routing within a conduit in SWMM is governed by the conservation of mass and momentum 

equations for gradually varied, unsteady open channel flow (Rossman, 2010). These equations 

are the Saint-Venant equations. The SWMM allows the user to choose the level of sophistication 

used to solve the equations. The Kinematic Wave and the Dynamic Wave routing methods are 

described below. They are distributed models, which means that the routing of the flow is 
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calculated as a function of space and time (Cantone, 2010). Therefore, they are able to describe 

the passage of water through channels, accounting for flow rate, velocity and depth (ibid.). 

 

5.2.2.1. Saint-Venant equations 

 

Flow can be represented by the two Saint-Venant partial differential equations. The momentum 

equation is defined by: 

 
 

 

  

  
 
 

 

 

  
 
  

 
   

  

  
             (7) 

The continuity equation is: 

 
  

  
 
  

  
   (8) 

Where   is the flow depth (m),   is the distance along the conduit (m),   is the time (s),   is the 

acceleration due to gravity (9.8m/s²),    is the friction slope (m/m),    is the bed slope (m/m),   

is the flow rate (m³/s) and   is the cross-sectional area of flow (m²) (Pitt et al., 1999). In 

SWMM, the flow rate is related to the flow depth, bed slope and friction slope by employing the 

Manning‟s equation (Rossman, 2010). Each of these variables is represented in figure 21. 

 

 
Figure 21. An elementary channel reach for derivation of the Saint-Venant Equations (from top to 

bottom: elevation view, plan view) (Source: Mujumdar, 2001) 

 

The terms in the momentum equation describe the physical processes that govern the flow 

momentum. These terms are: 

- 
 

 

  

  
 : local acceleration term, describing change in momentum due to the change in 

velocity over time; 
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- 
 

 

 

  
 
  

 
  : convective acceleration term, describing the change in momentum due to the 

change in velocity along the channel; 

-  
  

  
 : pressure force term, denoting the change in the water depth along the channel; 

-          : gravity force term, proportional to the bed slope and friction force term, 

proportional to the friction slope (Mujumdar, 2001). 

 

The terms in the continuity equations represent: 

- 
  

  
 : inflows and outflows to and from a control volume or the rate of change of channel 

flow width distance; 

- 
  

  
 : change in amount of water in control volume or the rate of change of area with time 

(ibid.). 

 

It is not possible to solve Saint-Venant equations analytically (Mujumdar, 2001). Numerical 

solutions are possible and depending on the desired accuracy, routing flow equations are either 

generated by using the complete momentum equation or by eliminating some of its terms (ibid.). 

In all cases, finite difference approximations, as used for the runoff surface routing, are used to 

numerically solve the two partial differential equations (Pitt et al., 1999). 

  

5.2.2.2. Kinematic Wave routing  

 

The Kinematic Wave method neglects the local acceleration, convective acceleration, and 

pressure terms in the momentum equation (Cantone, 2010). According to Mujumdar (2001), it is 

thus represented by: 

                  =    (9) 

The Kinematic Wave model cannot account for backwater effects, entrance/exit losses, flow 

reversal or flow acceleration (Mujumdar, 2001). According to Rossman (2010) it can usually 

maintain numerical stability with moderately large time steps (5 to 15 minutes). It is the simplest 

approximation of the Saint-Venant momentum equation.  

 

5.2.2.3. Dynamic Wave Routing  

 

Dynamic Wave routing solves the complete Saint-Venant flow equations and therefore produces 

the most theoretically accurate results (Rossman, 2010). Dynamic wave routing can account for 

channel storage, backwater effects, entrance/exit losses, flow reversal, and pressurized flow 

(ibid.). However, the computation time is longer than with the other method. 

 

 

5.2.3. Infiltration model 

 

Infiltration represents the loss due to rainfall penetrating the ground surface into the unsaturated 

soil zone of pervious areas of a subcatchment (Rossman, 2010). It is influenced by several 
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factors including the condition of the soil surface and its vegetative cover, the properties of the 

soils (porosity, hydraulic conductivity), and the current moisture content of the soil. SWMM 

offers three choices for modelling infiltration, among which Horton‟s equation method and 

Curve Number method, the two methods tested in this work. According to Gironàs et al. (2009), 

there is no general agreement on which method is the more appropriate. The Horton model has a 

long history of use in dynamic simulations while the Curve Number method is derived from the 

SCS Curve Number method used in simplified runoff models. 

 

5.2.3.1. Horton’s equation 

 

The Horton method is based on empirical observations showing that, if the soil has infiltration 

capacities (mm.h
-1

), infiltration decreases exponentially from an initial maximum rate to a 

minimum rate during a long rainfall event for which the rain intensity is greater than the 

infiltration capacity (Rossman, 2010). The decrease in infiltration capacity is the result of the 

operation of the following processes: packing of the soil-surface by rain, dilation of the soil 

openings and filling of the soil-surface openings by fine materials (Beven, 2004). Therefore, in 

the case of rainfall excess, surface runoff will occur. If the rain falls at rates less than the 

infiltration capacity, all water will infiltrate (ibid.), without any runoff. The appendix contains a 

figure which illustrates the Horton method. 

 

This model includes the following parameters. The first one is the maximum infiltration rate 

(mm/h), which is the initial infiltration rate at the start of a storm. It depends on soil type, initial 

moisture content and surface vegetation (Javaheri, 1999). The second parameter is the minimum 

infiltration rate (mm/h), which is the limiting infiltration rate that the soil attains when fully 

saturated and is equal to the soil‟s saturated hydraulic conductivity (Gironàs et al., 2009). The 

third one is the decay coefficient (h
-1

), that describes how quickly the rate decreases over time, 

and the time it takes a fully saturated soil to completely dry (ibid.). The infiltration rate    at time 

t is therefore equal to: 

                  
   (10) 

where    is the minimum infiltration rate,    is the initial infiltration rate or maximum infiltration 

rate (at time t  = 0), and   is the decay coefficient (Beven, 2004). 

 

5.2.3.2. Curve Number method 

 

The Curve Number method, developed by the U.S. Department of Agriculture (USDA)  also 

called the Soil Conservation Service (SCS), assumes that the total infiltration capacity of a soil 

can be found from the soil‟s Curve Number (CN) (Rossman, 2010), a parameter characterising 

the runoff properties for a particular soil and ground cover. In other words, the CN method can 

be used to estimate the depth of direct runoff from the rainfall importance, given an index 

describing runoff response characteristics (Boonstra, 1994). The CN method is based on the facts 

that when a long-duration, high-intensity rain falls over a small drainage basin, the runoff only 

starts after a certain quantity of rainfall has accumulated, and the curve is asymptotic (ibid.). To 

describe this curve, USDA assumes that the ratio of actual retention   to potential maximum 

retention   is equal to the ratio of actual runoff   to potential maximum runoff, being rainfall   
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minus initial abstraction    (ibid.).    represents all losses before runoff begins, including water 

retained in surface depression, intercepted by vegetation, evaporation and infiltration (USDA, 

1986) while   is the loss of additional rainfall in the form of infiltration after runoff has begun 

and   is the potential maximum retention, reached with increasing rainfall (Boonstra, 1994). The 

equation is therefore: 

 
 

 
 

 

    
 (11) 

where all parameters are expressed in millimetres. 

After runoff has started, all additional rainfall becomes either runoff or actual retention so the 

actual retention   is the difference between rainfall   minus initial abstraction    and runoff  : 

           (12) 

The SCS runoff equation is therefore obtained by combining the two previous equations: 

    
       

 

          
 (13) 

   was found to be correlated with   as: 

         (14) 

Therefore, by combining equation (13) and equation (14): 

    
          

        
            (15) 

where the potential maximum retention   is related to the soil and cover conditions through the 

CN by: 

     
     

     
 (16) 

where the CN, depending on the cover type, hydrologic condition and hydrologic soil group, is 

determined thanks to the SCS CN table. Figure 22 shows the graphical solution of the SCS 

equation [equation (15)]. It shows that a high CN, being 100 for roads where potential maximum 

retention is 0 for example, causes all rainfall to appear as runoff while lower CN, for permeable 

areas, produces less runoff. 

 

 
Figure 22. Runoff depth   as a function of rainfall depth   and CN (Source: Boonstra, 1994) 
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5.3. SWMM subcatchments parameters 

 

In order to solve the equations presented in the previous chapter, several variables need to be 

encoded into the model. For each subcatchment, the following parameters must be provided for 

the model to run: area, width, slope, percent of imperviousness, infiltration coefficients, and the 

Manning's coefficient and depression storage for both pervious and impervious areas. Different 

values for each parameter were calculated when it was possible, in order to assess its influence 

on the modelling for the adjustment. All details about technical manipulations are given in the 

tutorial (section 4). All subcatchments parameters are summarised at the end of this section, in  

. 

 
5.3.1. Area 

 

The area is determined from the resolution of the Watershed output (20 m) and the number of 

pixels contained in each subcatchment. It is then transformed into hectares. Subcatchments 1 and 

15 are the largest ones, with surfaces of 141 and 143 ha respectively. 

 

 

5.3.2. Width of overland flow 

 

According to Cantone (2010), the width has no real physical meaning. In theory, it represents the 

width over which surface runoff occurs (Pitts et al., 1999). If overland flow runs downslope off 

an idealised rectangular catchment which has a channel on its middle, the width of 

the subcatchment is the physical width of the overland flow (Javaheri, 1998). This parameter 

reflects the time of concentration – the traveltime for the first drop of effective precipitation at 

the most hydraulically distant point in the watershed to reach the watershed outlet (Straub et 

al., 2000) – for a given subcatchment: a small value of the subcatchment width increases the 

storage of the catchment; a large value decreases the storage and causes the peak flow to occur 

sooner. Since real watersheds are irregularly shaped, it may be difficult to determine the width of 

the subcatchment. Moreover, there are several ways to determine it. This parameter is therefore 

considered a calibration parameter whose value can be adjusted to produce a good match 

between observed and modelled hydrographs (Gironàs et al., 2009). Rossman (2010) also 

considers that adjustments should be made to this parameter to produce good matches to 

measured hydrographs. Three methods used in the determination of this parameter are presented 

below. 

 

Rossman (2010) and Gironàs et al. (2009) estimate the width of the subcatchment as its area 

divided by the average maximum overland flow length. In applying this approach, the channelled 

flow is not included as part of the flow path. The longest overland flow path was determined 

using the HEC-GeoHMS extension of ArcMap. It was edited manually to exclude the channelled 

flow. The length of each subbasin overland flow path was calculated and the subcatchment area 

was divided by it to determine the width. 

 

Javaheri (1998) computes the width in a different way. First, a skew factor is calculated. It is 

defined as: 

t a b l e  3 .  s u b c a t c h m e n t  p a r a m e t e r s  
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 (17) 

 

 

Where   is the skew factor (comprised between 0 and 1),    is the area to one side of the main 

channel,    is the area to the other side of the main channel and   is the total area of the 

subcatchment (         ). The width is then defined as: 

                (18) 

Where   is the length of the main drainage channel. Manipulations to calculate the width using 

this method were done using the editing tools in ArcMap. 

 

Finally, Cantone (2010) considers that subcatchment width should be approximately twice the 

length of the main drainage channel through the catchment. This method was also tested. The 

width calculated with this method showed particularly high values. 

 

 

5.3.3. Slope 

 

The slope associated to each subcatchment is the slope of the land surface over which runoff 

flows (Gironàs et al., 2009). The slopes of the Upper Bukit Timah basin were calculated from 

the new generated DEM (Slope function). Figure 23 illustrates this. It can be seen that the area 

surrounding the Upper Bukit Timah summit is steeper that the rest of the basin. On the other 

hand, the main channel has a weak slope of less than one percent. A mean value for each 

subcatchment was calculated by multiplying each subcatchment mask by the slopes extracted 

from the DEM (using Raster Calculator). Subcatchments 5, 12, 14 have logically the highest 

mean slopes (14.0 %, 13.8 % and 23.1 % respectively). 

 

 
Figure 23. Slopes of the Upper Bukit Timah basin 
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5.3.4. Percentage of impervious area 

 

This parameter is expressed as the percentage of land area which is impervious, through which 

rainfall cannot infiltrate. According to Gironàs et al. (2009), it is one of the most sensitive 

parameter in the hydrologic characterisation. The mean percentage of imperviousness can be 

calculated from the coefficients of imperviousness associated to each land use class. A weighted 

percentage of impervious area can therefore be determined from the area of each land use class 

within the subcatchment, using the Clip function to extract the part of the land use that overlays 

the subcatchment. 

 

There are many different imperviousness coefficients in the literature. As a first choice, the mean 

value from all literature sources was used. Other tests were realised using the coefficient of 

imperviousness provided by Guo (2003). Table 1 below gives the coefficients of imperviousness 

for each land use class. Figure 24 shows the percentage of imperviousness calculated for each 

subcatchment, using the values given by Guo (2003). 

 

Table 1. Coefficients of imperviousness for each land use class 
Land use classes Coefficients of imperviousness 

Mean values from several sources* Values from Guo (2003) 

Apartment 0.70 0.70 

Multiple-family, attached 0.70 0.70 

Multiple-family, detached 0.50 0.50 

Single-family 0.50 0.50 

Commercial & Educational 0.85 0.70 

Industrial 0.82 0.80 

General vegetation 0.10 0.07 

Woodland 0.01 0.01 

Car park 0.74 0.74 

Road 0.96 1.00 

Railroad 0.20 0.20 

Lake 0.00 0.00 

Construction site 0.60 0.60 

* County of San Diego Department of Planning and Land Use (2008), Guo (2003), Mason and Knight (2001), Pikes 

Peak Area Council of Governments (2005), Washburn et al. (2010), Wisconsin Department of Transportation (2007). 

 

5.3.4.1. Coefficients of imperviousness accuracy 

 

There are several methods to determine the percentage of imperviousness of an area. Calculating 

the imperviousness by determining the land use category for each area and multiplying by the 

typical imperviousness coefficient of that category implies uncertainties. Firstly, the published 

coefficients vary for a land use category to another. Secondly, the imperviousness can be 

different within the same category of land use. With this method, it is difficult to outline specific 

impervious surfaces, like individual buildings and their surrounding open spaces, roads, etc. 

since. Moreover, the resolution is much lower than an aerial photograph. The most accurate 

methods for determining imperviousness are direct methods. Ground surveys result in very 

accurate outlines of features (Mason and Knight, 2001). Orthophotographies are also a solution 

to acquire land cover information, since distortion is removed from the original photograph and 
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since the resolution is higher than satellites images. Individual features can therefore be 

separated. However, these two direct methods are expensive and rarely feasible. 

 

 
Figure 24. Percentage of imperviousness associated to the subcatchments 

 

 

5.3.5. Infiltration parameters 

 

Infiltration methods have been explained in section 5.2.3. These paragraphs present the values of 

the parameters used for the Horton and CN methods. 

 

5.3.5.1. Horton’s parameters 

 

Representative values of the maximum infiltration rate are given by Rossman (2010). For moist 

sandy loam soils
4
, which have drained but not dried out, the value has been calculated to be 

33.8 mm/h. Javaheri (1999) gives a range of possible values of 6.75-160 mm/h. He chose, as 

well as Liong et al. (1993), values from 45 to 80 mm/h
 
for the Upper Bukit Timah catchment. A 

value of 70 mm/h
 
was adopted for this model, as proposed by Selvalingam et al. (1987) for the 

Upper Bukit Timah basin. The minimum infiltration rate is equal to the hydraulic conductivity, 

estimated at 10.9 mm/h
 
by Rossman (2010) and between 7.6 and 11.4 mm/h

 
by Akan (1993) for 

sandy loam soils. Butler and Davies (2004) give a value of 12 mm/h for medium textured soils, 

such as sandy loam soils. The initial estimates used in the research of Javaheri (1999) are the 

same than in the work of Liong et al. (1993) and, are 2.5-3.5 mm/h. Selvalingam et al. (1987) set 

this value between 2 and 5. Given the variability of the values from literature, a mean value of 

                                                 
4
 The Rengam series have sandy loam textures in the topsoil. These series are largely dominant on the Upper Bukit 

Timah basin; the representative values of the infiltration parameters have therefore been taken on the basis of this 

type of soil. 
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10 mm/h has been used for the model. The decay constant has been set to 4 h
-1

, as Rossman 

specifies that it is comprised between 2 and 7 h
-1 

while Javaheri (1999) gives values ranging 

from 0.66 to 4.07 h
-1

 and specifies that a value of 4.25 h
-1 

could be used if no field data is 

available. Selvalingam et al. (1987) gives value in accordance with Javaheri (1999). Butler and 

Davies (2004), on the other hand, estimate that the decay coefficient is equal to 2 h
-1 

for every 

type of soils. 

 

5.3.5.2. Horton’s parameters uncertainty 

 

Ideally, the Horton‟s parameters should be estimated using results from field infiltrometer tests 

for several sites of the watershed and for different antecedent wetness conditions. Unfortunately, 

such measurements were not available in Singapore. It is certain that the parameters estimated 

above are only a first approximation based on different sources of the literature. Moreover, for 

all storms, the same value of all variables was used, the initial conditions assumed to be uniform 

for all events. However, the initial infiltration values can change due to initial wet conditions. A 

60-70 % reduction in the initial infiltration rate is expected if initial conditions are wet (Javaheri, 

1999). Also, each parameter was set to be the same for all subcatchments, the method does not 

take into account the variations in land use or soil type within the basin. But, the presence of 

vegetation, for example, can increase infiltration capacities. ASCE (1996) estimates that 

infiltration rates must be multiplied by a cover factor ranging from 3 to 7.5 for good permanent 

forest and grass. 

 

5.3.5.3. Curve Number 

 

Two CN grids for the Upper Bukit Timah basin were computed using the method prepared by 

Merwade (2010). This method uses the HEC-GeoHMS extension of ArcMap to create a CN Grid 

from the land use and soil maps. To implement this method, a hydrologic soil group was 

associated to each type of soil, C for Rengam and red variant Rengam series, D for Tengah 

series, according to the SCS classification (tutorial, section 4). A CN was also associated to each 

type of land use and according to the soil group. All CN used here figure in table 2. The soil and 

land use data were then combined to create a curve number grid using HEC-geoHMS. A 

weighted CN was associated to each subcatchment by calculating the surfaces associated to one 

CN. Figure 25 shows a map of the CN grids created. The CN grid 2 presents CN sensibly higher 

than the CN grid 1. 
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Table 2. CN table 

CN Grid 1* CN Grid 2** 

Land use class 
CN  

Soil C 

CN  

Soil D 
Land use class 

CN 

Soil C 

CN 

Soil D 

 

 

 

Medium residential, 

 
(containing developed open 

space and developed areas 

from low to high intensity, 

according to Merwade 

(2010))   

81 86 

Apartment 90 92 

Multiple-family, attached 90 92 

Multiple-family, detached 90 92 

Single-family 81 86 

Commercial & Educational 94 95 

Industrial 91 93 

General vegetation 74 80 

Car park 98 98 

Road 98 98 

Construction site 89 91 

Forest 71 78 Forest 70 77 

Water 100 100 Lake 100 100 

*Land use classes and CN determined by Merwade (2010). 

**Land use classes determined by personal classification, CN determined from Dunne and Leopold (1978), Marek 

(2009) and USDA (1986). 

 

 
Figure 25. CN Grids created from the CN figuring in table 2 (annotations refer to each average 

subcatchment CN) 

 

5.3.5.4. Curve number method quality 

 

The advantage of this method is that a CN is associated to each subcatchment, in opposition to 

Horton‟s method for which the values were fixed for the entire basin. Moreover, the CN given in 

the literature did not show any variability, contrarily to the Horton parameters for which 

infiltration rates may in fact double from one source to another. Finally, this approach, which 

only requires soil and land use data, considers the temporal distribution of rainfall, all initial 

rainfall losses and an infiltration rate that decreases during the storm (Marek, 2009).  

 

There are, however, some uncertainties concerning this method. Firstly, the effect of the basin 

initial wetness is not taken into account, whereas values of CN are expected to vary with site 
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moisture. By opposition, in the Horton method, initial moisture content can be considered 

(although, in this case, initial conditions remain constant for all storm events). Secondly, the 

soils of the area could have been identified from a soil survey report, and the associated precise 

soil map would have brought a better CN. In this case, the soil map was provided by Chuah 

(1987) which gave a simplified map, with uncertain limits between soil types. Thirdly, USDA 

(1986) notices that urbanisation involves the disturbance of the soil profile which can 

significantly change its infiltration characteristics. For example, mixture, removal of soil 

profiles, filling with material from other areas or compaction of the soil can severely affect the 

infiltration of the natural hydrologic soil group (Marek, 2009).  

 

 
5.3.6. Manning’s coefficient  

 

The Manning‟s roughness coefficient reflects the amount of resistance that overland flow meets 

as it runs off the subcatchment surface (Gironàs et al., 2009). As described above, SWMM uses 

the widely used Manning‟s equation, originally developed to describe flow in channels, to 

compute the overland flow rate. 

 

Separate values of Manning‟s roughness coefficient for overland flow are required for the 

impervious and pervious fractions of a subcatchment. This is because the pervious coefficient is 

generally an order of magnitude higher than the impervious one. Values of Manning's coefficient 

are not as well known for overland flow as they are for channel flow because of the considerable 

variability in ground cover, the very small depths of water on the surface and the complication in 

the estimation of its value due to the transitions between laminar and turbulent flow (Javaheri, 

1999). It is therefore best to refer to the appropriate values applicable to the area of study. 

Selvalingam et al. (1987) gives the following values for the Upper Bukit Timah catchment. For 

impervious areas, the value was set to 0.028 while for pervious areas, it was set to 0.35 for every 

subcatchment. For the Upper Bukit Timah basin, Javaheri (1999) set the values at 0.012 and 0.3 

while Liong et al. (1993) fixed the values at 0.02 and 0.3 for impervious and pervious areas 

respectively. Values chosen in this study differed from one land use class to another and from 

one catchment to another contrarily to these previous studies. They took into account the 

coefficients given by the two previous sources, but also the ones brought by Rossman (2010) and 

USDA (1986). Thus, the Manning‟s coefficient for impervious surfaces (industrial, parking and 

roads) was set at 0.011 while for general vegetation and forests, it was fixed at 0.24 and 0.6 

respectively. Other pervious land use classes have a coefficient of 0.05. Thereby, a weighted 

coefficient was calculated for the impervious and pervious areas of each subcatchment. 

 

 

5.3.7. Coefficient of storage and percentage of impervious area without depression 

storage 

 

Depression storage corresponds to a volume that must be filled prior to the occurrence of any 

runoff, such as surface ponding, interception by vegetation, etc. (Rossman, 2010). In this case, 

the DEM generation process has involved all sinks to be filled to ensure proper delineation of 

basins and streams. If closed depressions are not filled, the drainage network may be 

discontinuous. That is why a coefficient of storage value of 0 was chosen, by conception, for 
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both pervious and impervious fractions of each basin. Nonetheless, the model will show if this 

value needs to be modified. 

 

The second parameter, the percentage of impervious area without depression storage, represents 

direct runoff that occurs at the start of rainfall before depression storage is satisfied (Gironàs et 

al., 2009). Concretely, it represents pavement that has no surface ponding, rooftops that drain 

directly to street gutters, etc. (ibid.). In this particular case, there is no depression storage and 

therefore, the value of this parameter does not matter at first. 

 

The assumption that there is no depression in the basin is in accordance with the DEM 

previously built. However, it is undeniable that the surface is not smooth and that a certain 

volume of rain is stored in depressions or intercepted by vegetation. As an example, the porous 

pavement in some areas allows precipitation to be stored in it instead of being able to run off the 

surface (figure 26). 

 

 
Figure 26. Porous pavement, car park at the Bukit Timah Nature Reserve (08/09/2010) 

 

 

5.4. SWMM conduits and junctions parameters 

 

For each conduit, the length, slope, Manning‟s coefficient, shape, width, and depth must be 

known. Forty-five conduits were represented in the model since a new conduit was needed in the 

model for each variation in its dimensions. For each junction, only the invert elevation is needed. 

 

 

5.4.1. Conduits properties 

 

5.4.1.1. Length and slope 

 

Upstream and downstream elevation of each conduit must be entered in the model in order to 

characterise the slope of each drain. Elevations were determined on the DEM, using the 

measuring tool of ArcMap. The length between the two elevations points was also measured. 

 

5.4.1.2. Manning’s coefficient 

 

As the overland flow rate, the Manning‟s equation is used to express the flow rate   in a channel 

of cross-sectional area  , hydraulic radius   , slope   and Manning‟s coefficient  : 
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 (19) 

According to Rossman (2010), concrete lined channels have a Manning‟s roughness coefficient 

comprised between 0.011 and 0.02. Chuah and Wong (2010) estimate the concrete drains 

coefficient at 0.013 while Javaheri (1999) gives values of 0.012. Selvaligam et al. (1987) 

consider values between 0.028 and 0.056. This last source is considered as erroneous, maybe 

because the study is too old and drains have changed since then, thanks to drainage 

enhancements in Singapore. Some dirt channels are present in upstream areas of the basin. Their 

Manning‟s coefficient has been set to 0.03, as specified by Chuah and Wong (2010) and 

Rossman (2010). Several tests have been done with different values of Manning‟s coefficient for 

concrete channels.  

 

5.4.1.3. Cross-sectional geometry, width and depth  

 

It has been explained in chapter 4 how the shape, width and depth of conduits were determined. 

The values for each drain were encoded in the SWMM manually. Three cross section shapes are 

represented in the Upper Bukit Timah basin: rectangular, trapezoidal or triangular channels 

(figure 27). The height and width must be encoded for all shapes. In addition, the side slopes are 

needed for trapezoidal channels. The depth varies from 0.5 m for channel situated upstream to 

2.67 m for the large channel at the outlet. Likewise, the width varies from 0.66 m for small 

upstream triangular conduits to 5.8 m for the large Bukit Timah channel. 

 

 
Figure 27. Rectangular, trapezoidal and triangular drains at the Greenbank Park, the Bukit Timah 

road and the Toh Tuck road respectively (17/08/10) 

 

 

5.4.2. Junctions invert elevation 

 

Junctions invert elevations were encoded using the DEM; this corresponds to the upstream and 

downstream elevations of conduits.  
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5.5. Discharge and rainfall data 

 

The most important hydrologic data requirement is the rainfall data (Rossman, 2010). In order to 

adjust a watershed model, discharge data at the outlet related to rainfall are also essential. 

Unfortunately, no discharge data were available from the authorities despite several attempts. 

Old hydrographs and hyetographs were extracted from literary articles. In order to make sure the 

model was correct for current data, rainfall and discharge data were also obtained with indirect 

methods. This section describes how these data were acquired. The details of all manipulation 

figure in the tutorial, sections 5 and 6. 

 

 

5.5.1. Old hydrographs and hyetographs 

 

Several authors studied the Upper Bukit Timah catchment and some of them published 

hydrographs related to hyetographs
5
. Although they date from the 1980s, they were extracted in 

order to be used for the model parameterisation. A total of sixteen hydrographs and hyetographs 

of different intensities, durations, seasons and recording intervals were used (table 1). These 

storm events cover a large spectrum of events, in order to illustrate the variability of rainfall 

within the watershed. For example, the storm event of the July 2
nd

, 1984, lasted for 16 hours and 

the rainfall intensity did not reach 10 mm/h, resulting in a discharge of 3.7 m³/s. In the other 

hand, the rainfall of the April 3
rd

, 1988, lasted for 6 hours, the rainfall intensity exceeded 

92 mm/h and the discharge reached 27 m³/s. The data were extracted by georeferencing the 

graphs, digitising curves and histograms, extracting their values and reporting them in Excel. All 

details can be found in the tutorial, section 5.  

 

Table 4.  Characteristics of storm events extracted from the literature 

Storm 

events 

Duration 

(hh:mm) 

Max. rainfall 

intensity 

(mm/h) 

Max. 

discharge 

(m³/s) 

Storm characteristics 

12 Feb 78 03:30 84.3 29.1 Four major peaks, three minor 

02 Dec 78 03:30 54.9 19.8 Three major peaks 

01June 79 07:00 64.2 18.1 One peak 

03 Feb 84 03:30 34.1 19.3 
Three major peaks, highly variable 

hydrograph 

02 Mar 84 19:00 34.6 19.9 
Six major peaks, highly variable 

hydrograph 

02 Jul 84 14:30 9.3 3.7 Two major peaks 

03 Jan 85 13:10 21.2 7.5 Two peaks, the 1st smaller 

01 Aug 86 19:00 27 14.5 
Four major peaks, highly variable 

hydrograph 

18 Jun 86 10:10 86.5 22.4 Two peaks, the 2
nd

 very small 

07 Oct 86 10:10 71.9 20.3 Two peaks, the 2
nd

 very small 

27 Nov 87 05:30 69.5 19 One peak 

15 Feb 88 05:30 125.1 26.1 Two peaks, the 1
st
 one higher 

03 Apr 88 06:00 92.5 27.7 One peak 

                                                 
5
 Liong et al. (1986), Selvalingam et al. (1987), Liong et al. (2002), Khu and Werner (2003), Chuah and Wong 

(2010). 
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[continued]     

17 Apr 88 06:30 104.8 29.1 One peak, slow recession 

11 Jul 88 05:45 66.5 21.4 One peak 

18 Apr 89 03:30 154.9 23.7 One peak 

 

5.5.1.1. Uncertainties concerning old data 

 

It is evident that there are several uncertainties concerning the quality of the data. These are 

linked to the method of extraction but also to the fact that the methods of data obtaining are not 

known. Indeed, there is no information about the techniques of measurement of discharge and 

rainfall and the estimation of these. This fact can represent a first approximation. Also, the old 

hyetographs and hydrographs show some imprecision inherent to their representation. For 

example, measured discharge curves sometimes merge with modelled curves; this fact has an 

impact on the digitisation. Then, the thick lines representing the axes and the discharge and 

rainfall data prevent an exact digitisation and georeferencing. Furthermore, the graduation is 

often too weak, which lowers the quality of georeferencing. Finally, the biggest error is certainly 

due to the fact that, since the articles are relatively recent in comparison to their discharge and 

rainfall data, their old hyetographs and hydrographs probably result from secondary sources and 

do not come from direct measurements. Thus, the data extracted by this mean is certainly 

tarnished with several errors 

 

5.5.2. Recent discharge and rainfall data 

 

Finding recent data was not as simple. Several interesting storms events, for which the water 

depth at the outlet of the basin exceeded 1 m, were selected.  Then, the rainfall and discharge 

data of these were obtained by different means, which are explained below. 

 

5.5.2.1. Rainfall data 

 

The National University of Singapore (NUS) provides, free of charge, rainfall data of the NUS 

weather station. The records cover the period of time from August, 2003 to the present. The 

weather station is situated on the university campus, in the southern part of the island. Our 

calculations show that the distance between the centre of the basin and the weather station is 

about 5.5 km (figure 28). Due to the too high spatio-temporal variability of rainfall in Singapore 

observed on the RADAR images and according to the literature, it was decided not to use the 

NUS rainfall data directly in the modelling. 

 

RADAR images facilitate the inclusion of spatial and temporal variability of rainfall. 

Meteorological RADAR operates with the same principle as other RADAR but the wavelength 

of electromagnetic waves emitted varies from 3 to 10 cm (Alicime, 2008).  The meteorological 

RADAR emits an electromagnetic signal and the energy received from the detected rain is 

directly related to the amount of precipitation (ibid.). This fact allows for the generation of 

circular maps for which the radius is within the range of 150 to 250 km (ibid.). This kind of map 

gives a qualitative value of the detected precipitation.  In Singapore, the RADAR is located near 

the runways of the Singapore Changi International Airport in the eastern part of the island. Some 

6000 RADAR images were downloaded from the Singapore‟s National Environment Agency‟s 
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website
6
 during the period of May and June 2011 thanks to an automatic recording script (batch 

file). One image every 10 minutes is published on the website (figure 29). The resolution of 

these images is 220 m. In order to extract data from several storm events of May and June 2011, 

the aim was to transform the qualitative scale of the map into quantitative scale. To do so, 

rainfall data from the NUS station were used. The manipulations are explained below. 

 

 
Figure 28. Location of the NUS weather station 

 

         

         

Figure 29. RADAR images of the 5
th

 of June, 2011, storm. From left to right: 09:40, 10:00, 10:30 

and 10:50 (Source: National Environment Agency, 2002) 

 

                                                 
6
 National Environment Agency, 2002.  
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After several pre-treatments concerning the colours, each RADAR image was georeferenced in 

UTM 48N. Then, each image was reclassified to create thirty-one classes representing each 

colour of the qualitative scale, the remaining (background, title...) being set at 0. The qualitative 

value at the NUS weather station point previously created was then extracted (using the Zonal 

Statistics as Table function). For each event, one event being composed of six to forty-three 

images, the relationship between the qualitative values and the measured values at the NUS 

weather station was established for each point in time. The polynomial equation was calculated 

and some aberrant points
7
 were deleted in order to obtain a coefficient of determination R² 

superior to 0.8 (figure 30). A total of 143 images consisting of nine events have been used.  

 

 
 

 
 

 
Figure 30. Relationships between qualitative and quantitative values at NUS weather station for 

nine storm events 

                                                 
7
 For example, a value of 0 in the qualitative scale sometimes gave a value superior to 0 in the quantitative scale. 

This fact is probably due to a possible time lag between the quantitative and qualitative values. These kinds of points 

have been deleted in order to obtain a realistic relationship. 
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From all polynomial equations, the “mean” relationship between the variables has been 

calculated in order to obtain the values of precipitation for the different classes of the qualitative 

scale (figure 31). Linear interpolations were used for qualitative values between 0 and 5 while a 

polynomial interpolation was used for qualitative values superior to 5. In order to quantify the 

rainfall events within the Upper Bukit Timah basin, a mean qualitative value was extracted using 

the Zonal Statistics as Table function and then was transformed in rainfall intensities using the 

general relationships previously established. This step was repeated for each image of every 

event. 

 

 
Figure 31. General relationships used to transform qualitative values into rainfall intensities for the 

Upper Bukit Timah basin 

 

5.5.2.2. Discharge data 

 

The PUB is the Singapore‟s national water agency. Its role is to manage the country‟s water 

supply, water catchment and used water in an integrated way (PUB, 2010). Although the PUB do 

not agree to share any discharge data, their website contains an interactive map which shows the 

water level in real time from ninety-three water level sensors around the island (PUB, 2011). The 

data are updated at an interval of 10 min. For the sake of this work, the water level at the outlet 

of the Upper Bukit Timah catchment (Bukit Timah 1st Diversion canal, 6th Avenue), was saved 

every 10 minutes starting with April 29th, 2011, thanks to another batch file used to download 

automatically the main website‟s page
8
 which contains the water level of each PUB‟s station. For 

all the period of record, it was noticed that the minimum water depth, at the 1st Diversion canal 

station, was 0.27 m instead of 0 m. Since PUB did not provide any rating curve despite several 

attempts to obtain one, it was not possible to know the corresponding discharge. The flood of 

June 5
th

 brought the information. In fact, several flash floods occurred in the central and eastern 

parts of Singapore at this date and numerous photos and testimonies were published on the 

                                                 
8
 http://www.pub.gov.sg/general/pages/waterlevel.aspx contains in its html code the name of each station, its 

location, the last recorded water level, the flood alert level and the timestamp of each observation 
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Internet (figure 32). It was reported on Twitter as well as several forums and blogs
9
 that at about 

11:00 AM the bank full flow was reached. At this hour, a water depth of 3 m was recorded by 

the PUB. But, according to Chuah (1989), the depth of the canal at the outlet is not 3 m but 

2.67 m. By subtracting 0.27 m to 3 m, the resulting depth of 2.73 m could correspond to the 

value 2.67 m, the error caused by the divergence of information on the Internet and the latency of 

publishing messages on social websites. Therefore, it was supposed that the value of 0.27 m 

corresponds to a real water depth of 0 m. It was confirmed by the fact that the water level sensors 

do not take into account the low water channel, as shown in figure 33. All the measurements 

were therefore reduced by 0.27 m. 

 

 
Figure 32. Flood at the intersection of Bukit Timah Road and Swiss road, the morning of June 5

th
 

(Source: SPUG forum, 2011) 

 

 
Figure 33. Water level sensors on the edge of the canal, not taking into account the level of water in 

the central notch: A: Bukit Timah Canal (Backmore), B: Sg Kallang Sub Drain (Upper Thomsan 

Rd), C: Stamford Canal (Handy Rd), D: Stamford Canal (Killiney Rd). Sources: testech, n.d. (A), 

Google Street View (B), personal photographs (C, D) 

  

                                                 
9
www.stomp.com.sg/, http://www.spug.sg/forums/,  http://heresthenews.blogspot.com, 

http://www.expatsingapore.com/forum/, for example. 

http://www.stomp.com.sg/
http://www.spug.sg/forums/
http://heresthenews.blogspot.com/
http://www.expatsingapore.com/forum/
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Since PUB did not provide a rating curve, the water level measurements were transformed into 

discharge using the Manning formula. The wetted perimeter   of a trapezoidal channel (m) can 

be defined as: 

             
       

   (20) 

where   is the bottom width (m),   is the water depth (m) and    and    are the side slope on 

bank 1 and 2 respectively (m/m). The bottom width   at the outlet of the catchment is 5.791 m 

and the side slope is 1 on both sides (Chuah, 1989). 

 

The area   of the cross-section is: 

    
 

 
      (21) 

where the top width   (m) is equal to: 

              (22) 

The hydraulic radius    (m) can therefore be calculated by combining equations (21) and (22). 

Finally, from the velocity   (m/s) calculated from the Manning‟s equation, the discharge   

(m³/s) can be determined: 

       
   

   
    

 
 (23) 

where   is the channel slope (m/m) and   is the Manning roughness coefficient (LMNO 

Engineering, Research, and Software, 2000). In this case, the channel slope   is 0.00125 while 

the Manning‟s coefficient was set to 0.015. A bank full discharge of 74 m³/s was obtained for the 

Bukit Timah channel. It should be noted that the flow in the central notch was not calculated, 

since it is negligible during a high flow event. 

 

5.5.2.3. Extracted data and limits 

 

The discharge and rainfall intensity of eight recent storm events were determined for the basin 

(table 5). According to Channelnewasia (2011), the flood of June 5th was triggered by 65 mm of 

precipitation within 30 minutes. The values extracted from the RADAR images were in 

agreement with that fact, since a value of 63.7 mm was obtained between 10:20 and 10:50 AM. 

Moreover, this technique proves to be fairly accurate spatially, since the storm events centralised 

on the Upper Bukit Timah trigger higher discharges than storm events localised on the NUS 

weather station. 

 

Nevertheless, the estimation of the rainfall intensity from RADAR images is affected by 

significant errors. Firstly, it is important to remember that the RADAR image resolution is 

220 m.  Therefore, when the rainfall extracted at the NUS weather station, a pixel of 48400 m², is 

compared to the measured rainfall, the resulting value is certainly affected by this too high 

resolution. Secondly, although as many images as possible were used, the technique employed to 

transform the qualitative scale into quantitative scale is approximate. Indeed, the general 

relationships result from a mean of approximations between quantitative and qualitative values. 

Finally, rainfall estimation by RADAR technology is an indirect measure. It uses pulse-Doppler 

sensors, capable of detecting the motion and the size of rain droplets and the intensity of the 
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rainfall thanks to the reflectivity of radio waves on the drops. However, the quality of the 

estimation depends on the proper calibration of this reflectivity. Masking effects, attenuation or 

signal amplification can affect locally the estimation of the intensity and the location of the 

precipitation. The best solution is to dispose of direct rainfall measurement from the three 

weather stations within the basin and depending on their location, attribute them to the 

subcatchments. Unfortunately, rain gage data was not available for this work. 

 

Discharge data are also uncertain. Since PUB did not provide a rating curve, the transformation 

of water depth into discharge remains an approximation. It was supposed that a bank full 

discharge of 74 m³/s at the outlet of the Bukit Timah canal was an acceptable value, but it was 

not verified. However, the different parameters used in equation (23) should be correct as they 

were provided by a precise sketch done by Chuah (1989).  

 

Table 5. Duration, maximum discharge and rainfall intensity of the eight recent storm events 
Storm events Duration (hh:mm) Max. discharge (m³/s) Max. rainfall intensity (mm/h) 

27 Apr 11 02:10 44.7 66.5 

30 Apr 11 02:30 20.0 43.7 

04 May 11 02:40 37.3 96.6 

10 May 11 02:10 6.7 45.2 

13 May 11 00:50 39.0 67.2 

21 May 11 01:40 64.3 44.8 

25 May 11 02:00 103.6* 49.6 

05 June 11 07:30 79.7 101.5 

*aberrant value (the water depth published by PUB reached 3.9 m) 

 

 

5.6. Evapotranspiration 

 

Evapotranspiration encompasses all phenomena that cause water to vaporise. It is the addition of 

the evaporation from the subcatchments surfaces (lake, streams...), groundwater or vegetation 

and the transpiration from vegetation (Dassargues, 2010). It can be included in SWMM as an 

average monthly value. The monthly mean potential evapotranspiration   (mm/month) can be 

estimated from Thornthwaite‟s formula: 

         
        

 
 

 

       (24) 

where       is the average daily temperature of the month (°C),         is a corrective factor 

depending on the month   and latitude  ,   is a coefficient equal to: 

                                                   (25) 

and   is a heat index depending on the 12 monthly mean temperatures and equal to; 

          

  

   

  
      

 
 

       

   

 (26) 

 

Table 6 presents the calculated potential evapotranspiration. With a mean monthly value of 

142 mm, or 4.6 mm per day, the influence of evapotranspiration is very weak. For example, for a 
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rainfall event of 50 mm within one hour, evapotranspiration only reduces it by 0.17 mm. After 

several tests, it was decided not to include it in the model. Evapotranspiration might only be 

detected in the annual or monthly balance, but not for individual storm events. 

 

Table 6. Monthly mean potential evapotranspiration (mm) 

Jan Feb Mar Apr May Jun Jul Aug Sep Oct Nov Dec 

127 133 147 143 170 144 148 148 143 147 123 127 

(Monthly mean temperature from The Weather Channel, 2011) 

 

 

5.7. SWMM pre-parameterisation 

 

A pre-parameterisation of the SWMM model was done using the old storm events. This was 

realised in order to decide what the best methods for the parameter determination are (eg. Horton 

versus CN for infiltration parameters, Kinematic versus Dynamic Wave for flow routing, etc.). In 

addition to graphical techniques, the Nash-Sutcliffe coefficient was used to evaluate each test. 

Using the results of the pre-parameterisation, a final adjustment was performed to ameliorate the 

pre-parameterised model in a finer way (see next section).  

 

 

5.7.1. Graphical techniques 

 

A visual comparison of simulated and measured hydrographs can bring a first overview of model 

performance. In fact, hydrographs were observed in order to identify model bias, differences in 

timing and magnitude of peak flows and the shape of recession curves. According to Moriasi et 

al. (2007), it is recommended to use both graphical techniques and quantitative statistics to 

appropriately evaluate a model. The Nash-Sutcliffe coefficient constitutes the second method for 

model evaluation. 

 

 

5.7.2. Nash-Sutcliffe coefficient 

 
Moriasi et al. (2007) recommended that the Nash-Sutcliffe coefficient is a good parameter to 

evaluate the efficiency of a watershed model. This coefficient is a normalised statistic parameter 

that determines the relative magnitude of the residual variance compared to the measured data 

variance (ibid.). According to Javaheri (1999), who used the Nash-Sutcliffe coefficient to 

evaluate his parameterisation of the Upper Bukit Timah catchment model, it is a popular function 

that has gained importance. Also, Sevat and Dezetter (1991), who compared different approaches 

used in model calibration, estimated that the best function to use for calibration was the Nash-

Sutcliffe coefficient. This coefficient is defined as follow:  

         
    

      
      

   

    
      

       
   

  (27) 

where   
   

 is the i
th
 observed discharge,    

   
 is the i

th
 simulated discharge,   

    
is the mean of 

observed discharge and   is the total number of observations. 
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Nash-Sutcliffe coefficient ranges between −∞ and 1, 1 being the optimal value. Values between 

0 and 1 are generally acceptable whereas values inferior to 0 show an unacceptable performance 

of the model (Moriasi et al., 2007). It has been estimated that model simulation can be judged as 

satisfactory if the Nash-Sutcliffe coefficient is superior to 0.5 (ibid.).  

 

 

5.7.3. Pre-tests 

 

Twenty one tests were done on the sixteen old storms events (= 336 tests) in order to underline 

what were the best methods for parameters determination (table 7). Each test (or project) was 

performed by changing the parameters manually. Subcatchments area and slope stayed constant 

for all tests. It was also the case for conduits properties, apart for the Manning‟s coefficient and 

depth.  

 

This pre-parameterisation was performed in two stages. The first stage was made of several pre-

project, used to test different parameters. The second stage consisted in modifying first stage best 

projects (projects 15, 22, 23, 24), for which some errors were found concerning conduits length. 

These errors did not impede the model to run and did not greatly influence the outcomes but it 

was preferred to correct them for the remaining of the parameterisation. As first stage projects 

show accurate results and allow to understand which parameterisation is best to be used, they are 

still shown here. 

 

Table 7 shows that the Horton infiltration method gives very bad results compared to the CN 

method. Also, the methods 3 and 4 for calculating the widths, which show higher value than the 

other methods, seem not to be appropriate. In the other hand, smaller widths give better Nash-

Sutcliffe coefficient value. Projects 25_corr and 26_corr, for which the conduits depth was 

increased to 5 m in order to take into account the one-dimensional model limitations and avoid 

the truncation of hydrographs during flood events, have the worst Nash-Sutcliffe value. It can be 

seen on the graphs that, for these projects, there is no loss of water during the modelling and the 

discharge is greatly overestimated. Table 7 shows that all calculated mean Nash-Sutcliffe 

coefficients are negative, which means that the model still have to be improved. The appendix 4 

regroups all graphs of all events tested with each project with their corresponding Nash-Sutcliffe 

coefficient. 
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Project_final was selected for SWMM adjustment (next section), since Nash-Sutcliffe 

coefficients and graphical analysis (see appendix 4) showed the best results. This project 

corresponds to the following characteristics:  

- the width is determined by method 1, namely the subcatchment area divided by the 

maximum overland flow length; 

- the percentage of imperviousness was calculated using the coefficients of imperviousness 

given by Guo (2003); 

- the Manning‟s coefficients for both pervious and impervious surfaces is weighted for 

each subcatchment; 

- the CN method of infiltration is used; 

- the Dynamic Wave method is the flow routing; 

- the Manning‟s coefficient for conduits is set at 0.015 and 0.03 for concrete and earth 

channel respectively, and; 

- the depth of conduits is determined in the previous chapter. 

 

 
 

5.8. Final SWMM adjustment 

 

The previous section showed that the Nash-Sutcliffe coefficients values obtained for 

project_final were negative. It was observed on the graphs that SWMM model always 

overestimated the discharge. To improve the SWMM model, a finer parameterisation was 

performed in order to lower the simulated flow. A summary table below details the 

characteristics of the different projects used for the model adjustment (table 8). All graphs figure 

in the appendix 5. 

 

 

5.8.1. Adjustment tests 

 

Since some authors identify the width as a calibration parameter (see above), several 

modifications of its value were done (width determined by method 1 minus 10, 20, 25, 50, 100, 

200 m). The influence of the width on the model was thus observed. Simultaneously, the 

Manning‟s coefficient was also modified, because its values were uncertain due to the variability 

of the land cover (Javaheri, 1999). The modification consisted in increasing the Manning‟s 

coefficients of impervious surface by 0.002, 0.005, 0.01 and 0.05. Then, on the basis of the 

project for which the width was decreased by 200, several tests were done by modifying the 

Manning‟s coefficient for impervious surfaces. Finally, on the basis of the best previous test 

(width minus 200, Manning‟s coefficient plus 0.002), which gave a mean Nash-Sutcliffe value of 

0.358, the percentage of imperviousness was lowered by 1, 5 and 7 %. In fact, according to 

Javaheri (1999), the percentage of imperviousness was one of the best calibration parameter, as 

the width. A last test was performed using the CN Grid 2. Table 8 below gives all the details of 

the adjustment tests. 
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5.8.2. SWMM final parameterisation 

 

5.8.2.1. Characteristics 

 

A final project was selected, the mean Nash-Sutcliffe coefficient being 0.482. The graphs 

corresponding to this project are grouped in figure 34. The selected project characteristics are 

defined as follows: 

- the width is determined by method 1, its value is lowered by 200; 

- the Manning‟s coefficient for pervious areas (Nperv) is weighted for each subcatchment, 

for impervious surfaces (Nimperv), it is increased by 0.002; 

- the percentage of imperviousness (%imperv) corresponds to the land use imperviousness 

given by Guo (2003), its value is lowered by 7 %. This is certainly due to the fact that 

storm events tested here date from the 1980s while the imperviousness date from 2009; 

- the CN method of infiltration is used, with CN grid 1; 

- the Dynamic Wave method is the flow routing; 

- the Manning‟s coefficient for conduit (Ncond) is set at 0.015 and 0.03 for concrete and 

dirt channels respectively. 

 

5.8.2.2. Final parameterisation evaluation 

 

Although Moriasi et al. (2007) recommended a Nash-Sutcliffe coefficient superior to 0.5 for a 

watershed model adjustment, the mean value of 0.482 was considered as satisfactory. In fact, the 

graphs analysis showed that the simulated discharge matches the observed ones fairly well 

(figure 34). For some storm events (1 Aug 86), a negative Nash-Sutcliffe value was obtained 

because the simulated curve shifts, but the peak flow and curve shape were still acceptable. It is 

therefore important to perform a graphical analysis conjointly to a Nash-Sutcliffe coefficient 

determination. 
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Figure 34. Graphs corresponding to the final parameterisation project for all storm events. 
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Other methods to evaluate a watershed model were tested were tested for the final 

parameterisation project. The slope and y-intercept of the best-fit regression line can indicate 

how well simulated data matches measured data (ibid.). A slope of 1 indicates a perfect 

relationship between simulated and measured values while a y-intercept of 0 indicate that there is 

no lag between model prediction and measured data and that the data sets are perfectly aligned 

(ibid.). In this case, the value of the slope is 0.75, indicating that the model tends to overestimate 

the discharge. It can be observed on figure 34 that the model tends to overestimated discharge in 

the recession curve, but that the peak flow are relatively well estimated (eg 01 Aug 86, 02 Mar 

84, 18 Apr 89). The y-intercept is -0.45, which means that there is a lag between observed and 

measured data. This can be observed on some graphs of figure 34 (eg. 15 Feb 88). According to 

Moriasi et al. (2007), care needs to be taken while using regression statistics because this method 

uses the assumption that all of the error variance is contained in simulated values and that 

measured data are error free. In reality, measured data are not error free since they have been 

extracted from graphs. Errors due to the georeferencing and digitisation of the graphs are 

inevitably present. Moreover, the method for estimating discharge and the technique of 

measurement of rainfall at the time the data were obtained are not known. This fact has been 

discussed in section 5.5.1.1. 

 

The coefficient of determination R² is also an indicator, and typically values greater than 0.5 are 

considered as acceptable (ibid.). A value of 0.78 was obtained. 

 

 
Figure 35. Relationship between observed and simulated discharge at the outlet for all 16 storm 

events 

 

Several error indices are commonly used in model evaluation, among which the widely used 

RMS and the RMS-observations standard deviation ratio (RSR), developed by Moriasi et al. 

(2007). RSR standardises RMS using the observation standard deviation    so that the resulting 

statistic can apply to various constituents. In this case though, only the discharge was considered. 

RSR varies from the optimal value of 0 to a large positive value. It is calculated as follow: 
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 (28) 

where   
   

 is the i
th
 observed discharge,    

   
 is the i

th
 simulated discharge,   

    
is the mean of 

observed discharge and   is the total number of observations. A RMS of 0.12 and a RSR of 0.68 

were calculated.  Model performance can be evaluated as satisfactory if RSR is inferior to 0.7 

(ibid.). 

 

The comparison between simulated and measured hydrographs, the Nash-Sutcliffe coefficients, 

the regression analysis, the coefficient of determination and the RMS and RSR parameters show 

that our SWMM model can be considered as satisfactory. The next section explains the 

application of this SWMM model on old and current storm events with their corresponding 

imperviousness. 

  

 

5.9. SWMM verification 

 

The pre-parameterisation and final adjustment of SWMM was done using the old storm events 

and the current imperviousness. The final model was tested for old storm events and their 

corresponding old land use as well as for current storm events and their corresponding 

imperviousness. This is a necessary step to show that the SWMM model can be used for both old 

and current patterns of the Upper Bukit Timah basin in order to realise a diachronic analysis of 

the effect of urbanisation on runoff. 

 

 

5.9.1. Old storm events 

 

In order to characterise the imperviousness corresponding to the old storm events of the 1980s, 

the Chuah‟s land use map (1986) was georeferenced and digitised. Correspondences between the 

legend of the old map and current land use classification figure in the appendix 6. The 

percentage of imperviousness of the Upper Bukit Timah was calculated using the same technique 

as previously. On average, the difference between current and 1986 percentage of 

imperviousness is 3.8%, with a standard deviation of 6.7. Table 9 shows the percentage of 

imperviousness corresponding to the 1986 map. 

 

Table 9. Percentage of imperviousness corresponding to the 1986 land use (%) 

S1 S2 S3 S4 S5 S6 S7 S8 S9 S10 S11 S12 S13 S14 S15 

49.6 33.6 47.1 39.7 9.7 61.3 48.2 61.0 62.2 52.8 60.3 10.3 32.2 15.9 16.4 

 

The final project presented in the previous section was tested using the percentages of 

imperviousness of table 9. A mean Nash-Sutcliffe coefficient of 0.44 was obtained for the 

sixteen old storm events tested here. This value, in addition to the graphs presented in figure 36, 

show that the model is adapted for the modelling of the Upper Bukit Timah associated with its 

past land use. 
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Figure 36. Graphs corresponding to the project adapted to the 1986 land use map for all storm 

events. 

 

 

5.9.2. Recent storm events (2011) 

 

The final parameterisation of the SWMM model
10

 was tested on the eight storm events of May 

and June 2011. Unfortunately, this first test did not give as good results as for the sixteen old 

storm events. Several manipulations were done to try to improve the model. 

 

5.9.2.1. Influence of SWMM parameters on the hydrograph 

 

To understand why the SWMM model did not work with current data and eventually find the 

parameters adapted to all current storm events, the influence of the variation of some parameters 

on modelled hydrograph was highlighted by several tests. Thirty-six tests were performed on the 

eight current storm events (table 10). The graphs of figure 37 (p.81) present an example of the 

                                                 
10

 Proj_final, width – 200 ; Nimperv + 0.002 ;%imperv – 7 ; Ncond 0.015 ; Dynamic Wave ; CN Grid 1. 
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thirty-six tests executed on the May 13
th

 event. All other resulting hydrographs figure in the 

appendix 7. 

 

These graphs show that, for all events and all tests, the modelled discharge does not match the 

measured discharge at all. For some events, the shape of the modelled hydrograph is 

approximately correct while for others events, measured discharges seem aberrant (May the 4
th

 

and May the 25
th

 for example). The hydrographs also show that the most influential parameters 

are the width and the Manning‟s coefficient of impervious area (Nimperv). On the other hand, 

the Manning‟s coefficient of pervious surfaces (Nperv) seems to be the less influential 

parameter. 

 

Table 10. Tests performed to establish the relationships between SWMM parameters and discharge 

for current storm events 

Parameter Variations 

Manning for concrete conduits 

(Ncond) 
Set at: 0.011 ; 0.013 ; 0.015. 

Manning for imperv. areas 

(Nimperv) 

Increased by: 0.001 ; 0.003 ; 0.005 ; 0.01 ; 0.02 ; 0.05 ; 0.1 ; 

Lowered by: 0.001 ; 0.003 ; 0.005 ; 0.01. 

Manning for perv. areas  

(Nperv) 

Increased by: 0.005 ; 0.05 ; 0.1 ; 0.05 ; 

Lowered by: 0.05 

Percentage of imperv. 

(%imperv) 

Increased by: 1 ; 5 ; 10 ; 20 ; 

Lowered by: 1 ; 3 ; 7 ; 10. 

Width 
Increased by: 10 ; 50 ; 100 ; 300 ; 500 ; 1000 ;  

Lowered by: 10 ; 30 ; 50 ; 100. 

 

5.9.2.2. Influence of SWMM parameters on maximum discharge 

 

Failing the adjustment of the entire hydrograph curve, the peak flow of each test was extracted in 

order to eventually find a relationship between the maximum modelled discharge and each 

variation of the parameters and then to adjust the model to fit the maximum measured discharge. 

Graphs in figure 38 below show the relationships between the variation of parameters and the 

normalised difference between the measured maximum discharge and the modelled maximum 

discharge. 
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Figure 37. Tests performed to show the influence of parameters variation on modelled discharge, 

Example of the May 13
th

 event. From left to right, top to the bottom: influence of width, Nimperv, 

Nperv, Ncond and %imperv 
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Figure 38. Variation of parameters versus the normalised difference between maximum measured 

discharge and maximum modelled discharge 
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This figure shows that the difference between measured and modelled maximum discharge 

depends on the storm event being modelled. The 25
th

 of May, 21
st
 of May and 27

th
 of April 

events show the highest differences between measured and modelled maximum discharge. The 

10
th

 of May storm event is particular in the sense that modelled discharge is generally higher 

than observed discharge, contrarily to the other storm events. It is therefore highlighted that 

finding a general agreement to adjust the model for all storm event seems difficult. These graphs 

also confirm that the most influential parameters are the width and the Manning‟s coefficient for 

impervious areas (Nimperv).  

 

Some storm events were found to be impossible to adjust because of problem in the discharge 

data. It can be seen on figure 38 that, for the May 25
th

 event, a huge difference exists between the 

measured and modelled maximum discharge. In fact, the discharge showed an aberrant value 

higher than the bank full discharge of the channel (103.6 m³/s), which was reached in 7 minutes 

between 13:01 and 13:08. Also, a gap in the water depth data recorded by the PUB on the May 

4
th

 was found (figure 37). Between 14:58 and 16:21, no data were available, resulting in the 

impossibility to use the discharge data for this storm event. Concerning the storm event of the 

30th of April, 2011, the water depth rose from 0.6 m to 1.25 m and then lowered to 0.7 m in 10 

minutes.  This shift was considered as incoherent. The 5th of June, 2011, flood event was 

examined with caution since the SWMM model does not take into account excess water at 

overcharged conduits and drains. It was noticed on figure 38 that the discharge associated to this 

particular event does not react to the variation of parameter in the same manner than the other 

storm events.  

 

A last try was performed on the five remaining storm events to attempt a model adjustment by 

changing the two most influential parameters (width and Nimperv), it is explained below. 

 

5.9.2.3. Iso-response curves 

 

The objective here consisted in finding a common variation of the width and Nimperv for which 

the SWMM project results would fit the measured maximum discharge. The previous sections 

have shown that the modelled discharge had to be increased by some 20 to 50 m³/s, except for 

the May 10th event for which the modelled maximum discharge almost fit the real one. 

Therefore, 180 tests
11

 were performed on the five remaining storm events to establish, for each 

event, the iso-response curves showing the relationship between the width, Manning‟s 

coefficient for impervious surfaces and maximum discharge. These tests consisted in increasing 

the width and diminishing the Manning‟s coefficient of impervious areas, as it has been seen in 

previous section that these changes involve an increase in discharge. Figure 39 shows the iso-

responses curves for the 27
th

 of April, 10
th

 of May, 13
th

 of May and 21
th

 of May storm events. 

Iso-responses curves for the 5
th

 of June particular event figure in the appendix 8. These figures 

show that it was impossible to find a common adjustment of the model for all storm events. For 

example, the measured maximum discharge of the 27
th

 of April event is 44.7 m³/s. Figure 39 

shows that the modelled discharge, for a width increased by more than 10,000 and a Manning‟s 

                                                 
11

 The width was increased by 100, 200, 300, 400, 500, 1000, 1500, 2000, 2500, 3000, 3500, 4000, 6000, 8000, 

10,000. Simultaneously, the Nimperv parameter was lowered by 0.001, 0.002, 0.003, 0.004, ..., 0.012. Fifteen tests 

multiplied by twelve tests equals 180 tests for each event. 
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coefficient lowered by 0.012, gives a maximum discharge of only 26 m³/s. The same case is 

observed for the 21
th

 of May storm event for which the modelled discharge reach 26 m³/s while 

the measured one is 64.3 m³/s. On the other hand, the modelled discharge of the 10
th

 of May 

event always exceeds the measured one which has a value of only 6.6 m³/s. 

 

 

5.9.3. SWMM final model capabilities 

 

SWMM final model gave good results for old storm events. On the other hand, it was impossible 

to find a common adjustment for recent storm events. From this analysis, it was concluded that 

the impossibility for the SWMM to model recent events is due to the low quality of the rainfall 

and discharge data as well as the partial knowledge of the water network and its characteristics. 

It has been discussed in section 5.5.2 that the indirect methods used to determine recent data 

contain lots of errors and uncertainties. The rainfall extracted from the RADAR images and the 

discharge calculated from the water depth without a rating curve probably contained too many 

errors to be used in the model. Therefore, the assumption that the SWMM final model gives 

acceptable results for old and recent data was taken for the rest of this work, although it was 

impossible to prove it for the latter. 

 

 

 
Figure 39. 3D iso-responses curves showing the relationships between maximum discharge, width 

and Manning’s coefficient for impervious areas 
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5.10. HEC-HMS model 

 

HEC-HMS model was tested in order to compare its results and computational methods with the 

SWMM results. This section provides an overview of this model and its computational methods 

and parameters. The results of its application are then presented and shortly discussed. 

 

5.10.1. Overview 

 

HEC-HMS model is designed, as the SWMM model, to simulate the precipitation-runoff 

processes of watershed systems. The difference between these two is that HEC-HMS model is 

applicable in a wide range or geographic areas, contrarily to the SWMM model which can only 

be used in urban areas. The watershed is also separated into several subcatchments, reaches (or 

conduits) and junctions. The sketch representing the Upper Bukit Timah basin in SWMM model 

was reproduced in HEC-HMS, in order to dispose of two identical models. Figure 40 presents 

the HEC-HMS sketch of the basin. 

 

 
Figure 40. Basin Model in HEC-HMS 

 

5.10.2. Computational methods and model parameters 

 

Several mathematical models used to calculate mass or energy flux of the hydrologic cycle are 

included in the HEC-HMS. In most cases, several model choices are available to represent the 

loss, surface runoff and flow in conduits. In this case, only few data were available. Therefore, 

the methods used here were the ones for which only a few parameters are needed for the model 

to run. The parameters needed in HEC-HMS did not differ from the parameters used in SWMM, 

with the exception of the time of concentration and the storage coefficient, both used for surface 

flow routing. The tutorial (section 7) details the manipulations needed for the determination of 

these remaining parameters. 

 

 



86 
 

5.10.2.1. Subbasin surface flow routing 

 

The surface runoff calculation can be performed by different transformation methods in HEC-

HMS. Here the Clark-Unit Hydrograph was used. It differs from the conceptual view of SWMM 

model since this method represents two processes in the transformation of excess precipitation to 

runoff: the processes of translation and attenuation (Straub et al., 2000). Translation is the 

movement of flow downslope in response to gravity while attenuation is the reduction of the 

magnitude of the discharge from the frictional forces and channel-storage effects (ibid.). A time-

area curve, expressing the fraction of watershed area contributing to runoff as a function of time 

(figure 41), is used to develop the translation hydrograph resulting from a burst of precipitation 

(US Army Corps of Engineers, 2010). In other words, the surface is subdivided into subareas 

separated by isochrones of equal time of concentration (Bhawan, 1998). This is represented in 

figure 41. The HEC-HMS model uses the following relationship to develop a time-area curve for 

a watershed: 

 
    
  

  

 
 
 

 
       

 

  
 
   

                      
  
 

          
 

  
 
   

       
  
 
  

  (29) 

where      is the cumulative watershed area contributing at time  ,    is the total watershed area 

and    is the time of concentration (hr) of the watershed (US Army Corps of Engineers, 2000).  

 

 
Figure 41. Time-area histogram for a watershed (Source : Nicklow et al., 2004) 

 

The translated hydrograph (inflow   ) is obtained by multiplying the incremental areas    by one 

unit of depth of excess rainfall and then dividing by the computation time step    (US Army 

Corps of Engineers, 2000). To account for storage effects, the resulting hydrograph is then 

considered as an inflow to a conceptual linear reservoir with a certain storage (Nicklow et al., 

2004). The time rate of change of water in storage 
  

  
 at time   is calculated from the continuity 

equation: 

 
  

  
         (30) 

where    is average inflow, obtained from the time-area curve, to storage at time   and    is 

outflow from storage at time   (ibid.). Storage at time   is related to outflow with the linear 

reservoir model: 
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        (31) 

where R is a constant linear reservoir parameter representing the storage effect of the watershed 

(hr) (ibid.). Combining and solving the equations using a simple finite difference approximation 

yields: 

                (32) 

where    and    are coefficient calculated as: 

    
  

       
             (33) 

The average outflow during period   is: 

     
       

 
 (34) 

Clark-Unit Hydrograph is therefore obtained by routing a unit depth of direct runoff in 

proportion to the time-area curve and routing the runoff entering the channel through a linear 

reservoir (ibid.). 

 

This method thus uses only two parameters: the time of concentration    and the storage 

coefficient  . The storage coefficient   can be computed as the integrated surface under the 

hydrograph after the inflection point, divided by the value of the flow at the inflection point (US 

Army Corps of Engineers, 2000). As a first approximation, the mean value of   was calculated 

using four hydrographs. A value of 0.81 hr was obtained. There are several methods to determine 

the time of concentration. Six empirical methods were tested; they are presented in table 11. 

 

Table 11. Empirical equations used to estimate time of concentration (min) 

Method Equation Parameters 

US. Federal Aviation 

Agency (FAA) (1965)* 
   

              

  
     

  is the runoff coefficient; 

  is the longest flow lenght (ft);  

  is the slope (%); 

   is the length channel (km); 

  is the watershed equivalent diameter (km), 

equal to  
  

 
 
    

; 

  is the area (km²); 

   is the channel slope (m/m); 

  is the width (km); 

   is the basin slope (m/m); 

     is the storage coefficient (in.) calculated 

from the subcatchment CN and equal to 
    

  
   . 

 

Williams (1922)**    
         

   

   
    

Kirpich (1940)**            
      

       

Haktanir-Sezen 

(1990)** 

          
       

and          

Johnstone-Cross 

(1949)** 
         

  
  
 
   

 

Simas-Hawkins 

(2002)** 

  
              

          
      

and             

Sources:* LMNO Engineering, Research, and Software. 2003, ** Fang et al., 2008 

 

The value of the times of concentration calculated using the six empirical methods figure in the 

tutorial, section 7. FAA method gives the smaller value of time of concentration while Haktanir-

Sezen and Williams‟s methods show sensibly higher values.  
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5.10.2.2. Subbasin loss method 

 

The SCS Curve Number method was used to model the infiltration loss from pervious surfaces. 

Section 5.3.5.3 overviews the method. The pervious portion is estimated from the percentage of 

impervious surface and the subbasin area, as previously. 

 

5.10.2.3. Flow routing in conduit 

 

The process used to determine the time and magnitude of flow within a reach at a point in the 

system is the Kinematic Wave method. This method has already been explained in section 5.2.2. 

 

 

5.10.3. Results 

 

For each test, the Nash-Sutcliffe coefficient was calculated, and the modelled hydrograph was 

visually compared to the measured one. All graphs figure in the appendix 8. The mean Nash-

Sutcliffe coefficient for all tests of all events was -0.06. The FAA methods gave the highest 

Nash-Sutcliffe coefficient, with a value of -0.05. Other methods gave values of -0.06, -0.24, -

0.26, -0.33 and -0.52 for the Haktanir-Sezen, Simas-Hawkins, Kirpich, Johnstone-Cross and 

Williams methods respectively. Graphical analysis showed that for long storm events (eg. 12 Feb 

78, 03 Feb 84, 02 Mar 84) the modelled discharge is generally surestimated, resulting in bad 

value of Nash-Sutcliffe coefficient. For these events, the Williams method results in a 

hydrograph which is smoothed in comparison with the measured hydrograph. For shorter event 

of low rainfall intensity, however, results are better and Nash-Sutcliffe coefficients are positive 

(eg. 02 Jul 84, 03 Jan 84). For short event of high rainfall intensities, modelled discharge is 

generally underestimated, resulting in bad Nash-Stucliffe coefficients (27 Nov 87, 03 Apr 88, 11 

Jul 88, 18 Apr 89). 

 

The difficulty in estimating Clark-Unit Hydrograph parameters had an impact on the results of 

this model. Although the determination procedure for the coefficient of storage is simple, it 

requires an observed hydrograph with well defined point of inflection. In this case, the 

hydrographs extracted from the literature contain uncertainties that have been discussed in 

section 5.5.1.1. Furthermore, the identification of inflection point on the recession curve is a 

difficult task. Also, each hydrograph varies in shape and different   values were thus obtained. 

The average value of storage coefficient was therefore used. According to Ahmad et al. (2009), a 

unique value of   representing unique instantaneous unit hydrograph is difficult to achieve and 

the average value of storage coefficient obtained from different hydrograph do not result in the 

match between observed and measured hydrographs. The determination of the time of 

concentration was done using six empirical equations, originally developed for specific regions 

and for watersheds of different sizes. For example, Williams developed his equation in 1922 to 

study flood discharge in India, Kirpich proposed his equation in 1940 for small watersheds (< 

0.45 km²) in Tennessee and Johnstone and Cross presented their equation for watershed in Ohio 

(Fang et al., 2008). Although six different equations were tested on each event, the model 

showed inacceptable results. It is thus evident that these equations are not well adapted to this 

case study. The HEC-HMS was not used for the rest of this study because the Clark-Unit 
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Hydrograph method did not show enough accurate results. Further analysis could have been 

done to adjust the model by using other methods for the surface flow routing, but no data were 

available to implement them. 

 

 

5.11. Conclusion 

 

This chapter presented the SWMM and HEC-HMS models, as well as the parameters they 

require and the computational methods they use. SWMM model was parameterised, adjusted and 

verified using past and recent storm events. It was impossible to verify the model for current 

storm events, probably due to the numerous uncertainties in the determination of discharge and 

rainfall data. These uncertainties, as well as the ones linked to the determination of the 

parameters, have been discussed in details in the concerned sections. On the other hand, SWMM 

model showed accurate results for the old storm events. Less uncertainty was present for these 

ones. Although six methods were used to determine the time of concentration, HEC-HMS did 

not give good results. It was decided to use SWMM model for the rest of this work, with the 

assumption that the incorrect results of recent storm events were not due to the SWMM 

parameterisation. The two watershed models could have been improved if more data were 

available, but SWMM was judged satisfactory given the poor database available here. Next 

chapter presents a diachronic analysis of the effects of urbanisation on runoff, using the final 

SWMM model. 
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6.  DIACHRONIC ANALYSIS 
 

 

This chapter aims to present a diachronic analysis of the effects of urbanisation on runoff using 

the SWMM model. It first presents the results of an approximate method, the Rational formula, 

used to estimate the peak runoff resulting from a given rainfall intensity at different periods of 

time. Since the use of this method does not allow the user to compare hydrographs of different 

period of return, another approach was developed to compare the runoff at different dates. Next 

sections therefore present how the past and future imperviousness of the Upper Bukit Timah 

basin was characterised and how design hyetographs of a given period of return were 

constructed. It then analyses the results of the application of the SWMM model on these data. 

The final section attempts to identify the sensitive areas of the catchment in terms of runoff. 

 
 

6.1. Rational method 

 

Chuah (1987) used the Rational formula to characterise the effect of land use changes on peak 

flow. Following this work, the 2009 land use was also characterised using the Rational formula. 

This constitutes a first approach to appreciate the effect of urbanisation on peak runoff. 

 

 

6.1.1. Rational formula and evolution of the peak flow 

 

The Rational method is based on a simple formula that relates the runoff-producing potential of 

the catchment, the intensity of rainfall and the watershed drainage area (Thompson, 2006). It 

assumes that a peak discharge occurs when a steady state is reached whereby the entire 

catchment is contributing to the runoff (Chuah, 1987). The peak discharge can be calculated 

using: 

               (35) 

where   is the peak runoff rate (m³/s),   is the runoff coefficient,   is the rainfall intensity 

(mm/h) and   is the area of the watershed (km²) (Anctil et al., 2005). 

 

The dimensionless runoff coefficient   is the fraction of precipitation falling on the watershed 

that becomes runoff (Thompson, 2006). The runoff coefficient therefore depends on the land use 

class, just as the coefficient of imperviousness does (see appendix 10). A mean runoff coefficient 

for the whole 2009 Upper Bukit Timah catchment was calculated; its value is 0.47.   is the 

intensity of a constant intensity design storm (fictive event) with the specified design return (in 

this case, 5 years), and a storm duration equal to the time of concentration of the drainage area 

(Bengtson, 2010). The relation between these three components is represented by the intensity-

duration-frequency (IDF) curves (appendix 1). Once the design return period and time of 
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concentration were calculated, the rainfall intensity was determined from the IDF curve. The 

time of concentration of the year 2009 was calculated using the FAA formula (see section 

5.10.2). According to Chuah (1987), the peak flow grew from 73.68 in 1950 to 91.65 m³/s in 

1986. For the year 2009, the calculated peak discharge is 102.6 m³/s, showing an increase of 

peak flow through time. 

 

 

6.1.2. Evaluation of the method 

 

The Rational method is widely used to estimate the peak surface runoff rate in order to design a 

variety of drainage structures (Bengtson, 2010). The method is also used in Singapore (PUB, 

2011). This method assumes four hypothesis: (1) the rainfall intensity is constant for the duration 

of the storm, (2) the coefficient of runoff does not change over the time, (3) the peak discharge is 

reached and maintained when the rainfall duration is longer than the time of concentration and 

(4) the drainage area does not change during the rainfall event (Anctil et al., 2005). The first 

assumption is constraining since the rainfall intensity greatly varies in Singapore. The second 

assumption illustrates the limits of the method. As runoff is linked to the infiltration capacity 

which changes over the time, a constant runoff coefficient is an approximation. The quality of 

the Rational method also depends on the determination of the parameters. In this case, the time 

of concentration, for example, was determined using the FAA formula, for which the quality is 

uncertain. Also, the delimitation of land use, and therefore the determination of the runoff 

coefficient, was approximate. Finally, this method does not allow the definition of any 

hydrograph and just gives a rough approximation of the peak discharge for a given storm 

intensity. The use of this method is therefore not practical since hydrographs of different 

probability of occurrence can be obtained using the SWMM model. The following sections 

explain how this was done. 

 

 

6.2. Past and future urbanisation 

 

The first step necessary to apply the model on past and projected urbanisation consisted in the 

characterisation of the past and future imperviousness of the Upper Bukit Timah catchment. The 

techniques used for the determination of the percentage of imperviousness are explained below. 

In addition to the change in imperviousness, a modification of the CN of each subcatchment as 

well as the Manning‟s coefficient was indispensable since a change in infiltration and roughness 

due to urbanisation is expected. This is detailed in the last paragraphs of this section. In short, the 

calibrated model of the previous chapter was used to simulate a non-urbanised catchment for the 

years 1950, 1959, 1973, 1986, 2009 and 2020, using the corresponding percentage of impervious 

area, CN and Manning‟s coefficient, while keeping other model parameters constant. 
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6.2.1. Past land use and imperviousness 

 

6.2.1.1. Chuah’s maps (1987) 

 

In 1987, Chuah analysed the changing land use of the Upper Bukit Timah basin, in terms of 

increase in impervious areas, for the period from 1950 to 1986. For the years 1950, 1959, 1973, 

1986, she built land use maps on the basis of several sources, namely topographic maps, aerial 

photography, literature and fieldwork. These maps were georeferenced (using, on average, 13 

GCP per map) and digitised in order to be used to estimate the imperviousness, CN and 

Manning‟s coefficient of each subcatchment. Figure 43 presents the maps extracted for each 

date. It can be seen on these ones, as well as in figure 42, that there is an increase in the built-up 

areas especially along and around the major roads. Also, the western part of the catchment 

become more and more urbanised along the years, mostly due to new commercial and residential 

features. The areas around the Nature Reserve, in the north part of the basin, remain more or less 

unaffected by developments. The single-family dwellings show a particular evolution, with an 

increase from 1950 to 1973 followed by a decline as they are being replaced by multiple-family 

dwellings since 1986. 

 

The percentage of imperviousness was determined as previously: a weighted coefficient for each 

subcatchment was calculated on the basis of the coefficients of imperviousness and the surface 

of each land use class within each subcatchment. Our calculations showed that the mean 

percentage of imperviousness calculated for the whole Upper Bukit Timah catchment grew from 

21.3 % in 1950 to 24.7 % in 1959 and then to 37.5 %, 40.0 % and 43.8 % for the years 1973, 

1986 and 2009 respectively. The appendix 11 details the percentage of imperviousness for each 

subcatchment. 

 

 
Figure 42. Evolution of four land use classes: forest, open space, urban and single-family dwellings 

in the Upper Bukit Timah catchment, from 1950 to 2009. 
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Figure 43. Land use for the years 1950, 1959, 1973, 1986 and 2009 (NB: roads figuring on the 1950, 

1959, 1973 and 1986 maps act as landmarks useful for comparison between maps) 

 

6.2.1.2. Quality of the data 

 

It is evident that the quality of the data extracted from Chuah‟s map is uncertain for several 

reasons. Firstly, the compilation of the land use made by Chuah (1987) encountered some 

difficulties which are explained in her work. The 1950 land use is derived from the 1950 aerial 

photograph on a scale of 10 inches to a mile (≈ 1:6336). Delimitation of land use on this black 
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and white photograph is not an easy task. For the 1959 map, the 1959 topographic data for the 

northern portion of the basin was not available and therefore, the land use for this section was 

derived from the years preceding and following 1959. The land use categories classified in the 

1973 map, which derived from field surveys of past authors, differed from those of the other four 

years, and some difficulty was encountered for the comparison of land use changes over the 

years. The 1980 land use map derived from two past studies. The total area of the basin was 

slightly smaller than Chuah‟s other maps. The 1986 map derived from field survey. Chuah 

specified that, for all maps, the extent of the boundary of the different types of land use was 

approximately determined following roads. Where there were no road or reference points, the 

distance was determined approximately. All these maps are therefore tarnished by numerous 

errors. Secondly, Chuah delimited the boundary of the Upper Bukit Timah catchment manually 

on the 1980 topographic map, which is also a source of imprecision. As the catchment delimited 

by Chuah slightly differed from our basin, approximations were made when determining the 

percentage of imperviousness for the old maps. Indeed, the surface of the catchment was kept 

constant and the percentages of imperviousness of the old maps were adapted to our 

subcatchment delimitation. Thirdly, the land use maps presented by Chuah are simplified and 

can be considered as general land use maps. For example, minor land use types as green belts 

surrounding built-up areas are excluded, contrarily to our classification of the 2009 Google 

image. Fourthly, errors inherent to the georeferencing are also present, especially because almost 

no reference points (roads, streams, etc.) were present on the old land use maps. Some 

difficulties were therefore encountered to adjust these maps. Finally, Chuah‟s land use classes 

differed from our classification, resulting in a subjective appreciation of the old land use classes 

to adjust them to the classification. For example, the old „forest and open space” class were 

considered as 50 % composed of forest and 50 % of open space, an uncertain assumption. 

Correspondences between old maps legends and the land use classification of this work are 

presented in the appendix 6. 

 

These uncertainties are noticed in the figure 42 below, representing the evolution of four land 

use classes in the Upper Bukit Timah catchment. The decline of the forest in 1973 is certainly 

due to an overestimation in single-family dwellings, in the north part of the basin. In the same 

way, Chuah specified that small open spaces were not taken into account in her classification. 

This can be observed in figure 42, where an increase of open spaces in 2009 is observed, due to 

our more precise classification. However, this figure clearly shows the growth of the 

urbanisation (encompassing commercial, dense residential and industrial classes) over the years 

as well as the increase in single-family dwelling until 1973 followed by a decline due to their 

replacement by more dense residential features (apartment and multiple-family dwellings). 

 

 

6.2.2. Predicted imperviousness 

 

6.2.2.1. Imperviousness versus population density 

 

Future imperviousness can be estimated using its relationship with population density. 

According to Exum et al. (2005), population density is a reasonable predictor of impervious 

cover arising from residential and commercial developments that support human settlement. 

Population growth can therefore be used to project an increase in impervious cover in a 
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watershed. A number of relationships between population density and impervious cover have 

been developed.  Three empirical relationships, with different functional forms to relate 

population density, were tested here (table 12). 

 

Table 12. Empirical relationships between population density and percentage of imperviousness 

Stankowski (1972)*                                
where   is the 

population density 
(persons/mi²) and 
        is  the 

percentage of 
imperviousness (%) 

Graham et al. (1974)**                            
 
     

Hicks and Woods (2000)**                                 

Sources: *Hordon (1977) and Brabec et al. (2002), ** Exum et al. (2005) 

 

The Singapore Department of Statistics estimated that the 2010 annual growth was 1.8 % 

(comprising Singapore citizens and permanent residents). If the annual growth stayed constant 

over the next ten years, the population in 2020 was calculated to be 6,068,191, resulting in a 

population density of 8517 persons/km² or 22190 person/mi². Given this density, the value of 

percentage of imperviousness in 2020 estimated by Stankowski, Graham et al., and Hicks and 

Woods was estimated at 48.9 %, 85.4 % and 86.6 % respectively. The three empirical 

estimations were evaluated by comparing their resulting percentages of imperviousness with the 

ones predicted for the Upper Bukit Timah basin (see section 6.2.1) for the years 1950, 1959, 

1973, 1986 and 2009 (figure 44). The population densities corresponding to these dates were 

obtained from the Department of Statistics (2010). Figure 44 shows that the Stankowski (1972) 

relationship is the most appropriate, the two other methods overestimating the imperviousness. 

Stankowski‟s formula predicts a growth of 3.2 % from 2009 to 2020. The percentage of 

imperviousness of each subcatchment was therefore increased by this value and assumed to 

represent the imperviousness of the Upper Bukit Timah catchment in 2020. 

 

 
Figure 44. Percentages of imperviousness determined by empirical formulas and predicted for the 

Upper Bukit Timah catchment 
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6.2.2.2. Discussion about the method 

 

The use of population density as a mean to estimate impervious cover provides a rapid technique 

to generate a quantitative estimation of projected imperviousness (Exum et al., 2005). Moreover, 

the population density is generally a widely available population data (Brabec et al., 2002). 

However, it is evident that this method is a rough approximation for different reasons. Firstly, 

imperviousness can considerably vary for a given density. Secondly, the use of a constant annual 

growth to estimate the future population density is uncertain since annual growth varies from 

year to year. Thirdly, the choice of the method relies on a comparison between imperviousness 

estimated from empirical formulas and imperviousness estimated for the Upper Bukit Timah 

catchment, itself containing uncertainties. Finally, the empirical methods were developed for 

particular regions: Stankowski for New Jersey, Graham et al. for Washington and Hick and 

Woods for Vancouver (Exum et al., 2005) and could not be adapted to Singapore. Nevertheless, 

it was used as a first approach to illustrate the future possible urbanisation. 

 

 

6.2.3. Past and future infiltration and roughness 

 

Infiltration, expressed via the CN is expected to change with urbanisation. The CN of each 

subcatchment for each old map was extracted as previously, using a combination of soil and land 

use maps in HEC-GeoHMS. The mean CN for the Upper Bukit Timah for the years 1950, 1959 

and 1973 was lower than the mean CN of 1986, with a value surrounding 76 for the formers and 

a value of 79 for the latter. The mean CN of 2009 was even higher, with a value of 80. For the 

tests undergone on a non-urbanised catchment, the CN was set at 72, the mean value between 

forests and open space CN (Merwade, 2010) 

 

Roughness, illustrated by the Manning‟s coefficient of overland flow for both pervious and 

impervious surfaces was calculated as previously, by taking a weighted coefficient for each 

subcatchment. Old land use maps constituted a basis to determine the mean Manning‟s 

coefficient associated to each land use classes. The Manning‟s coefficient for a non-urbanised 

basin was set at 0.4, the mean value of coefficients for forests and open spaces, as mentioned in 

Rossman (2010). 

 

For 2020 projected urbanisation, CN and Manning‟s coefficients were identical to the 2009 

parameters, as no information were available on any relationship between urbanisation, 

infiltration and roughness. 

 

 

6.3. Synthetic design hyetographs 

 

 

In the Rational method, the rainfall intensity is supposed to be constant over the storm period.  

However, the distribution of the rainfall over the time has a great influence on the generated 

discharge.  Design hyetographs can account for variability of the intensity throughout a storm 

event. Thus, once these hyetographs are created, the SWMM can be used to model the discharge 
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of a given return period. This section explains how design hyetographs were created using the 

arithmetical mean method. The tutorial (section 8) gives all details concerning the steps for 

determining design hyetograph. 

 

 

6.3.1. Definition and method 

 

A design storm is a fictive rainfall event, supposed to statistically represent a real storm event for 

which a return period can be associated (Benabdesselam, 2009). This return period is expressed 

as the frequency that a certain storm event would be exceeded (Stanescu and Musy, 2006). A 

design rainfall is therefore used to assess the flood hydrograph of a certain return period since it 

is impossible to affect a return period to a measured hyetograph, which is aleatory. Characteristic 

elements of a design rainfall are: depth (mm), duration (hr), average intensity (mm/hr), 

maximum intensity and time distribution of the rain intensities (ibid.). 

 

There are several ways to determine a design rainfall. It can be derived directly from the IDF 

curves, for which the temporal distribution is arbitrary, or from the observed rainfalls, from 

which the temporal distribution results (MDDEP and MAMROT, 2002). The method chosen 

here, the arithmetical mean derived from measured precipitation, belongs to the second category. 

The 5-minutes rainfall database of the NUS weather station from 2004 to the present was used. 

To procedure to follow consisted of: (1) selecting the observed storms having a daily rainfall 

volume reaching 50 mm or more. A total of 106 storm events were selected; (2) translating the 

maximum intensity of each event in time in order to match all maximum intensities of all events; 

(3) computing the mean of all selected events to obtain the structure of the design hyetograph for 

a given duration (in this case, 03:30); (4) expressing the depth of design hyetograph in each time 

step as a percentage of the total depth; (5) establishing the relationships between duration of the 

storm and intensity of rainfall for selected return period (2, 5, 10, 25, 50, 100 years); (6) 

determining the total volume of precipitation, given the duration and frequency of the storm; (7) 

multiplying the percentage of the total depth by the desired storm volume (Stanescu and Musy, 

2006 and Picouet et al.,  2003). 

 

In order to obtain several design storms of different durations, the procedure was repeated by 

selecting the storm events having a specific duration. Each of the 106 storm events was classified 

following its duration. Five classes were created: duration between 20 and 40 minutes (30-

minutes design rainfall), 50 and 70 minutes (60-minutes design rainfall), 80 and 100 minutes 

(90-minutes design rainfall), 110 and 130 minutes (120-minutes design rainfall) and 160 and 200 

minutes (180-minutes design rainfall). A design shape of hyetograph was therefore created for 

each duration. The design shape of hyetograph was multiplied by the rainfall volume determined 

by the IDF relationships. Thirty design hyetographs were therefore created, their total volume, 

depending on the return period and duration figure in table 13. 
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Table 13. Total volume of precipitation (mm) of design hyetographs 
Return 

period (yrs) 
Duration (min) 

30 60 90 120 180 

2 43 68 88 107 139 

5 56 89 116 141 184 

10 64 102 134 163 214 

25 76 120 156 188 245 

50 85 134 176 212 278 

100 93 147 193 233 305 

 

 

6.3.2. Comments about the arithmetical mean method 

 

According to Stanescu and Musy (2006), the arithmetical average method is well adapted to a 

large range of catchment areas and time of concentration. Moreover, they allow for making a 

choice of the duration and return interval. This fact was interesting for this work, since the 

discharge associated to the synthetic hyetographs can also be characterised in terms of return 

period. Moreover, this method gives better results than other methods like Chicago-type storm, 

or triangular design rainfall for which the time distribution is arbitrary. Moreover, the parameters 

used to define the design hyetograph are easily derived from rainfall records. 

 

There are, however, some limitations. Many storm events have to be considered in order to 

obtain an accurate design hyetograph (ibid.). In this case, 103 storm events were selected, which 

is considered as satisfactory. The main disadvantage of this method is the smoothing of temporal 

variation of the storm, resulting in a quite evenly distributed intensity or volume (ibid.). 

Although there were few extreme events in our selection (the mean maximum volume being 

10 mm within 5 minutes, with nine storm events of rainfall volume superior to 15 mm), the 

hyetographs showed a great variability in intensities. All synthetic hyetographs are presented in 

the appendix 12. 

 

 

6.4. Impact of land use changes on flow  

 

Once the design hyetographs defined and the parameters modified, 210 computations were 

performed, representing each design hyetograph for each period of time (2, 5, 10, 25, 50, 100-

year return period, 30, 60, 90, 120, 180-minute duration for a non-urbanised catchment and the 

years 1950, 1959, 1973, 1986, 2009, 2020). Three interrelated effects of land use changes on the 

hydrology of an area were analysed here: changes in hydrograph characteristics, changes in peak 

flow, and changes in the frequency of high flows.  

 

 

6.4.1. Effects of urbanisation on hydrograph 

 

Urbanisation affects the roughness and imperviousness of the land surface, which increases the 

runoff volume. Figure 45 present the hydrographs obtained for 5-year return period rainfall 

events of different duration. Other hydrographs are presented in the appendix 13. These results 

show a significant discharge increase in Upper Bukit Timah watershed with the increase in urban 
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area, despite constant meteorological conditions. They also show that for the same return period, 

discharges are higher for long storm events than for short rainfall events, despite an almost 

constant maximum volume of rainfall (16-19 mm). This clearly shows the importance of initial 

moisture of the basin, since a maximum volume of rainfall occurring sooner (30-minute 

hyetograph) produces a smaller discharge than a maximum volume of rainfall occurring later 

(180-minute hyetograph).  

 

As surface roughness is lowered and imperviousness increased, the stream exhibits a faster 

response time, in addition to a higher discharge. Lag time is thus altered by the effects of 

urbanisation. It is defined as the time interval between the centre of mass of the hyetograph and 

the centre of mass of the resultant hydrograph (Leopold, 1968). As water runs off faster from 

urban areas than from natural vegetated areas, the lag time is decreased with increasing 

urbanisation. Figure 45 clearly shows that the time to peak is shortened as urbanisation increases. 

Table 14 show the mean lag time values for the different storm events durations. The average 

value of lag time for all 210 computations was calculated as 41 minutes for a non-urbanised 

basin, 19 minutes for the year 1950, 21 minutes for 1959, 20 minutes for 1973 and 11 minutes 

for the years 1986, 2009 and 2020. The general tendency is thus a decrease in lag time with 

imperviousness, although the value of 1959 shows a smaller value than the value of 1973. It was 

noticed that the 90-minute storm event causes a higher value of 1973 time lag for all return 

periods, resulting in an average higher value. Overall, a decrease in lag time is observed with the 

increase in imperviousness. 

 

Table 14. Lag time calculated for storm events of different duration and for different period of time 

Years 
Storm event duration (min) 

30 60 90 120 180 

Non-urbanised 00:23:20 00:35:00 00:50:50 01:05:00 00:34:10 

1950 00:16:40 00:15:50 00:23:20 00:14:10 00:25:00 

1959 00:16:40 00:16:40 00:35:00 00:15:00 00:25:00 

1973 00:15:50 00:16:40 00:30:00 00:12:30 00:25:00 

1986 00:11:40 00:10:50 00:15:50 00:10:00 00:10:00 

2009 00:11:40 00:10:50 00:16:40 00:10:00 00:10:00 

2020 00:11:40 00:10:50 00:16:40 00:10:00 00:10:00 
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Figure 45. Design hydrographs of 5-year return period for storm events of different duration (30, 

60, 90, 120, 180 minutes) 
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6.4.2. Effect of urbanisation on peak flow 

 

It is intuitive that an increased proportion of impervious areas brings shorter lag times and 

subsequently higher runoff peaks. Table 15 shows the peak flow at the outlet for several periods 

of return, and different dates with their corresponding percentage of imperviousness. For an 

average 5-year storm event, for example, the peak discharge reaches 18.33 m³/s for a non-

urbanised catchment, 37.28 m³/s for a 30 % impervious catchment (1973) and 53.59 m³/s for a 

47 % impervious basin (2020). The appendix 14 contains the detailed results. It shows that table 

15 hides some disparities since, for the year 2009, a 5-year 30-minute storm event triggers a peak 

discharge of 44 m³/s while for a 180-minute rainfall event, the peak discharge reaches 62 m³/s. 

For the return periods of 10, 25, 50 and 100 years, the predicted 180-minute events of 2020 reach 

respectively 73 m³/s, 83 m³/s, 92 m³/s and 100 m³/s. Table 16 shows the mean percentage of 

increase in peak flow, from years to years. It can be seen that since 1950, peak flow has 

increased by almost 85 % and current peak flow is projected to increase by about 3 % to 2020. 

 

Table 15. Peak flow (m³/s) for different years and for return periods of 2, 5, 10, 25, 50, 100 years, 

average on all duration storm events 

Years Mean %imperv 

Peak discharge (m³/s) / increase in percent from the previous to the next year 

T2 T5 T10 T25 T50 T100 

Non-urb. 4.0 12.4   18.3   22.2   26.7   30.7   34.0   

1950 21.3 21.1 70.4% 27.3 49.1% 31.8 43.5% 37.2 39.4% 41.6 35.6% 45.3 33.4% 

1959 24.7 24.7 16.8% 32.8 20.1% 38.2 20.1% 44.6 19.8% 49.8 19.8% 53.9 18.9% 

1973 29.7 28.3 14.8% 37.3 13.5% 42.6 11.5% 48.5 8.9% 53.3 7.0% 57.4 6.6% 

1986 40.0 38.8 36.8% 49.9 33.8% 56.0 31.3% 63.5 31.0% 70.5 32.2% 76.7 33.5% 

2009 43.8 41.7 7.6% 52.3 4.8% 58.6 4.7% 66.6 4.9% 74.3 5.3% 80.8 5.4% 

2020 47.0 43.2 3.5% 53.5 2.4% 60.0 2.4% 68.5 2.8% 76.3 2.7% 83.2 2.9% 

 

Table 16. Increase in peak flow (%) between different periods of time 

 
1950 1959 1973 1986 2009 2020 

Non-urbanised 45.27% 73.13% 91.53% 155.18% 169.29% 176.83% 

1950 
 

19.25% 31.64% 75.22% 84.79% 89.92% 

1959 
  

10.41% 46.97% 55.01% 59.32% 

1973 
   

33.08% 40.35% 44.25% 

1986 
    

5.45% 8.37% 

2009 
     

2.77% 

 

 

6.4.3. Effect of urbanisation on frequency of high flows 

 

The effect of urbanisation on peak flows triggered by a 180-minute event is shown in figure 46. 

It is shown that the peak discharge-frequency curve under non-urbanised condition passes 

through a value of 24 m³/s to more than 76 m³/s for a 50 % impervious catchment for a 10-year 

return period storm event. With a 60 % impervious catchment, the peak flow can reach more 

than 90 m³/s for return period of less than 10 years. For a return period of 50 years, the peak flow 

is estimated at 40 m³/s for a non-urbanised basin and 100 m³/s for a 50 % impervious basin 
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(~2020 conditions). The appendix 15 groups the graphs concerning the other durations. Peak 

discharges are smaller for short duration events, but the effect of increase in impervious areas is 

still clearly shown. Obviously these curves remain extrapolations based on minimal data. 

 

 
Figure 46. Peak discharge for different degrees of urbanisation (measured by the percentage of 

impervious area) and for different return periods 

 

 

6.4.4. Discussion about the results 

 

It is important to note that these results are an approximation of past and future conditions. Our 

model gave smaller peak flows than Chuah‟s estimations, but these ones were not verifiable 

(section 6.1.1). In previous chapter, the bank full discharge was estimated at 74 m³/s and 

section 6.4.2 has shown that the bank full discharge was reached for a 10-year 180-minute storm 

event. This is probably underestimated. Effectively, the one-dimensional model probably 

underestimates the value of discharge for important events of great return periods, as the 

overbanking water is lost from the system. Moreover, SWMM was calibrated using events of 

weak amplitude, with a mean discharge of 30 m³/s. Also, as discussed earlier, the parameters 

used in the model contained some uncertainties inherent to their determination (section 6.2). It 

was also the case for the determination of design hyetograph (section 6.3). 

 

 

6.5. Identification of critical areas 

 

It is now evident that land use changes have the potential to increase average maximum flows. 

The identification of portions of the Upper Bukit Timah basin that have the highest contribution 

in runoff may also be interesting.  
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6.5.1. Evolution of runoff volume per subcatchment 

 

This was done by computing the maximum runoff of each subcatchment for all 210 

computations. To allow comparisons between subcatchments, the maximum runoff (m³/s) was 

transformed into specific runoff by dividing it by the surface of the concerned subcatchment and 

then into a volume (mm). For each date and each subcatchment, the mean maximum volume of 

runoff for all events of different duration and period of return was calculated. This allows the 

generation of critical areas maps (figure 47). 

 

Table 17 presents the evolution of the mean volume of runoff for the Upper Bukit Timah 

catchment. The effect of urbanisation is noticeable. The runoff produced by the 2020 projected 

basin is more than the triple than the runoff from the non-urbanised catchment. 
 

Table 17. Average runoff (mm) produced by the Upper Bukit Timah catchment at different dates 

Non urba. 1950 1959 1973 1986 2009 2020 

1.80 2.59 2.94 3.49 5.58 5.73 6.05 

 

 

Figure 47 clearly shows the effect that urbanisation has on runoff volume. From the non-

urbanised catchment to the 1950 basin, only north subcatchments (12, 14, 5, 15, 6 and 4) remain 

unaffected by the urbanisation. The highest mean runoff is found in subcatchment 10, and 

downstream subcatchments began to produce more runoff (3-4 mm).  The 1959 pattern is similar 

to the situation of 1959 except that downstream subcatchments produce even more runoff, with a 

value between 4 and 5 mm. In 1973, subcatchments 3, 7 and 11 produce the highest quantity of 

runoff, with a value comprised between 8 and 9 mm. This corresponds to the new urban features 

set up along major roads (see figure 42). Even more runoff volume is produced in 1986, 

principally in subcatchments 9 and 11 where the value reached 10 mm, and in subcathments 3, 7 

and 10, where the mean depth of runoff is comprised between 8 and 10 mm. It is certainly due to 

the new commercial and residential features built along the Upper Bukit Timah road. In 2009, 

these subcatchments produce less runoff, probably due to the different land use classifications 

(more open spaces are taken into account in the 2009 classification, see section 6.2.1). 

Nevertheless, the total quantity of runoff produced in 2009 is still higher than in 1986. In 2020, it 

is predicted than all downstream subcatchments (1, 3, 2, 7, 9, 10, 11) will produce an average 

volume of runoff comprised between 7 to more than 10 mm. Finally, it is noticed that, for all 

dates, subcatchments 4 and 6 remain the less affected. Subcatchments in the north part of the 

basin (5, 12, 14), are also low runoff-producing zones. In this figure, it is even noticed that other 

characteristics than urbanisation influence the runoff. For example, for the non-urbanised 

catchment, subcatchments 10, 13 and 14 present a higher amount of runoff than other 

subcatchments, probably due to the higher slopes in this part of the basin. 

 

In conclusion, it is shown that subcatchment 1, 2, 3, 7, 9, 10, 11 are the most critical areas, with a 

average production of runoff volume between 8 to more than 10 mm. Preserving the forests in 

the north part of the basin seems therefore essential to keep up with increasing runoff. 
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Figure 47. Evolution of the average runoff for each subcatchment 

 

It is evident that the way these maps have been built hides some disparities. Indeed, the runoff 

volume produced by a short 2-year frequency storm is obviously smaller than for a long 100-year 

frequency storm. Nevertheless, the average of runoff for all kind of storm stays a good 

illustration of the effect of urban features on runoff since it allowed the identification of critical 

area associated to a quantity of runoff depth. 

 

 

6.6. Diachronic analysis conclusion 

 

This chapter first characterised the evolution of the Upper Bukit Timah catchment in terms of 

imperviousness. Thanks to the construction of a large number of design hyetographs, the 

evolution of maximum discharge and runoff was performed. It was shown that, in average, 

urbanisation has increased the peak discharge by some 90 % and decreased the lag time by 8 

minutes since 1950. Moreover, high flows are predicted to be more frequent if impervious areas 

become more important. Finally, high runoff-producing zones were identified and a link between 

these and the urban sprawl has been illustrated by critical areas maps. 

 

The precision of these results was discussed in each concerned section. Uncertainties are 

inevitably present but these results can be considered as acceptable. 
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7. FINAL CONCLUSION 
 

This work consisted in the modelling of the rainfall-runoff relationships in the Upper Bukit 

Timah catchment in Singapore, in order to highlight the impacts of urbanisation on hydrology. 

The first hypothesis consisted in verifying that it is possible to build a watershed model using 

only few available data. This has been partly confirmed since the model only fitted the observed 

data of old storm events. The effects of urbanisation on the hydrograph shape, lag time, 

maximum discharge and high flow frequency were proved and quantified, confirming the second 

hypothesis. Next paragraphs show the major steps of the methodology implemented to tests these 

two hypotheses and the main final results. Uncertainties and limitations are then discussed and 

future research perspectives are proposed. 

 

The Upper Bukit Timah basin, 6.8 km², contains the highest point of Singapore (163 m) in its 

north part while the other parts of the basin are flat. The land use of the basin is variable, since 

30 % of the catchment is constituted by the forests of the Nature Reserve of Singapore while 

other parts are much urbanised. The basin is mainly drained by concrete lined channels. The 

Upper Bukit Timah basin is a suitable area for this study since the urbanisation has occurred at a 

rapid pace, which has resulted in a high frequency of flood. Moreover, although the catchment 

has been studied extensively over the past, it is important to bring a new methodological 

approach which takes the current pattern into account of the area and which uses current 

powerful tools, like watershed models. 

 

For the application of any watershed model, a large number of data is required. In this case, it 

was particularly difficult to obtain valuable data. The basic data, such as a DEM and a land use 

map, were obtained using the 2005 topographic map (1:25;000) and the 2009 Google Earth 

image. The new DEM, which has a resolution of 20 m, showed to be suitable for the study since 

a RMS error of 1.1 m was obtained. The RMS error of the ASTER GDEM, a DEM available at 

no charge which has a resolution of 30 m, was calculated at 10.1 m. Finally, comparison between 

the two DEMs showed divergences of more than 110 m. The new DEM was therefore used for 

the modelling. Land use data were obtained by digitising the 2009 Google Earth image, after 

defining each land use class as precisely as possible. 

 

The SWMM model, a one-dimensional physically based model especially developed for urban 

areas, was mainly used. The parameters encoded into the model were determined by different 

means and several methods were used for their determination in order to assess their influence on 

the modelling. Observed discharge and rainfall data, essential to adjust the model, were 

determined either for old or current storm events. For old rainfall events, sixteen hyetographs 

and hydrographs of a variety of papers were georeferenced, digitised and their data extracted. 

For recent events, discharge data were determined from the water depth published on the PUB 

website while corresponding rainfall data were extracted from RADAR images. The adjustment 

of the model was firstly done using the old storm events. For each adjustment performed, the 
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model was evaluated using the Nash-Sutcliffe coefficient and a graphical analysis of the 

observed and modelled hydrographs. With a mean Nash-Sutcliffe coefficient of 0.482, and a 

simulated discharge matching the observed discharge fairly well, the SWMM model was 

considered as usable. For recent storm events, however, the low quality of the rainfall and 

discharge data, due to their indirect methods of determination, does not allow the adjustment of 

the model. Therefore, the assumption that the SWMM final model gives acceptable results for 

old and recent data was taken for the rest of this work. 

 

Using the final adjustment of the SWMM model, a diachronic analysis was performed in order to 

present the effects of urbanisation on runoff. Our approach was to characterised the land use 

pattern of the Upper Bukit Timah basin for different dates (non-urbanised catchment, 1950, 

1959, 1973, 1986, 2009, 2020), in order to characterise the catchment in terms of 

imperviousness, roughness and infiltration. For past dates, old land use maps were used. For the 

projection of 2020, the relationship between population density and imperviousness was 

determined using three empirical formulas. Then, in order to compare hydrographs of different 

periods of return, thirty synthetic design hyetographs of different duration and return period were 

constructed using the arithmetical mean of 103 observed storm event (NUS 5-minutes rainfall 

data). The results showed that urbanisation involve changes on the hydrographs shapes, with a 

significant increase of discharge and a decrease in lag time from date to date. From 1950 to 

2009, the model showed a diminution in lag time by 8 minutes. The effects in peak flow are also 

noticeable, with, for example, a mean increase of more than 89 % from 1950 to today. The peak 

discharge-frequency curves generated for each storm duration also showed the effect of urban 

sprawl. For a 10-year return period storm event, for example, the peak discharge for a 50 % 

impervious catchment is more than the triple of what is produced by a non-urbanised catchment. 

Finally, high runoff-producing areas were identified using the runoff generated by each 

subcatchment of the Upper Bukit Timah basin. Critical areas maps were constructed for each 

date. They showed an increase in runoff from date to date for the whole basin, with a mean 

runoff depth of 1.80 mm for a non-urbanised catchment to a projected runoff volume of 6.05 mm 

in 2020. The most critical areas, constituted by downstream subcatchments, have an average 

production of runoff of 8 to 10 mm. The north part of the catchment, constituted by forests, is a 

low runoff-producing zone (0-4 mm). 

 

Uncertainties and limitations of the methods were discussed along the work, in their 

corresponding sections. It is evident that with more precise valuable data, the model would have 

been easier to implement and to calibrate. The first uncertainties were linked to the DEM 

creation. Although the new DEM showed to be hydrologically correct, it is evident there are 

errors inherent to its creation. A LIDAR DEM would have been more suitable for this study. The 

quality of digitisation is also uncertain, mainly due to the subjectivity in the class choices as well 

as in the determination of the areas. Uncertainties in the SWMM parameters determination are 

also present, particularly for the width of each subcatchment. However, these parameters were 

adjusted to obtain results which fit observed data. This approach is common, since the 

calibration of a watershed model involves the modification of some parameters. The major 

limitations come from the determination of recent rainfall and discharge data, necessary to verify 

the model for recent land use pattern. Although as many RADAR images as possible were used, 

the too low resolution of the images and the approximate technique for the determination of 

rainfall intensity involved many errors. The best solution is to dispose of direct rainfall 
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measurements from weather stations within the catchment. Unfortunately, only NUS data were 

available. Then, the impossibility to dispose of a rating curve impeded the possibility to 

transform the water depth into discharge. These two datasets were therefore not valuable. 

However, the final adjustment of the SWMM model showed good agreement between observed 

and modelled discharge for old storm events and was therefore considered as acceptable. 

Concerning the diachronic analysis, the old land use maps used have been compiled 

approximately by Chuah (1987), lowering the quality of the data. Although the method used to 

calculate the predicted percentage of imperviousness is empirical, it is valuable to illustrate what 

would be the future projected impact of urbanisation on the Upper Bukit Timah basin. Finally, 

the results for low frequency storm event of high intensity may be underestimated because of the 

limitations of the one-dimensional model and the fact that this one was calibrated using low 

amplitude storms events. 

 

There are some improvements which can be implemented in the future. First of all, providing 

valuable long term data could bring a verification of the model and its results, as well as a better 

adjustment. Indeed, data used to calibrate model simulations have a direct effect on the 

validation and evaluation of results. With continuous long-term rainfall and discharge data, it 

could be possible to automatically calibrate the model to fit the observed data. Rainfall data of 

several gages across the catchment could also be useful to take into account the spatial variability 

of rainfall during a storm event. An ideal model calibration would use a large range of data, with 

storm events of different duration, intensities and periods in order to « activate » all model 

parameters during calibration. It would also include uncertainty analysis, which allows the 

quantification of the level of confidence in a watershed model simulation output from a large 

number of relevant data. Uncertainty can be evaluated through the quantification of the quality 

and amount of observed data available, the absence of measured data, the lack of knowledge 

about the area of study, the approximations in the mathematical equations used in the model and 

the quality of the calibration. Also, precise data on catchment characteristics, such as channels 

dimensions, depression water storage, infiltration and so on, could surpass the problem linked to 

the one-dimension of the model and its impossibility to take into account overbanking water. For 

example, the SWMM model is able to take into account the effect of storage of water in surface 

depressions and its re-introduction into the system after a certain time. Dividing the basin into 

more uniform subcatchments could also be, in a lesser extent, interesting to improve the results. 

 

Numerous applications can start from this work if data are available. For example, SWMM 

model is able to compute water quality around the considered catchment. This can be useful to 

quantify pollution generated from several sources (industry, used water, etc.). Another emerging 

challenge in urban areas is global warming, potentially leading to climate change. The model 

could be used to define the impacts of an eventual global increase of rainfall intensity for 

example. Moreover, data about infiltration and aquifers can also be used in SWMM to quantify 

the groundwater recharge reduction. This can be useful to estimate groundwater depletion and 

estimate the consequences of both urbanisation and eventually pumping. Finally, it has been seen 

that Singapore is a wealthy country, where floods are generally localised and of brief duration 

thanks to the flood alleviation schemes performed throughout the country. The situation would 

be different in countries that cannot afford fully engineered systems for flood mitigation. The 

application of the methodology showed here could therefore be useful to define the needs for 

flood control in such countries. 
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In conclusion, this research has reached its principal objective to provide a framework that can 

easily be reused in the future. It helps to understand the hydrological processes that take place in 

an urban environment and shows that a variety of indirect data can be useful for a watershed 

model application. If other valuable data are introduced, the constructed model can be used for 

other applications than the quantification of the effects of urbanisation on the hydrologic 

environment. 
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Section 1. Georeferencing 
 

Topographic sheets details 

- Published by Mapping Unit, Ministry of Defense, Singapore, 2005. 

- Compiled by Mapping Unit from the following sources: 

Series L802, Edition 9 SMU (2000), 

1:5,000 Topo plans, 2002 and 2003 / Aerial Photography Oct 2003, 

PSA SP1 Chart – 18 March 1998, 

MPA (Port limit) Notification 1997. 

- Series L802, Sheets 1 and 4, Edition 10 SMU. 

- Scale: 1:25,000. 

- Contour interval 10 meters, supplementary contour 5 meters. 

- Projection: Rectified Skew Orthomorphic (Metric Grid). 

- Spheroid: Everest. 

- Origin: 4°00 N., 102°15‟ E. 

 

Topographic sheets georeferencing 

- Add the Georeferencing toolbar to 

the view (View > Toolbars > 

Georeferencing); 

- Click the Add Control Point tool ; 

- Click the mouse pointer on a 

junction of the projection lines; 

- Right click Input X and Y and enter 

the coordinates indicated along the 

border; 

- Repeat the operation for each 

junction; 

- Click View Link Table tool  which shows residual error for each links and the RMS 

error in a tabular form to evaluate the transformation; 

- Click Georeferencing > Rectify in order to permanently transform the topographic sheet; 

- Repeat the operation for each photo. 

 

The Adjust transformation has been used. According to the ESRI (2009), the adjust 

transformation optimizes for both global least square feature algorithm and local accuracy. It is 

built upon an algorithm that combines a polynomial transformation and TIN interpolation 

techniques. Each area inside the triangular network is then adjusted by bilinear interpolation. 

Typically, the adjust transformations give a RMS of near zero or zero (however, this does not 

mean that the image will be perfectly georeferenced but this method allows the user to give 

reference points their exact location on the final image).  

 

An example of Link Table obtained for the DSCN0643 photo is shown below. 
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Dscn0643 

X Source                     Y Source                     X Map                        Y Map 
138.419747  -180.003254 642000.000000 148395.000000 

1749.150813 -1346.678696 644000.000000 147000.000000 

2608.371289 -539.463804 645000.000000 148000.000000 

3642.108180 -250.853861 646250.000000 148395.000000 

3443.345430 -560.004754 646000.000000 148000.000000 

2604.472669 -1363.929588 645000.000000 147000.000000 

3457.964992 -1382.159726 646000.000000 147000.000000 

871.990078  -2177.531299 643000.000000 146000.000000 

901.536971  -1329.208172 643000.000000 147000.000000 

70.907075  -1314.070425 642000.000000 147000.000000 

117.678280  -495.916771 642000.000000 148000.000000 

952.052887  -187.042794 643000.000000 148395.000000 

936.949304  -504.938144 643000.000000 148000.000000 

1771.997937 -525.170948 644000.000000 148000.000000 

29.977275  -2156.926623 642000.000000 146000.000000 

1728.050099 -2199.220139 644000.000000 146000.000000 

2594.137964 -2220.518867 645000.000000 146000.000000 

3467.033900 -2239.394361 646000.000000 146000.000000 

1781.199536 -207.713012 644000.000000 148395.000000 

2610.442402 -224.927288 645000.000000 148395.000000 

3436.207542 -245.779575 646000.000000 148395.000000 

3651.525202 -565.003662 646250.000000 148000.000000 

3667.208104 -1387.431581 646250.000000 147000.000000 

3684.313158 -2244.006241 646250.000000 146000.000000 

 
 

 

- In ArcToolbox use the Define Projection function (Data Management Tools > 

Projections and Transformation > Raster > Define Projection) to assign the projection 

Kertau RSO Malaya Meters (Projected Coordinate System > National grids > Malaysia) 

to the georeferenced topographic sheets. This projection corresponds to the 

characteristics shown on the map. Its characteristics are resumed below. 

 

- In ArcToolbox use the Project function (Data Management Tools > Projections and 

Transformations > Feature > Project) to change the Malaysian coordinate system to the 

UTM coordinate system (Projected Coordinate System > UTM > WGS 1984). Singapore 

corresponds to the UTM Zone 48 N. The characteristics of the projection are resumed 

below. 

 

Topographic sheets assembling 

Use Erdas Imagine Software to assemble the four georeferenced images of topographic sheets. 

This software allows the creation of a seamless (automatic or user controlled) mosaic. 

 

Google Earth image georeferencing 

The date of the Google Earth image that has been used is the 14
th

 of March, 2009, the last 

available accurate image acquired with the Quickbird satellite (original panchromatic resolution: 

0.61 m). 
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- Proceed as explained above and: 

When using the Add Control Point tool, input the X and Y figuring on Google Earth; 

- The View Link Table tool showed an acceptable RMS with 35 ground control points; 

- The Google Earth image is projected in UTM (Zone 48 N). 

 

Projection characteristics: Kertau RSO Malaya Meters 
 

Projection: Rectified_Skew_Orthomorphic_Natural_Origin 

False_Easting: 804671.299775 

False_Northing: 0.000000 

Scale_Factor: 0.999840 

Azimuth: -36.974209 

Longitude_Of_Center: 102.250000 

Latitude_Of_Center: 4.000000 

XY_Plane_Rotation: -36.869898 

Linear Unit: Meter (1.000000) 

 

Geographic Coordinate System: GCS_Kertau 

Angular Unit: Degree (0.017453292519943295) 

Prime Meridian: Greenwich (0.000000000000000000) 

Datum: D_Kertau 

Spheroid: Everest_1830_Modified 

Semimajor Axis: 6377304.063000000100000000 

Semiminor Axis: 6356103.038993154700000000 

Inverse Flattening: 300.801699999999980000 

 

Projection characteristics: UTM Zone 48 N 

 
Projection: Transverse_Mercator 

False_Easting: 500000,000000 

False_Northing: 0,000000 

Central_Meridian: 105,000000 

Scale_Factor: 0,999600 

Latitude_Of_Origin: 0,000000 

Linear Unit: Meter (1,000000) 

 

Geographic Coordinate System: GCS_WGS_1984 

Angular Unit: Degree (0,017453292519943295) 

Prime Meridian: Greenwich (0,000000000000000000) 

Datum: D_WGS_1984 

Spheroid: WGS_1984 

Semimajor Axis: 6378137,000000000000000000 

Semiminor Axis: 6356752,314245179300000000 

Inverse Flattening: 298,257223563000030000 
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Section 2. DEM realisation 
 

 

Digitisation 

 

Contour lines: 

- Open ArcCatalog  and create a New Shapefile (File > New > Shapefile). Set the 

feature type as Polyline and define the spatial reference (UTM 48 N); 

- Set the Properties by adding a Field named Elevation (Data type: Double); 

- Add the new shapefile to ArcMap; 

- Add the Editor Toolbar to ArcMap; 

- Edit the shapefile (Editor > Start Editing) by creating a New Feature; 

- Use the pencil to digitise each contour line of the topographic map and enter manually 

the elevation value in the Attributes Table ; 

- Save Edits when needed. 

 

Quoted points: 

- Repeat the same steps, but create a Point shapefile instead of a Polyline shapefile. 

 

Lakes: 

- Repeat the same steps, but create a Polygon shapefile. 
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First test with the Topo to Raster function 

 

- In ArcToolbox, use the Topo to Raster function (ArcToolbox > 3D Analyst Tools > 

Raster Interpolation > Topo to Raster) to create a DEM; 

- Input the lakes, contour lines and quoted points as feature layers as shown below. 

 

 
 

- Test the Flow Direction function (ArcToolbox > Arc Hydro Tools >Terrain 

Preprocessing > Flow Direction) by using the DEM. 

 

The FlowDir output raster shows the direction of flow out of each cell. It is an integer raster 

whose values range from 1 to 255 (ESRI, 2009). The values for each direction from the 

center are: 

 

- Test the function Flow Accumulation (ArcToolbox > Arc Hydro Tools 

>Terrain Preprocessing > Flow Accumulation) by using the 

DEM and the FlowDir raster. 

 

The FlowAcc output represents the number of upslope cells that flow into each cell, assuming 

that all rain became runoff and there was no interception, evapotranspiration or loss to 

groundwater (ESRI, 2009). 

 

- The result of this function is not accurate enough. Optimization is needed and is 

explained below. 
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Streams digitisation and characteristics (→ water system in 2D) 

 

- Create a New Shapefile. Set the feature type as Polyline and define the spatial reference; 

- Georeference the Chuah & Wong‟s sketch of the Upper Bukit Timah catchment. It 

constitutes a first reference for the drains position. The second reference is Google Street 

View; 

- From both sources, digitise the drains of the catchment (in forested areas, Chuah & 

Wong‟s sketch is the reference; in built areas, Street View is the used tool); 

- Modify the Attributes Table by adding the following fields: 

State** (aerial, subterranean or unknown), Text; 

Channel type* (concrete line channel or earth channel), Text; 

Manning‟s coefficient*, Double; 

Length*, Double; 

Slope*, Double; 

Channel shape*** (trapezoidal, wide rectangular or triangular), Text; 

Width*, Double; 

Side slope*, Double; 

Upstream flow*, Text. 

 

- Edit the Attributes Table manually for each field (Sources: * Chuah & Wong (2010); 

** Google Earth, Google Street View, and fieldwork; *** Chuah & Wong (2010), 

Google Street View and fieldwork). A part of the Attributes Table is shown below. 

 
 

- For the depth, make a sketch of the drains with their respective depth using Google Street 

View (eg. One step ~ 20 cm, 10 steps ~ 2 m) when more accurate data is not available. 

This will be used later. 

 

Transformation of the streams into points (→water system in 3D) 

 

Drains: 

- Add the ET GeoWizard toolbar and use the Create Station Point function; 

- Input the waterways shapefile (in Source Polyline Layer) and set the distance between 

stations to 50 m. This function creates a point every 50 m on the waterways; 

- Edit the Attributes Table by encoding the elevation of each point manually :  

- The first point elevation is known: 7.62 m (9.67 m as noted on the topographic 

map minus the drain depth of about 2 m (determined in Google Street View and 

personal field photos)). 
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- Drain depth, drain slopes and distance between points are also known. 

- The other elevations are determined by rule of three and the upstream propagation 

of this calculation.  

 

Drain sides: 

- Create a point shapefile to create new points on the bank of all drains; 

- Use the Copy Parallel Tool  (Editor > Copy Parallel) to copy the „central drain‟ on the 

bank position for both sides (the width of each drain is known) into the created shapefile; 

- Edit the Attributes Table by encoding the elevation of each point. The elevation value is 

calculated from the width (which is known) and from the depth (determined with Google 

Street View). 

 

Second test with the TIN function 

 

- In ArcToolbox, find the TIN Creation tab and create a TIN (3D Analyst Tools > TIN 

Creation > Create a TIN); 

- Then, use the Edit TIN function. The inputs are the contour lines, the quoted point, the 

„central drain‟ shapefile and the „drain sides‟ shapefile; 

- It gives accurate results for the drains areas but not for the remaining zones. 

 

Transformation of the Station Points 

 

- The Create Station Point function (ET GeoWizard) is rerun with the Source Polyligne 

Layer being the waterways shapefile and the distance between stations set to 5 m; 

- Transform the TIN layer into a raster (TIN to Raster function); 

- In ArcToolbox find the Extract Value to Point 

function (Spatial Analyst Tools > Extraction > 

Extract Value to Point) and enter the TIN raster and 

the Station Points shapefile as inputs in order to 

associate the TIN elevation value to each created 

point. 

 

Rerun the Topo to Raster function as many times as necessary 

 

- Reuse the Topo to Raster function to create a DEM. In addition to all the inputs used in 

the previous test, add the Station Point (every 5 m) shapefile; 

- Test the Flow Direction function; 

- Test the FlowAccumulation function; 

- Create a new shapefile and define the Pour Point (outlet) using the FlowAcc layer; 

- Create a new Polygon shapefile and digitise the Upper Bukit Timah watershed of the 

Chuah and Wong‟s article; 

- Test the function Watershed with the Pour Point and Flow Direction layers as inputs; 

- Check the different layers created; compare the modelled watershed with the real one; 

- Rerun the operation as many times as necessary after each modification. 
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- The modifications made to the inputs layers between tests are: 

- Delete problematic parts of contour lines: Edit the shapefile, use the Split Tool  

(Editor Toolbar) to create the feature which has to be deleted. Select it and delete 

it using the Attributes Table. Repeat the operation as many times as necessary. 

- Delete problematic contour lines (Editor Toolbar). 

- Redigitise some contour lines (see above). 

- Change the resolution of the created DEM (several tests with 10, 15, 20, 30 m). 

 

- After numerous tests (~ 40), the FlowAcc layer looks hydrologically correct and the 

Watershed looks like the Chuah and Wong‟s Upper Bukit Timah catchment. 

 

Evaluation of the DEM 

 

Contour lines: 

- Reconstitute the contour lines of the newly created DEM by using the Raster to Polyline 

function (ArcToolbox > Conversion Tools > From Raster > Raster to Polyline); 

- Compare the reconstituted contour lines (blue) with the actual ones (yellow). 

 

 

 

Drainage system 

- Visually compare the FlowAcc output with the shapefile of drains created from different 

sources of the literature. 

 

RMS error 

- Use the Extract Value to Point function (ArcToolbox > Spatial Analyst Tools > 

Extraction > Extract Values to Point) to extract the value of quoted points from the new 

DEM;  

- Clip them with the polygon representing the basin limits (ArcToolbox > Analysis Tools > 

Extract > Clip) ; 



129 

 

- Clip the known quoted point with the polygon representing the basin limits too; 

- Report the Attributes Tables in Excel and determine the RMS error from the following 

expression: 

            
    

                
       

   

 
 

Where,   
            

 refers to the i
th

 interpolated point value,   
     refers to the i

th
 known quoted 

point and N is the number of sample points. 

 

Comparison with ASTER GDEM 

 

- Clip both DEMs with the basin limits (ArcToolbox > Data Management Tools > Raster 

> Raster Processing > Clip); 

- Use the Single Output Map Algebra function to substract the ASTER GDEM from the 

new DEM (ArcToolbox > Spatial Analyst Tools > Map Algebra > Single Output Map 

Algebra): 
FINAL_MNT_Clip1.img - ASTGTM_N01E103_dem_Clip.img 

 

- The layer properties show the statistics data of the layer obtained. 

 

- To calculate the RMS error of the ASTER GDEM in order to compare it with the 

previously calculated RMS error, repeat the steps described above. 
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Section 3. Land use digitisation 
 

Shapefiles creation 

 

- Create a new shapefile. Set the feature type as Polygon and define the spatial reference 

(UTM 48 N) for each land use classes: 

- Forests 

- General vegetation 

- Railroad 

- Car parks 

- Industrial 

- Commercial & educational 

- Single-family dwellings 

- Multiple-family dwellings, detached 

- Multiple-family dwellings, attached 

- Apartment buildings 

- Construction sites 

 

NB1: Lakes digitisation has already been done with the DEM creation (Appendix II). 

NB2: For roads, see below. 

 

- Add all shapefiles to ArcMap; 

- Add the Editor Toolbar to ArcMap. 

 

Land use classes creation 

 

- Start an editing session (Editor > Start Editing), set the Task field to Create New 

Feature, choose the land use class you want to digitize (Target) and click on the 

pencil  to start the digitisation. Finish the sketch (Right click > Finish sketch) when 

the polygon is done. 

 

Useful tools 

 

- Use the Clip tool (Editor > Clip) when two adjacent polygons should share a border in 

order to avoid digitising the border twice or having overlaps or spaces between polygons: 

- Digitise the first polygon; 

- Digitise the second one, insure it overlays the first one; 

- Select  the first one and clip it. 

NB: You can also use the Auto-CompletePolygon task 
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- Use the Merge tool (Editor > Merge)  when two polygons of the same class need to be  

merged: 

- Select  the two polygons and merge them. 

 

- To reshape a polygon, follow these steps: 

- Build a Map Topology by clicking the topology icon  and select all the land use 

classes; 

- Use the Topology Edit tool  to select the polygon to be reshaped. It is selected 

in magenta; 

- Set the task to Reshape Edge; 

- Use the pencil to draw a sketch of the reshaped line, make sure that the sketch 

intersects the polygon at least two times;  

- Finish the sketch. 

 
 

- To create a hole in a polygon (eg. forest surrounding a lake): 

- Digitise the outer boundary of the polygon, right-click and click Finish Part; 

- Sketch the inner boundary, right-click and click Finish Sketch. 

 

- To split an existing polygon into two or more features: 

- Click the Edit tool ;  

- Set the Cut Polygon Features task; 

- Use the pencil to construct a line that cuts the original polygon as desired; 

- Finish the sketch. 
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Other tips 

 

- To add or delete a vertex, click the Edit tool and double-click the polygon you want to 

modify, right click and click Insert Vertex or Delete Vertex. 

- The Trace tool  helps you create segments that follow along existing segments. 

- The Intersect command (Editor > Intersect) creates a new feature from the common 

areas or edges of any two selected features of the same geometry type. 

- To separate a multipart feature, click the Explode tool . 

 

A special case of land use class: the roads 

 

- Create a New Polygon Shapefile encompassing all the Upper Bukit Timah area; 

- Use the Merge tool of the ArcToolbox (ArcToolbox > Data Management Tools > 

General > Merge) to merge all the land use classes previously created (all the classes 

except the roads). It creates a new shapefile which regroups all the classes except the 

roads; 

- Use the Union tool (ArcToolbox >Analysis Tools > Overlay > Union) to join the big 

polygon with the „Merge‟ shapefile. This function computes a geometric intersection of 

the input features. All features are assembled in a new shapefile with the attributes from 

the input features; 

- Use the Select By Location tool (Selection > Select By Location) in order to select the 

features from the „Union‟ shapefile that are equal to the features from the of „Merge‟ 

shapefile; 

- Delete the selected features (via the Attributes Table). 
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Add details to the Attributes Tables 

 

- For each land use class layer, set the Properties by adding two Fields named Type (Data 

type: Text) and Surface (Data type: Double). 

- Edit each layer manually: add the type of land use and the surface of each polygon (in the 

Attributes Table, Right Click on the top of the column „Surface‟, select Calculate 

Geometry and choose the Area property). 

 

Create one layer regrouping all land use classes 

 

- The Merge function combines input features from multiple input sources into a single 

one. Use it to merge all land use classes and obtain a new shapefile. This procedure 

assumes that every empty spaces within the digitisation area are classified as road 

network. No distinction is made between the different types of highways, freeways and 

local roads. 
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Section 4. SWMM subcatchments parameters determination 
 

Delimitation 

 

- Using the FlowAcc raster, create a stream network by applying a threshold value (100 

cells) to select cells with high accumulated flow. To do so, use the Reclassify function 

(ArcToolbox > 3D Analyst Tools > Raster Reclass > Reclassify) to assign the value 

of one to all cells that have more than 100 cells flowing into them, and NoData to all 

other cells; 

- From the created layer determine a pour point for each subcatchment (create a Point 

New Shapefile, and edit it). On the figure below, pour points are presented in yellow; 

- Using this new shapefile, use the Watershed function; 

- A raster layer representing the subcatchments is created. 

 

 
 

- Use the Reclassify function to create a mask for each subcatchment: assign the value 

of one to all cells contained into a given subcatchment and the value of NoData to all 

other cells; 

- 15 raster files are created; 

- Use the Raster To Polygon function (ArcToolbox > Conversion Tools > From Raster 

> Raster to Polygon) to convert the raster features to polygon features (simplify 

polygon box not checked). 
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Area 

 

- To determine the area of each subcatchment, open the Attributes Table, and note the 

number of pixels contained in it. Since the resolution is 20 m, each pixel represents 

400 m²,  

- Multiply the number of pixels by that value and transform the result into hectares. 

 

Width  

 

Longest flow path method: 

According to the SWMM user‟s manual (2010) and SWMM applications manual (2009), 

the width can be defined as the subcatchment‟s area divided by the length of the longest 

overland flow path that water can travel.  

- Add the HEC-GeoHMS Main View 9 and HEC-GeoHMS Project View 9 toolbars to 

ArcMap; 

- Use the Merge function to combine all the subcatchment polygons; 

- Add a column in the Attributes Table of that new layer named „HydroID‟ and assign 

the subcatchment number to each polygon (necessary step for the use of HEC-

GeoHMS); 

- Use the Longest Flow Path function (Watershed Processing > Longest Flow Path); 

- In Excel, divide the value of the longest flow path by the subcatchment‟s area. 

 

Several tests have been done in applying this approach by excluding the channelized flow 

as part of the flow path. 

- Open the reclassified FlowAcc shapefile (considered as the „channelized flow‟) and 

the Longest Flow Path shapefile; 

- Start an editing session with the Longest Flow Path shapefile as a target; 

- Use the Split tool  (click the Edit tool , set the Cut Polygon Features task) to cut 

the Longest Flow Path shapefile where it meets the channelized flow; 

- Recalculate the length of each segment (via the Attributes Table); 

- In Excel, divide that value by the subcatchment‟s area. 

 

Skew factor method: 

- Transform the reclassified FlowAcc output into a polyline shapefile using the function 

Raster to Polyline (ArcToolbox > Conversion Tools > From Raster > Raster to 

Polyline); 

- Created an edit session for this layer and lengthen the main channel in order to form 

two parts of the subcatchment (Double Click on the polyline feature which has to be 

lengthened and move the vertex across the limits of the subcatchment as showed 

below: in blue the modified polyline which will separate the subcatchment in two 

parts; in red the original polyline);  
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- Split the polygon by the overlapping line feature : select the polygon, set the Task to 

Cut Polygon Features, use the pencil tool to Right Click the line and select Replace 

Sketch and then Finish the sketch ; 

- The subcatchment is split in two parts along the main channel. 

 

              
 

- Recalculate the surface of each part of each subcatchment; 

- From the reclassified FlowAcc shapefile created above, calculate the length of each 

main channel within each subcatchment; 

- The width can now be determined by: 

               

Where   is the length of the main drainage channel and   is the skew factor 

(comprised between 0 and 1) calculated as: 

  
     

 
 

Where,    is the area to one side of the main channel,    is the area to the other side 

of the main channel and   is the total area of the subcatchment (         ).  

 
 

 

 

Ja
v

ah
er

i,
 1

9
9

9
 



137 

 

Slope (%slope) 

 

- Use the Slope function (ArcToolbox > 3D Analyst Tools > Raster Surface > Slope) to 

determine the slope (in percents) of the DEM; 

- Multiply each subcatchment mask by the Slope raster layer using the Raster 

Calculator (Spatial Analyst > Raster Calculator). This creates a raster layer for each 

subcatchment; 

- Note the Mean value of the slope for each subcatchment (Right click on the layer > 

Properties > Source > Mean). 

 

Percent of impervious area (%Imperv) 

 

- Use the Clip function (ArcToolbox > Analysis Tools > Extract > Clip) to extract the 

part of the land use layer that overlays the subcatchment features: Input Features = 

land use layer, Clip features = subcatchment polygons; 

- 15 shapefiles are created; 

- For each subcatchment, determine the surface occupied by each polygon of land use 

(via the Attributes Table, select the Calculate Geometry function); 

- In Excel, copy and paste the Attributes Table of each subcatchment and calculate the 

proportion of each land use classes contained in it; 

- From the imperviousness coefficients of each land use classes, determine the percent 

of imperviousness of each subcatchment. 

 

 
 

Infiltration model (Curve Number method) 

 

Create a Curve Number (CN) Grid using HEC-GeoHMS (according to Merwade, 2010): 

- Preparing land use data for CN Grid: use the Reclassify function on the land use raster 

dataset to create three classes of land use: water (1), medium residential (2) 

containing developed open space and developed land from low to high intensity, and 

forest (3); 
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- Convert the reclassified land use grid into a polygon feature class (Raster To Polygon 

function); 

- Create an empty field named “LandUse” (Data Type: Short Integer) and equal it to 

the GRIDCODE column (representing the land use class) via the Field Calculator. 

 

- Create a soil map from Chuah (1989): georeferencing, digitalisation of the soil classes 

(see sections 1 and 3); 

- Create an empty field for storing soil group data named „SoilCode‟ (Data type: Text). 

Edit the field by adding the SoilCode associated to each type of polygon (C for 

Rengam and red variant Rengam series, D for Tengah series). 

- SCS classification of soils: 

-  

Soil 

code 

Characteristics Examples 

A Soils having high infiltration rates (low 

runoff potential), well to excessively-drained 

sands or gravels 

Sand, sandy loam, 

aggregated silts 

B Soils having moderate infiltration rates 

(moderately low runoff potential), moderately 

fine to moderately coarse textures 

Silt loam, loam 

 

C Soils having slow infiltration rates 

(moderately high runoff potential), soils with 

a layer that impedes downward movement of 

water, or soils with moderately fine to fine 

texture 

Soils high in clay, 

sandy clay loam 

D Soils having very slow infiltration rates (high 

runoff potential), soils with a clay layer at or 

near the surface, soils with permanently high 

water tables 

Clay loam, silty clay 

loam, sandy clay, silt 

 

Sources: Marek (2009), SWMM User‟s manual (2010), NRCS (1986) 

 

- Create four more fields named PctA, PctB, PctC, and PctD (Data type: Short Integer) 

for each feature (polygon). PctA will define what percentage of area within the 

polygon has soil group A (100 %), PctB will define what percentage of area within 

the polygon will have soil group B (100 %) and so on; 

- Use the Union tool (ArcToolbox > Analysis Tools > Overlay > Union) to combine 

soil and land use data. The result of Union features inherits attributes from both 

feature classes; 

- Delete the features that have attributes from only one feature class (via the Attributes 

Table). 

 

- Create a table named „CNLookUp‟ (ArcCatalog > File > New > dBASE Table), 

- Create six fields in it (in ArcCatalog, Right Click on the table > Properties), 

representing the Curve Numbers associated to each land use class  for each land use 

soil group: 

LUValue (Data Type: Short Integer)  

Description (Data Type: Text)  

A (Data Type: Short Integer)  

B (Data Type: Short Integer)  
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C (Data Type: Short Integer)  

D (Data Type: Short Integer)  

- Start the Editor to edit the table and fill it as shown below: 

 

 
 

- Use HEC-GeoHMS to create the curve number grid click on Utility > Generate CN 

Grid: use the DEM, the soil and land use layer and the CN Lookup table as inputs; 

 

- Use the Int function (ArcToolbox > 3D Analyst Tools > Raster Math > Int) to convert 

it to integer; 

- Apply the Raster To Polygon function; 

- Use the Clip function to clip it with each subcatchment; 

- Within each subcatchment, Merge the features of the same CN, add the field 

„Surface‟ (Data Type: Double); 

- From the surface and the CN associated to each subcatchment, calculate a weighted 

CN in Excel. 

 

- To obtain a more precise CN Grid, repeat these steps using all the land use classes. 

The CN associated to them are described in the table below: 

- Thus, the CN Lookup table is: 

 

 
 

 

Manning’s coefficient (N-Imperv & N-perv) 

 

- From the Excel table containing the proportion of each land use class in each 

subcatchment, calculate a weighted Manning‟s coefficient for the impervious areas 

(industrial, car park and road) and the pervious areas (others). The Manning‟s 

coefficients are noted below: 
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 Manning‟s coefficient 

Apartment 0,05 

Multiple-family, attached 0,05 

Multiple-family, detached 0,05 

Single-family 0,05 

Commercial & Educational 0,05 

Industrial 0,011 

General vegetation 0,24 

Woodland 0,6 

Car park 0,012 

Road 0,011 

Construction site 0,05 

(Source: Rossman (2010), USDA (1986)) 

  



141 

 

Section 5. Old hyetograph and hydrograph: data extraction 

 

Georeferencing 

 Discharge: 

 

- Add the Georeferencing toolbar to the view; 

- Click the Add Control Point tool ; 

- Click the mouse pointer on a graduation on the X axis; 

- Right click Input X and Y and enter the coordinates of the considered point (values in 

hour, Y = 0); 

- Repeat the operation as many times as possible along the X axis. 

 

- Repeat these steps for the Y axis (values in m³/s or 10m³/s, 0). 

NB: Multiply the graph unit per ten is useful to not overstretch it. 

 

- Click Georeferencing > Rectify in order to permanently transform the image. 

 

 
 

Precipitation 

 

- Add the initial graph on the view; 

- Repeat the previous steps (X values in hour, Y values in mm, 10mm, mm/h or 10mm/h). 
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Data extraction  

Discharge 

 

- Create a new shapefile. Set the feature type as Polyline; 

- Add it to ArcMap; 

- Start an editing session and digitize the discharge curve (Task: Create New Feature). 

 

 

 

- Create a New Shapefile (Polyline) called „grid‟; 

- Draw manually several lines spaced by a width equal to the width between the center of 

two bars of precipitation (0,10 = 6 min between two records of precipitation, 0,4 = 15 

min…). 

To do so, Right Click on the polyline created > Properties and enter the coordinates of 

both ends. Then, copy and paste 1, 2, 4, 16… polylines and move them on the right place. 
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- In ET GeoWizard, use the Point Intersection function to create a point feature class with 

the intersection points of the grid and the digitized discharge curve. 

 

 
 

- In the Attributes Table of the newly created shapefile, add two fields named X and Y and 

fill them with the X and Y coordinates (Calculate Geometry). 

- In Excel, multiply the Y values per ten if necessary. 

 

Precipitation 

 

- Use the Create Station Point function in ET GeoWizard to create a layer of points spaced 

by a width equal to the width between the center of two bars of precipitation; 

- Start an editing session and modify that layer by deleting the useless points and by 

moving the remaining points on the top of the histogram bars; 

- In the Attributes Table, add two fields named X and Y and calculate the X and Y 

coordinates (Calculate Geometry). 

- In Excel, multiply the Y values per ten if necessary. 
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Section 6. Data extraction from RADAR images 

 

NUS weather station 

 

- Records from August, 2003 to present; 

- Hourly data or 5-minute data; 

- Coordinates: 103° 46‟ 41‟‟E, 1° 17‟ 40‟‟ N 

- Distance between the centre of the Upper Bukit Timah and the NUS weather station: 

about 5.5 km. 

 

Pre-treatments in Corel Photo Paint software 

 

- For each color figuring on the color palette and the image background, find the RGB 

code using Corel Photo Paint software (using the Eyedropper tool ) and associate 

it a class number; 
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- Choose the interesting RADAR images and convert them into tif (gif → tif) with 

Corel Photo Paint software (File > Batch process, load the files to convert, save as 

type tif). “8-Bit paletted” images are created. 

- Convert the colors of every image with a Corel Photo Paint script in order to obtain 

the same value in the RVB code (eg. 151 – 151 – 151, 152 – 152 – 152…): File > 

Batch process, load the files and add the script previously created.  

The “8 Bit paletted” image has new colors (associated to a new RGB code), each of 

them being associated with a number of the palette, different for each image; 

- In order to obtain a same value associated to a given colour for every image, create a 

script converting the “8 Bit paletted” image into a “24 Bit RGB” image. 

 

Georeferencing 

 

See section 1 for details 

- Georeference a first image in Arcmap, and save the Link Table (figuring below). In 

our case, the RMS equalled 50, which is acceptable since the resolution of the 

RADAR images is around 220 m. Project it into UTM 48N; 

- Open all the RADAR images of a given event and build a new macro using 

Workspace Macro Pro, in order to automatically georeference all the following 

images; 

- Use the same macro for all events (an event contains between 6 and 43 images, taken 

every 10 min). 

 

  X Source                Y Source                        X Map                        Y Map 
1.668511  2.107182 348231.000000 145247.000000 

4.273237  2.497541 389463.000000 151507.000000 

3.334294  1.864586 374680.000000 141482.000000 

2.965693  3.200807 368845.000000 162372.000000 

 

 

Qualitative values extraction – weather station 

 

- Create a new point shapefile representing the NUS weather station. Set its coordinates 

to 363748 m E, 143135 m N (Projection UTM 48N). Transform that shapefile into a 

raster layer using the Point to Raster function (ArcToolbox > Conversion Tools > To 

Raster > Point To Raster); 

- Use the Reclassify function to create 31 classes representing each colour of the 

qualitative scale, the remaining (background, title...) being set at 0 (see an example of 

reclassified image below). Save the reclassification table (figuring below); 
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Old 

values 

New 

values 

0-130 0 

151 1 

152 2 

153 3 

154 4 

155 5 

156 6 

157 7 

158 8 

159 9 

160 10 

 

161 11 

162 12 

163 13 

164 14 

165 15 

166 16 

167 17 

168 18 

169 19 

170 20 

171 21 

172 22 

 

173 23 

174 24 

175 25 

176 26 

177 27 

178 28 

179 29 

180 30 

181 31 

182-255 0 

NoData NoData 

 

- Use the Zonal Statistics as Table function (ArcToolbox > Spatial Analyst Tools > 

Zonal > Zonal Statistics as Table) in order to extract the qualitative value of the 

rainfall in the NUS weather station (mean). An example of table is showed below; 

 

 
 

- For each image, repeat these last two steps (using Workspace Macro Pro); 

- For each event, report the qualitative values of rainfall in an Excel file and associate 

them to the measured values of precipitation; 

- Find the best polynomial relation (R² > 0.8) between the qualitative and measured 

values (deleted aberrant points if necessary); 

- From all polynomial equations, find the “mean” relationship between them and 

calculate the values of precipitation for the different classes of the qualitative scale. 

 

Qualitative values extraction – Upper Bukit Timah Basin 

 

- A relation is now established between the qualitative scale and the quantity of 

rainfall. Use the Zonal Statistics as Table function in order to extract the mean 

qualitative value of rainfall falling on the Upper Bukit Timah Basin (in red on the 

image below); 

VALUE COUNT AREA MIN MAX RANGE MEAN STD SUM VARIETY MAJORITY MINORITY MEDIAN

1 1 48130,30000000000 22 22 0 22,00000000000 0,00000000000 22,00000000000 1 22 22 22
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- Repeat that step for each image of the event; 

- From the relationship between qualitative and quantitative data, calculate the quantity 

of rainfall falling on the basin during the event, every 10 min.  A linear interpolation 

is needed between the values of the scale. 
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Section 7. Determination of HEC-HMS parameters 

 
Almost all parameters were previously determined to be encoded in the SWMM model, with the 

exception of the conduits slope, time of concentration and storage coefficient. 

 

Conduits slope 

 

The elevation of the outlet and inlet of each conduit as well as its length were determined for the 

SWMM application. The slope of each conduit was simply determined using these data, in order 

to be sure the two models are identical. 

 

Time of concentration 

 

Several parameters were needed to determine the time of concentration using the six empirical 

methods presented before. Among them, the runoff coefficient and the channel slope were not 

determined for the SWMM model. They are thus determined here. 

 

-  , runoff coefficient: 

 

A runoff coefficient was attributed to each land use class. Then, a weighted coefficient was 

calculated for each subcatchment, depending on the surface of each land use class within the 

subcatchment. 

 

Runoff coefficients associated to each land use class: 

Land use class C* 

Apartment 0.60 

Multiple-family, attached 0.67 

Multiple-family, detached 0.50 

Single-family 0.40 

Commercial + Educational 0.73 

Construction site 0.50 

Industrial 0.65 

Grass 0.25 

Woodland 0.15 

Parking 0.86 

Road 0.83 

Railroad 0.30 

*Mean value from: Guo (2003), Wisconsin Department of Transportation (2007), McCuen (2004),and 

Dunnes and Leopod (1978). 

 

Weighted runoff coefficient calculated for each subcatchment: 

s1 s2 s3 s4 s5 s6 s7 s8 s9 s10 s11 s12 s13 s14 s15 

0.53 0.58 0.50 0.46 0.23 0.68 0.57 0.62 0.59 0.53 0.57 0.23 0.39 0.17 0.30 

 

-   , channel slope (m/m): 
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All conduits situated in one specific subcatchment were regrouped. The channel slope was 

simply taken as the mean slope of these conduits.  

 

Time of concentration (min) determined by four empirical methods 

Sub 
id. Surface (m²) Methods of estimation 

  
FAA Williams Kirpich Haktanir-Sezen Johnstone-Cross Simas-Hawkins 

s8 39200.000 4.756 3.027 3.881 9.235 8.063 0.426 

s6 168007.866 7.552 14.610 15.742 22.288 29.427 0.435 

s7 194400.000 6.559 19.942 17.724 30.665 28.397 22.492 

s4 206799.957 8.182 15.182 10.883 29.460 15.435 0.605 

s11 222785.150 7.677 14.271 10.001 28.279 14.172 10.247 

s12 229199.833 5.412 11.068 7.883 23.411 11.640 7.183 

s2 264708.486 10.793 22.126 16.109 35.639 22.938 14.888 

s10 289200.000 7.650 18.771 13.506 31.586 19.603 16.646 

s9 355978.811 14.170 22.037 14.492 35.964 19.887 13.947 

s14 378131.725 4.473 24.494 11.655 48.261 12.582 19.216 

s3 443200.713 15.050 33.944 25.548 41.643 38.061 19.258 

s13 462798.873 7.753 32.858 19.948 47.209 25.617 14.235 

s5 804693.938 9.229 73.604 35.827 84.976 38.640 37.133 

s1 1408366.642 22.497 121.381 69.079 94.424 85.140 50.684 

s15 1430033.518 11.401 67.963 28.721 79.098 30.259 58.999 

 

 
Subcatchment surface versus time of concentration 

 

Storage coefficient 

 

The storage coefficient is calculated by dividing the surface after inflection point (in purple on 

the example below) by the value of the flow at the point of inflection (in red). 
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The surface after inflection point was calculated by determining the surface formed by each 

trapezium under the curve and then summing all concerned surfaces. 

 

 
Two recent storm events (2

nd
 of April, 2011, and 10

th
 of April, 2011) for which the data provided 

from the PUB were used for the determination of the storage coefficient. Two old storm events 

(18
th

 of April, 1989, 11
th

 of July, 1988) were also used. The mean storage coefficient determined 

from these four events was encoded in the HEC-HMS model. 
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Section 8. Synthetic design hyetographs determination 
 

Arithmetical mean derived from measured precipitation 

 

- Select, from the NUS 5-minutes rainfall data, the storm events having a daily rainfall 

volume superior or equal to 50 mm; 

- Translate the maximum intensity of each event in time in order to match all maximum 

intensities; 

- Calculate the average volume of precipitation for all selected storm events. 

 

 
 

- The hyetograph obtained from the average volume of all selected events is presented 

below. The portion between 05:30 and 08:30 was selected to represent the design 

hyetograph shape. 

 

 
-  
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- From the obtained mean hyetograph, express the volume as a percentage of the total 

depth; 

 

- From the IDF curves, establish the relationships between intensity, duration and 

frequency of the storm. Several points of a given duration and return period were selected 

to determined the associated rainfall intensity (mm/h, in blue in the table below). Then 

the relationships were established, using these points. 

 

Return 
period (yr) 

Duration (hr) 

0.083 0.166 0.25 0.5 1 

2 145 130 120 90 62 

5 185 165 155 120 80 

10 210 190 170 135 94 

25 260 230 210 160 110 

50 285 260 235 175 125 

100 310 280 260 195 135 

 

 
 

- The duration of the hyetograph is 03:30. From the IDF curves, the total volume of 

precipitation can be determined, given the duration and return period of the storm (the 

intensity needs to be multiplied by the duration to be transformed into volume of 

precipitation). For a storm event having a duration of 03:30, the total volume of 

precipitation is: 

 

Return period (years) Volume (mm) 

2 153.8 

5 204.3 

10 237.7 

25 270.8 

30 307.4 
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- In order to obtain design hyetographs of different duration the procedure is repeated by 

selecting the storm events of specific duration: 

- Between 20 and 40 minutes: 30-minutes design rainfall; 

- Between 50 and 70 minutes: 60-minutes design rainfall; 

- Between 80 and 100 minutes: 90-minutes design rainfall;  

- Between 110 and 130 minutes: 120-minutes design rainfall and; 

- Between 160 and 200 minutes: 180-minutes design rainfall. 

 

- Thirty synthetic hyetographs are therefore created (see appendix 12). 
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Appendix 1. Intensity-duration-frequency curves for Singapore 

 

 
Source: PUB, 2010 
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Appendix 2. Major features of the Upper Bukit Timah basin  
 

Upper Bukit Timah basin, Major roads and streams 
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Appendix 3. Land use criteria 
 

Several criteria have been defined before the digitisation, in order to avoid or reduce any 

subjective selection in the land use classes. They are presented in the table below. 

 

Land use 

Class 

Definition Example 

 

Residential 

 

Single-

family 

dwellings 

The term „single-family‟ 

means that the building is 

usually occupied by just one 

household and consists of 

just one dwelling unit.  

This type of dwelling does 

not share any wall with any 

other house and has only 

outside walls. It does not 

touch any other dwelling. 

Commonly, there is a garden 

surrounding the house. In 

most of the cases, there is a 

swimming pool near the 

dwelling. 

 

 

Multiple-

family 

dwellings, 

detached  

(= 

duplexes) 

The term „multiple-family‟ 

means that the building is 

occupied by two (or more) 

families. The term 

„detached‟ means that the 

building consists of just one 

dwelling unit for two (or 

more) families.  

Duplexes commonly refer to 

two separate residences, 

attached side-by-side. The 

detached multiple family 

dwellings often looks like 

either two houses put 

together, or as a large single 

home with two different 

entrances.   

The difference between 
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apartment building (see 

below) and duplexes is 

sometimes vague but 

generally, apartment 

buildings tend to be bigger 

whereas duplexes are usually 

the size of a normal house.  

Multiple-

family 

dwellings, 

attached (= 

row houses) 

Row houses refer a style 

where a row of identical or 

mirror-image houses share 

side walls.  

Attached multiple family 

dwellings are inspired by the 

well-known British house 

design: they are multistory 

housing units that are at least 

consistent, if not identical, to 

all adjoining homes.  

 

 

Apartment 

buildings 

Apartment buildings consist 

in a block of flats, multi-unit 

dwelling made up of several 

flats.  

In Singapore, apartment 

buildings are often 

Condominium, which are a 

form of ownership with 

individual apartment for 

everyone with common 

areas, such as lobbies, 

recreation rooms, swimming-

pool, tennis courts… They 

are easily recognizable.  
 

 

Vegetation 

 

Forests Forested areas consist in a 

zone containing dense trees 

only (zone consisting in 

grass and sparse trees are 
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regrouped in the „general 

vegetation‟ class). 

They figure on the 

topographic map and the 

Street Directory book. 

 

 
 

General 

vegetation 

(parks, 

grass, green 

spaces, 

open 

spaces) 

This class contains parks, 

grass, green spaces, open 

spaces... These features can 

be found around 

condominiums, on the sides 

of the road. They sometimes 

contain sparse trees.  

Parks generally figure on the 

Street Directory book. 

 

 

 
 

 

Communication 

 

Roads  

 

Railroad Railroad area has been 

identified on the topographic 

map and the Street Directory 

book. 
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Car parks To avoid any subjectivity, 

only the car parks figuring in 

the Street Directory book 

have been classified. 

 

 
 

 

Industrial, commercial & educational 

 

Industrial Few industrial areas are 

present in the Upper Bukit 

Timah Catchment.  

They consist in gasoil 

stations, car dealers and 

industries companies 

figuring on the Street 

Directory and on Google 

Earth information. 

Generally, they can be 

spotted by their concrete 

pavement and flat roofs. 

 

 
Nissan Motor Centre, Bukit Timah Road 

 

Commercia

l & 

educational 

School and universities are 

easily identifiable thanks to 

their playgrounds, tennis 

courts and racetracks. 

Commercial areas are 

generally situated near an 

important road and consist in 

big infrastructure with 

surrounding car parks. 

All schools, shopping malls 

and shops have been listed in 

the class after confirmation 

with Google Earth and/or the 

Street Directory book. 

 

Chuah (1989) regrouped 

schools and commercial 

 
Bukit Timah Primary school (left) and Bukit 

Batok Secondary school (right) 
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features in a same class, as 

schools zone tend to have 

little or no open space. This 

reinforced our choice to 

regroup them into a same 

class. 

 

NB: religious features such 

as churches and temples 

have been regrouped in this 

class. 

 
Bukit Timah Shopping Center 

 

Others 

 

Lakes These features can be easily 

identified on the topographic 

map as well as on Google 

Earth. 

 

 
 

Constructio

n sites 

Generally, construction sites 

are disturbed sites light 

coloured, depending on their 

current construction phase. 

They are identified easily. 

 

 
 

 

Some photos taken on the field can illustrate the different land use classes used in this work. 

They are presented below. 
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Forest: Bukit Timah Nature Reserve (15/08/2010) 

 

 
General vegetation: Open space near Bukit Timah Nature Reserve (15/08/2010) 

 

 
Industrial: BMW at Dunearn Road (17/09/2010) 
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Commercial: Bukit Timah Shopping Center, Upper Bukit Timah road (18/09/2010) 

 

 
Apartments: Upper Bukit Timah road (18/09/2010) 

 

 
Multiple-family dwellings, attached: Kismis Green (13/08/2010) 

 



166 
 

 
Multiple-family dwellings, detached: Bukit Timah road (23/08/2010) 

 

 
Single-family dwelling: Binjai Park (17/09/2010) 

 

 
Construction: near Bukit Timah Nature Reserve (08/09/2010) 

 

  



167 

 

Appendix 4. SWMM pre-parameterisation hydrographs 
 

The graphs presented here are: 

- 12 Feb 78; 

- 01 Jun 79; 

- 02 Mar 84; 

- 02 Jul 84; 

- 03 Jan 85; 

- 18 Jun 86; 

- 01 Aug 86; 

- 07 Oct 86: 

- 27 Nov 87; 

- 15 Feb 88; 

- 03 Apr 88; 

- 03 Feb 84; 

- 17 Apr 88; 

- 11 Jul 88; 

- 18 Apr 89 

- 02 Dec 78. 

 

 

Time (hh:mm) figures on X axis, discharge (m³/s) figures on Y left axis and rainfall intensity 

(mm/h) figures on Y right axis. Measured discharge is in red, simulated discharge in blue. The 

Nash-Sutcliffe coefficient is noted on the right hand side of each graph.  

In order to allow a global view of the curves and to save space, graphs presented here are 

reduced. 

 

12 Feb 78 
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01 Jun 79 
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02 Mar 84 
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172 
 

 
02 Jul 84 
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03 Jan 85 
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18 Jun 86 
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01 Aug 86 
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07 Oct 86 

 

 



179 

 

 

 
27 Nov 87 
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15 Feb 88 
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03 Apr 88 
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03 Feb 84 
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17 Apr 88 
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11 Jul 88 
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18 Apr 89 
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02 Dec 78 
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Appendix 5. SWMM final adjustment hydrographs 
 

The graphs presented here are: 

- 12 Feb 78; 

- 01 Jun 79; 

- 02 Mar 84; 

- 02 Jul 84; 

- 03 Jan 85; 

- 18 Jun 86; 

- 01 Aug 86; 

- 07 Oct 86: 

- 27 Nov 87; 

- 15 Feb 88; 

- 03 Apr 88; 

- 03 Feb 84; 

- 17 Apr 88; 

- 11 Jul 88; 

- 18 Apr 89 

- 02 Dec 78. 

 

Time (hh:mm) figures on X axis, discharge (m³/s) figures on Y left axis and rainfall intensity 

(mm/h) figures on Y right axis. Measured discharge is in red, simulated discharge in blue. The 

Nash-Sutcliffe coefficient is noted on the right hand side of each graph. In order to allow a 

global view of the curves and to save space, graphs presented here are reduced. 

 

12 Feb 78 
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01 Jun 79 
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02 Mar 84 
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02 Jul 84 
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03 Jan 85 
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18 Jun 86 



198 
 

 
01 Aug 86 
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07 Oct 86 
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27 Nov 87 



202 
 

 
15 Feb 88 



203 

 

 
03 Apr 88 
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03 Feb 84 
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17 Apr 88 
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11 Jul 88 
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18 Apr 89 
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02 Dec 78 

 

 



210 
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Appendix 6. Correspondences between old maps legends and 

current map classification 

Old legend 
New legend, corresponding to the 2009 map 
classification 

1950 
Sparse residential with open space Single-family dwellings + Open space* 

Forests Forests 

Sparse residential + secondary 
lowland vegetation Single-family dwellings + Forests** 

Lowland secondary vegetation Forests 

Built-up areas 
Multiple-family dwellings + Apartment + Commercial & 
Educational + Industrial 

Open space with little or no trees Open space 

Quarry Construction site 

Cemetery Open space 

1959 
Sparse residential with open space Single-family dwellings + Open space* 

Forests Forests 

Sparse residential + lowland 
secondary vegetation Single-family dwellings + Forests** 

Lowland secondary vegetation Forests 

Built-up areas 
Multiple-family dwellings + Apartment + Commercial & 
Educational + Industrial 

Open space with little or no tress Open space 

Quarry Construction site 

Cemetery Open space 

Murnane Reservoir Lake 

1973 
Lowland Rainforest Forests 

Tall Secondary Forest Forests 

Low Secondary Forest Forests 

Grass & Shrub OpenSpace + Forests*** 

Suburban Gardens Single-family dwellings + General vegetation** 

Mown Grass Open Space 

Mixed Tree Crops Forest 

Urban 
Multiple-family dwellings + Apartment + Commercial & 
Educational 

Industrial Industrial 

Quarry Construction site 

Murnane Reservoir Lake 

1986 
Dense residential little open space Multiple-family dwellings 

Dense residential bigger open space Single-family  dwellings 

Sparse residential + Lowland veget Single-family dwellings + Forests** 

Open space with little or no trees Open space 

Secondary lowland vegetation Forests 

Forests Forests 

Construction Construction site 

Quarry Construction site 

Commercial+Educational Commercial + Educational 

Industrial Industrial 

Service reservoir Lake 

Assumptions: 
* 50% Single-Family dwellings, 50% Open space 
** 20% Single-Family dwellings, 80% Forests (according to Chuah (1987), this class represents lowland 
secondary vegetation with scattered houses) 

*** 50% Open space, 50% Forests 
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Appendix 7. Influence SWMM parameters on the modelled 

discharge for recent events  

 

Parameters tested: width, Manning‟s coefficient of impervious/pervious areas 

(Nimperv/Nperv), percentage of impervious areas (%imperv) and Manning‟s coefficient 

of concrete conduits (Ncond) 

 

27
th

 of April, 2011 
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30
th

 of April, 2011 
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4th of May 2011 
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10
th

 of May, 2011 
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21
th

 of May, 2011 
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25
th

 of May, 2011 
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5
th

 of June, 2011 
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Appendix 8. 3D iso-responses curves, 5
th

 of June, 2011. 
 

 
  



225 

 

 

Appendix 9. HEC-HMS: simulated versus modelled hydrographs 
 

The graphs presented here are: 

- 12 Feb 78; 

- 03 Feb 84; 

- 02 Jul 84; 

- 03 Jan 85; 

- 01 Aug 86; 

- 27 Nov 87; 

- 15 Feb 88; 

- 03 Apr 88; 

- 17 Apr 88; 

- 11 Jul 88; 

- 18 Apr 89; 

- 02 Mar 84. 

 

From left to right, top to the bottom, the methods for estimating the time of concentration are:  

- FAA; 

- Williams;  

- Haktanir-Sezen;  

- Kirpich; 

- Johnstone- Cross and; 

- Simas-Hawkins. 

 

Time (hh:mm) figures on X axis, discharge (m³/s) figures on Y left axis and rainfall intensity 

(mm/h) figures on Y right axis. Measured discharge is in red, simulated discharge in blue. The 

Nash-Sutcliffe coefficient is noted on the right hand side of each graph. In order to allow a 

global view of the curves and to save space, graphs presented here are reduced. 

 

12 Feb 78 

 



226 
 

 
 

03 Feb 84 

 

 
02 Jul 84 
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03 Jan 85 

 
 

 
01 Aug 86 

 

 
27 Nov 87 
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15 Feb 88 

 

 
03 Apr 88 
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17 Apr 88 

 

 
11 Jul 88 

 

 
18 Apr 89 
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02 Mar 84 
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Appendix 10. Runoff coefficients 
 

Land use class Runoff coefficient*  

Apartment 0.60 

Multiple-family dwellings, attached 0.67 

Multiple-family dwellings, detached 0.50 

Single-family dwellings 0.40 

Commercial + Educational 0.73 

Construction site 0.50 

Industrial 0.65 

Grass 0.25 

Forest 0.15 

Parking 0.86 

Road 0.83 

Railroad 0.30 

Lake  0.00 

*Mean value from: Dunnes and Leopold (1978) 
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Appendix 11. Percentages of imperviousness (%) by subcatchment, 

from 1950 to 2020 
 

Calculated from the coefficients of imperviousness given by Guo (2003) 

 

  1950* 1959* 1973* 1986* 2009** 2020*** 

s1 27.561 35.679 41.690 49.634 53.693 56.897 

s2 20.464 43.188 34.360 33.604 55.096 58.300 

s3 20.626 24.423 41.475 47.170 54.701 57.905 

s4 20.775 20.142 39.311 39.753 44.546 47.750 

s5 6.099 7.008 10.194 9.711 11.274 14.478 

s6 29.452 34.915 34.456 61.317 69.894 73.098 

s7 25.093 30.652 53.357 48.248 55.052 58.256 

s8 28.013 25.733 36.984 60.978 62.634 65.838 

s9 31.512 31.867 7.800 62.220 60.509 63.713 

s10 23.042 30.876 37.448 52.836 56.258 59.462 

s11 25.208 24.133 34.620 60.287 58.974 62.178 

s12 13.774 15.248 7.912 10.253 12.290 15.494 

s13 22.251 22.215 28.683 32.176 34.197 37.401 

s14 12.502 10.479 14.345 15.973 6.007 9.211 

s15 12.657 14.165 22.914 16.392 22.341 25.544 

 
*Calculated from Chuah's maps (1987) 

 
**Calculated from Google Earth (13/03/2009) 

 
***Estimated by empirical formula (1974) 
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Appendix 12. Design synthetic hyetographs 
 

30-minutes hyetographs 
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60-minutes hyetographs 
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90-minutes hyetographs 

 

 

 



236 
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120-minutes hyetographs 
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180-minutes hyetographs 
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Appendix 13. Design hydrograms for the return periods of 2, 10, 25, 

50 and 100 years. 

2-yrs 
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10-yrs 
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25-yrs 
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50-yrs 
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100-yrs 
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Appendix 14. Modelled peak discharge for each design rainfall event 
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Appendix 15. Graphs of imperviousness versus return period and 

peak discharge 
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